# Table Of Content

1 Welcome to ABSYNTH 5!........................................................................................................ 12  
1.1 What is ABSYNTH?........................................................................................................ 12  
1.2 What's New in ABSYNTH 5?........................................................................................ 13  
1.3 The ABSYNTH 5 Documentation .................................................................................. 14  
  1.3.1 In this Manual ........................................................................................................ 14  
  1.3.2 Other Documentation .......................................................................................... 14  
  1.3.3 Formatting Conventions ...................................................................................... 15  
2 Control Elements and Areas............................................................................................. 16  
  2.1 Windows, Pages, Panels, and Tabs ............................................................................ 16  
  2.2 Buttons and Switches ............................................................................................... 17  
  2.3 Menus and Selectors ................................................................................................ 17  
  2.4 Value Fields ........................................................................................................... 18  
  2.5 Sliders and Knobs ..................................................................................................... 19  
3 Application Menu Bar...................................................................................................... 20  
  3.1 File Menu ................................................................................................................ 20  
  3.2 Edit Menu ................................................................................................................ 22  
  3.3 Help Menu ............................................................................................................... 22  
  3.4 Options Dialog ......................................................................................................... 23  
    3.4.1 General Page ...................................................................................................... 23  
    3.4.2 Surround Page .................................................................................................... 24  
    3.4.3 Browser Page ..................................................................................................... 27  
4 Navigation Bar ................................................................................................................... 29  
  4.1 Top Row: Global Controls ......................................................................................... 29  
    4.1.1 ABSYNTH 5 Logo .............................................................................................. 29  
    4.1.2 Window Tabs ...................................................................................................... 30  
    4.1.3 Record Button .................................................................................................. 30
### Table of Contents

#### 4.1.4 CPU Meter

#### 4.1.5 Input and Output Level Meters

#### 4.1.6 Panic Button

#### 4.1.7 NI Logo

#### 4.2 Bottom Row: Sound Management

##### 4.2.1 File and Edit Menus

##### 4.2.2 Sound Name Display and Sound Menu

##### 4.2.3 Previous/Next Sound Buttons

##### 4.2.4 Mutate and Retry Buttons

##### 4.2.5 Save and Save As Buttons

##### 4.2.6 Database Activity Indicator

##### 4.2.7 Keyboard Button

#### 5 Patch Window

##### 5.1 Signal flow in the Patch

###### 5.1.1 Combining Modules in the Channels

###### 5.1.2 Channel Level controls

###### 5.1.3 Surround Pan Switch

###### 5.1.4 Master Channel

###### 5.1.5 Mono Mode and Poly Mode in the Master Channel

##### 5.2 Common Features for all Modules

###### 5.2.1 Edit Menu

###### 5.2.2 Panels and Tabs

###### 5.2.3 Universal Library

##### 5.3 Common Features in Many Modules

###### 5.3.1 Waveform Selector and Waveform Selection dialog

###### 5.3.2 Frequency Menu and Frequency Control

###### 5.3.3 Anti-Alias Switch

###### 5.3.4 Phase Inverter

##### 5.4 Oscillator Module

###### 5.4.1 Oscillator’s Panels and Tabs
### 5.4 Oscillator Module

- **5.4.2 Oscillator’s Edit Menu** ................................................................. 52
- **5.4.3 Single Mode** ................................................................................. 53
- **5.4.4 Double Mode** ............................................................................... 54
- **5.4.5 FM Mode** ...................................................................................... 55
- **5.4.6 Ringmod Mode** ............................................................................. 56
- **5.4.7 Fractalize Mode** ........................................................................... 57
- **5.4.8 Sync Granular Mode** .................................................................... 58
- **5.4.9 Sample Mode** ................................................................................ 59
- **5.4.10 Granular Mode** ........................................................................... 61
- **5.4.11 Audio In Mode** ............................................................................ 62

### 5.5 Filter Module

- **5.5.1 General Functioning** ................................................................. 63
- **5.5.2 Filter’s Panels and Tabs** .............................................................. 64
- **5.5.3 Feedback Loop and Feedback Panel** .......................................... 64
- **5.5.4 Lowpass** ...................................................................................... 67
- **5.5.5 Highpass** ..................................................................................... 68
- **5.5.6 Allpass** ......................................................................................... 69
- **5.5.7 Bandpass** ..................................................................................... 70
- **5.5.8 Notch** ........................................................................................... 71
- **5.5.9 Comb** ............................................................................................ 72
- **5.5.10 Supercomb** ................................................................................ 73
- **5.5.11 Cloud** ........................................................................................ 74

### 5.6 Modulator Module

- **5.6.1 General Function** ........................................................................ 77
- **5.6.2 Ring Modulation** ......................................................................... 77
- **5.6.3 Frequency Shift** .......................................................................... 78

### 5.7 Waveshaper Module

- **5.7.1 General Function** ........................................................................ 80
- **5.7.2 Main Panel** .................................................................................. 81

### 6 Effect Window

- ..................................................................................................................... 82
6.1 General Interaction ........................................................................................................... 83
  6.1.1 Change of Status and Selecting an Effect ................................................................. 83
  6.1.2 Signal Pathway ........................................................................................................ 84
  6.1.3 Surround Panner ...................................................................................................... 84
  6.1.4 Control Area ........................................................................................................... 87
  6.1.5 Modulation and Sensitivity Control .......................................................................... 87
6.2 Pipe .................................................................................................................................. 88
  6.2.1 Parameters ................................................................................................................ 89
6.3 Multicomb .......................................................................................................................... 90
  6.3.1 Parameters ................................................................................................................ 90
6.4 Multitap ............................................................................................................................... 92
  6.4.1 Parameters ................................................................................................................ 93
6.5 Echoes ................................................................................................................................ 94
  6.5.1 Parameters ................................................................................................................ 95
6.6 Resonators .......................................................................................................................... 96
  6.6.1 Parameters ................................................................................................................ 96
6.7 Aetherizer ........................................................................................................................... 98
  6.7.1 Master Section .......................................................................................................... 99
  6.7.2 Grain Cloud Parameters .......................................................................................... 99
  6.7.3 Aetherizer Display .................................................................................................... 103
7 Wave Window ......................................................................................................................... 104
  7.1 Waveform Page, Spectrum Page, Morph Page ............................................................ 104
  7.2 Creating New Waves ...................................................................................................... 105
  7.3 Editing Waves ............................................................................................................... 105
    7.3.1 Tools in the Waveform Page .................................................................................... 106
    7.3.2 Transform menu (Waveform Page) ....................................................................... 106
  7.4 Spectrum Edit .................................................................................................................. 108
    7.4.1 Tools in Spectrum Page ........................................................................................ 109
    7.4.2 Transform menu (Spectrum Page) ....................................................................... 109
  7.5 Wave Morph .................................................................................................................... 110
# Envelope Window

## 8.1 Fundamentals for Operation
- **Zoom Function**
- **Envelope List**
- **Selecting an Envelope**
- **Copying and Inserting Envelopes**

## 8.2 Breakpoints, Transitions/Steps, Sync
- **Creating and Deleting Breakpoints**
- **Grid Switch**
- **Lock/Slide Switch**
- **Free/Sync Switch**
- **Sustain/Release Marker**

## 8.3 Envelope Modes
- **Release Mode**
- **Sustain Mode**
- **Loop Mode**
- **Retrigger Mode**
- **Control Driven Envelopes**
- **Link Mode**
- **Sample Jump**

## 8.4 Envelope LFO

## 8.5 Envelope Modulation

## 8.6 Master Envelope
- **Assigning Breakpoints**
- **Controlling the Master Envelope**

## 8.7 Transform Commands
- **Scale**
- **Expand to Rhythm**
- **Generate AR Pulse**
- **Set Duration**
8.7.5 Load Template ................................................................. 132
8.7.6 Save as Template ............................................................ 132
8.7.7 Initialize Selected Envelope ......................................... 132
8.7.8 Delete Selected Envelope .............................................. 132

9 LFO Window ......................................................................................... 133
9.1 Oscillator Section ........................................................................... 134
9.2 Modulation Sections ................................................................. 135
  9.2.1 Channel Parameters Section ............................................. 136
  9.2.2 Master Parameters Section ............................................... 137
  9.2.3 Controller Section .............................................................. 138

10 Perform Window ................................................................................. 139
10.1 Global Features ............................................................................. 140
  10.1.1 Global Settings Bar ............................................................ 140
  10.1.2 Master Envelope .............................................................. 141
  10.1.3 Audio In ............................................................................. 141
10.2 Automation in ABSYNTH 5: Macro Controls ............................ 142
10.3 Controllers Page ............................................................................. 145
10.4 Assignments Page .......................................................................... 147
10.5 MIDI Page .................................................................................... 148
  10.5.1 Pitchbend ............................................................................ 148
  10.5.2 Volume ............................................................................... 149
  10.5.3 Pan ...................................................................................... 149
  10.5.4 Velocity .............................................................................. 150
10.6 Note Page ..................................................................................... 150
  10.6.1 Note-dependent Modulation ............................................. 151
  10.6.2 Glide .................................................................................. 151
10.7 Tuning Page .................................................................................. 152
  10.7.1 Creating a User-defined Tuning ..................................... 152
  10.7.2 Octave Link ....................................................................... 153
1 Welcome to ABSYNTH 5!

We at Native Instruments would like to thank you for purchasing ABSYNTH – it’s because of customers like you that we can continue developing ground-breaking music software. We hope that this reference manual will provide you with all the information needed to make use of ABSYNTH 5 to its full capacity.

1.1 What is ABSYNTH?

ABSYNTH is a synthesizer capable of producing some of the most daring sounds. Whether you are developing a film soundtrack or want to create striking leads – ABSYNTH 5 always has the right sound for you. The semi-modular design allows you to combine oscillators, modulation sources and filters in any way you want. You can create unusual and dynamic sounds by combining the numerous effects and modulation possibilities in various ways. Endless evolving soundscapes and eccentric pads made up ABSYNTH’s legend. The new Aetherizer effect and filter feedback bring ABSYNTH 5 to a new level in penetrating sound design. Or you can simply navigate through the huge ABSYNTH 5 Factory Library, containing more than 1700 fine-shaped presets in the KORE SOUND® format. Moreover, the new Mutator feature allows you to create whole new sounds based on a favorite and the attributes you choose!

Dedicated Macro Controls allow you to operate several parameters at the touch of a button or just by pressing one key on your MIDI keyboard. Additionally everything is fully automatable in your audio MIDI sequencer allowing you to trigger your sounds into action with full project recall.

Even with all these possibilities, getting the right sound from ABSYNTH 5 is always quick and intuitive using the Browser. Simply choose the characteristics for your desired sound and let ABSYNTH 5 find the perfect creation for you. Coupled with the new Mutator and Finetuning controls, the Browser might be all you need to get the perfect sound. If you want to tweak or program your own sounds, the clear interface structure lets you quickly find important operating features and always keep them in view. All this allows you to keep concentrating on what this is all about: realizing your musical ideas!

We hope you enjoy ABSYNTH 5 as much as we do.

– The ABSYNTH 5 Team at Native Instruments.
1.2 What’s New in ABSYNTH 5?

Here is a short overview of the new features in ABSYNTH 5 compared to ABSYNTH 4:

• The Mutator: This powerful feature introduces a totally new approach to sound design with ABSYNTH. With the Mutator, you can let ABSYNTH automatically generate new Sounds somewhere between the current Sound and other Sounds from the Library.

• New Aetherizer effect: This amazing effect combines a granular-based feedback with a post-delay section. Moreover, all its parameters can be both randomized and modulated.

• New Cloud filter: This is the little brother of the new Aetherizer effect, for use in the Filter modules within the Patch Window.

• New Supercomb filter: This filter type extends the capacities of the Comb filter (still available), using some of the characteristics of the Resonators and Pipe Delay effects.

• New feedback loop for many filter types: LPF 2 Pole, LPF 4 Pole, LPF 8 Pole, Supercomb, Allpass 2, Allpass 4, Allpass 8. Filter feedback allows you to insert a sound modulator like a Waveshaper, Frequency shifter or Ring modulator in the resonance path, giving your filters custom distortions, even ones never heard before.

• Reorganized Filter, Modulator and Waveshaper modules: These modules now present a unified interface and propose a new organization for their menus.

• Support for Windows XP/Vista 64-bit operating systems.

💡 If you are particularly interested in the new sounds ABSYNTH 5 has to offer, type “ab-synth5” in the relevant Search Field in the ABSYNTH Browser. This will narrow the Search Result List down to the new Sounds in ABSYNTH 5.
1.3 The ABSYNTH 5 Documentation

1.3.1 In this Manual
What you are reading right now is the Reference Manual that will give you an in-depth description of all commands and functions to be found in ABSYNTH 5.

This Reference Manual is divided into three parts:
• The first part is the introduction, which you are reading right now.
• Chapters 2 to 12 are the reference itself.
• Chapters 13 and 14 are appendixes relating to the work with Attributes.

1.3.2 Other Documentation
For a comprehensive introduction to ABSYNTH 5, please refer to the ABSYNTH 5 Getting Started guide, which is both copied to the ABSYNTH 5 folder on your hard drive during the installation and available as paperback in the product box. The Getting Started guide provides you with necessary information about the installation and setup procedures. It also presents you the important concepts implemented in ABSYNTH 5 and offers a selection of Quick Starts, introducing you to some important workflows in ABSYNTH 5.

We recommend you to read the Getting Started guide first. If you have any doubt about a command, control element or function of ABSYNTH 5, please refer to this Reference Manual.
1.3.3 Formatting Conventions

This section will introduce you to the signage and text highlighting used in this manual.

This manual uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing these notes let you see what kind of information is to be expected:

⚠️Whenever this exclamation mark icon appears, you should read the corresponding note carefully and follow the instructions and hints given there if applicable.

💡This light bulb icon indicates that a note contains useful extra information. This information may often help you to solve a task more efficiently, but does not necessarily apply to the setup or operating system you are using. However, it should be worth reading for most users.

Special Formatting

In this manual, distinctive formatting has been applied in order to let you recognize certain elements in the text at a glance:

- **Menu item:** Items from ABSYNTH 5’s menus and lists are printed in italics.
- **Important concepts:** On first occurrence important concepts are printed in **bold**.
- **Results of actions are introduced by an arrow (→).**
2  Control Elements and Areas

On the ABSYNTH 5 user interface you will find various control elements which allow for customizing the interface itself, to run functions or modify values. This section provides you with an introduction to nomenclature, elements, and instructions for their use.

If the mouse cursor is not in a text or value field, your computer keyboard triggers MIDI notes. Use the keyboard letters to play ABSYNTH 5. If the Virtual Keyboard is displayed, you can see the corresponding keys being pressed while you play on your computer keyboard.

2.1  Windows, Pages, Panels, and Tabs

Window is the word used to refer to the overall work areas in ABSYNTH 5. There are eight Windows on the ABSYNTH 5 user interface: Browser, Attributes, Perform, Patch, Effect, Wave, Envelope and LFO. They can be accessed via the Navigation Bar, at the top of the application’s interface. To switch to a particular Window, click on the desired Window tab in the Navigation Bar. The tab for the active Window is highlighted.

Window tabs in the ABSYNTH 5 Navigation Bar

In the Wave and Perform Window, there is a number of distinct pages. Each page holds control elements related to a specific task. To switch to a particular page, click on the desired tab at the top of the page. The tab for the active page is highlighted.

Page tabs within Perform Window

In the Patch Window, most modules can be switched between multiple panels. To switch to a particular panel, click on the desired tab at the top of the panel. The tab for an active panel is highlighted.
2.2 Buttons and Switches

Buttons and switches basically allow you to trigger a function or to activate/deactivate a feature. Some other parts of the interface also work as switches: for example, you can turn individual modules on and off in the Patch Window by clicking on the extended left border of each Module Slot. You do not necessarily need to click on the writing, the entire left border area works as a switch. The same applies to the effect within the Effect Window: clicking on the thick border displaying Effect at the top left corner activates/deactivates the effect.

2.3 Menus and Selectors

Menus can be found in many areas in ABSYNTH 5. They contain lists of available options. Menus can be recognized a small triangle pointing downwards.

In order to choose an option or a command from a menu, click on it: A drop-down list appears, which remains open if you move the cursor. Click on the desired entry to select it. To leave the menu without changing the setting, click somewhere else on the user interface or press [Esc] on your computer keyboard.

Selectors are similar to menus, but instead of opening a drop-down list below the menu when clicked, they open a separate pop-up dialog. Most of the time, you can not only select an entry with them but also choose some other options. You then need to click on “OK” (or “Cancel”) at the bottom to get back to the original Window. An example is the Wave Selector and its companion the Wave Selection dialog, which can be found in many places in ABSYNTH 5.
2.4 Value Fields

Value fields contain the numerical values of parameters. The values indicated can be changed in a variety of ways:

- Clicking within the field: The value is highlighted and you can enter a value using your computer keypad. Press [Enter] to confirm or [Esc] to let the value unchanged.

- Using the diamond button (▲) next to a value field: Click on it and hold the mouse button depressed. Drag the mouse up/down to increase/decrease the value, respectively. Depending on the resolution of the parameter, you will see one, two or three diamonds next to its value field. The leftmost diamond has the biggest range – and the lowest resolution: use it to change the value roughly. Use the other diamonds to make finer adjustments.

- If your mouse has a scroll wheel, you can place the cursor on a diamond and change the value by turning the scroll wheel. Move the wheel forward to increase the value and backwards to decrease it.

- You can also right-click ([Ctrl]+click on Mac) on most value fields to bring up a contextual menu. Here you can assign the parameter to one of the Macro Controls. More specific information about Macro Controls can be found at section 10.2 “Automation in ABSYNTH 5: Macro Controls”.


2.5 Sliders and Knobs

Some parameter values can be changed via sliders and knobs.

Sliders (or faders) are used for example to adjust the effect’s input levels in the Effect Window, or to define the mutation settings in the Browser Window’s Mutator. To adjust the value of a slider, click on it and drag your mouse horizontally while holding the mouse button depressed.

![Mutation Amount](MutationAmount.png)

Sider for Mutation Amount in Browser Window

Knobs can be found for example in the Effect Window, where you adjust the signal proportions using the Wet Level and Dry Level controls.

![Wet/Dry knobs](WetDryKnobs.png)

Wet/Dry knobs in the Effect Window

The global Master Envelope also uses knobs to define its four steps Attack, Decay, Sustain and Release. To adjust the value of a knob, you have following possibilities:

- Click on the knob (or on the value display if available) and drag the mouse up/down to increase/decrease the value, respectively. If your mouse has a scroll wheel, you can place the cursor on the knob and change its value by turning the scroll wheel. Move the wheel forward to increase the value and backwards to decrease it.

- Double-click on the value display (if available) and enter a new value via your computer keyboard, then press [Enter] to confirm or [Esc] to let the previous value unchanged.
3 Application Menu Bar

The Application Menu Bar (here on Windows version shown)

The Application Menu Bar is only available if you are using ABSYNTH 5 in stand-alone mode. It holds commands dealing with the overall functioning of ABSYNTH 5. Similar to the menu bar found in other applications on your operating system, it contains three menus, detailed below: the File menu, the Edit menu and the Help menu.

3.1 File Menu

The File menu contains the following entries:

- **New Sound**: Creates a new empty Sound in ABSYNTH 5. The default new Sound only contains one Oscillator in its Channel A.

- **Open Sound…**: Opens a dialog labeled Open SingleSound File... allowing you to select a Sound on your hard drive for opening. In the dialog, navigate to the desired Sound, select it and click on “Open” (or double-click on the Sound). The Sound replaces the Sound previously loaded in ABSYNTH 5.

- **Recent Files**: Opens a submenu containing shortcuts to the 10 last Sounds that you opened in your last sessions. Select an entry in the submenu to open the corresponding Sound. At the bottom of the submenu, the entry Clear Menu empties the submenu.

- **Save Sound**: Allows you to save the changes made to the currently loaded Sound. If you did not save the current Sound yet, this command automatically opens the Save Sound As dialog (see below).

- **Save Sound As…**: Opens a dialog labeled Save SingleSound File As... allowing you to save the current Sound under a new name. In the dialog, navigate to the desired folder where you want to save your Sound, type a new name for the Sound and click on “Save”.

  We recommend saving sounds to the default path, “My Sounds.” This way, your Sound will automatically be integrated to the ABSYNTH 5 Database upon saving.
• **Import Glo Bank…**: Opens a dialog labeled Please select a glo bank to import... allowing you to import Sounds made with older versions of ABSYNTH into ABSYNTH 5. Navigate to the desired Glo bank on your hard drive, select it and click on “Open”. You can then scroll through the list of Sounds available in this bank. The Sound selected in the list is automatically loaded in ABSYNTH 5 and you can play it. Should you wish to convert this Sound into an ABSYNTH 5 KORE SOUND®, you can save it like any other Sound via the Save/Save As... commands explained above.

⚠️ The Factory Contents of all previous versions of ABSYNTH have already been converted and are directly available via the Browser Window. Thus, you need this command for User Sounds only!

• **Options…**: Opens the Options dialog, which will be explained in detail later (see section 3.4 “Options Dialog” below).

• **Audio and MIDI Settings…**: Opens the Audio and MIDI Settings dialog allowing you to adapt ABSYNTH 5 to your custom studio or live setup. The audio and MIDI settings are explained in detail in the Getting Started guide.

• **Exit**: Quits the application. Please check that you saved your Sound before closing. If you did not, unsaved changes will be lost!
3.2 Edit Menu

The Edit menu contains the following entries:

- **Undo**: Cancels the last action in ABSYNTH 5.
- **Redo**: Cancels the last Undo command – in other terms, re-executes the last cancelled action.
- **Copy**: Stores the selected Envelope (if in Envelope Window) or Waveform (if in Wave Window) to the clipboard.
- **Paste**: Pastes the Envelope or Waveform stored in the clipboard (via the command Copy above).
- **Balance levels**: Equilibrates the three Channels A, B and C at a level that prevents the overall output from clipping.

3.3 Help Menu

The Help menu contains three entries with further information about ABSYNTH 5:

- **Launch Service Center**: Starts the NI Service Center. The Service Center can activate ABSYNTH 5 as well as search for new updates. Detailed information can be found in the Service Center Quick Start Guide and manual.
- **Visit Absynth on the Web**: Opens the ABSYNTH page on the Native Instruments website in your favorite Internet browser, where you can access up-to-date information on ABSYNTH 5.
- **About Absynth…**: Opens the About screen where you can view the version number and the individual serial number of your copy of ABSYNTH 5. You also find there the names of all the people who worked on ABSYNTH 5.
3.4 Options Dialog

The Options dialog provides you with various options that shape global functions in ABSYNTH 5. You can call the Options dialog by selecting the corresponding entry in the File menu of the Application Menu Bar (stand-alone application only) or in the File menu of the Navigation Bar (see section 4 “Navigation Bar” below).

The Options dialog is organized into three pages: General, Surround and Browser. Each of them can be accessed by clicking on the corresponding tab at the top of the Options dialog.

To confirm any changes made to the options, click on “Done” at the bottom of the dialog. To close the dialog without saving your changes, click on the dialog’s close icon instead (its location depends on your operating system).

We describe hereafter all available options.

3.4.1 General Page

The General page allows you to define the paths for the directories containing your samples and your templates, along with two additional options:

The General page of the Options dialog
• **Samples Directories**: These three fields allow you to set paths to the directories containing the samples used by your Sounds. To define a path, click on the Browse button under one of the fields, navigate to the desired folder on your hard drive and click “OK.”

• **Template Libraries Directory**: This field allows you to set the path for the directory containing your various Templates (Envelopes, Waveforms, modules, Channels…). To change the path, click on the Browse button under the field, navigate to the desired folder on your hard drive and click on “OK.” For more info on the Templates, please refer to section 5.2.3 “Universal Library.”

• **Auto balance patch channels**: If this option is enabled, ABSYNTH 5 controls the output of the three individual Channels in the Patch Window so that the main output remains constant and do not clip. That is, if you were to increase the level of one Channel, ABSYNTH 5 would automatically decrease the levels of the two other Channels.

• **Auto rename control macro on first assignment**: If this option is enabled, a Macro Control that has had a parameter assigned to it takes over the name of this parameter – but only if no other parameters have already been assigned to it.

### 3.4.2 Surround Page

The Surround page allows you to configure ABSYNTH 5’s surround output channels.

![The Surround page of the Options dialog](image)
ABSYNTH 5 can have up to eight separate audio outputs. The fundamentals for configuring your audio and MIDI interfaces can be found in the Getting Started guide. The Surround page can then be used to assign your output channels to specific positions in the panoramic field.

In the Surround menu sitting at the top of the page, you can choose from the following configurations:

- **2 Stereo**: This standard configuration delivers typical two-channel stereo sound. In this setting, the speakers are situated at 45 degrees and -45 degrees.
- **2 Stereo Wide**: This configuration is easy to distinguish from 2 Stereo: Both front speakers are arranged at 90° and -90°. This results in a wider stereo soundscape.
- **3 Surround**: This configuration returns to analog Matrix surround sound. It is well known under the names of, for example, Dolby Surround™ (home entertainment center) or Dolby Stereo™ (movie theatre), but without a front center channel. Here, there is a central rear channel as well as left- and right front ch3 Front: This configuration replaces the central rear channel of the previous configuration with a center front channel, which leads to better distribution in the stereo soundscape than a classic stereo configuration.
- **4 Surround**: This configuration combines a 3 Surround configuration with a front-center channel and is also known under the name Dolby Surround Pro Logic™.
- **4 Quad**: This four-channel configuration is based on the quadraphonic systems that were popular with consumers in the 1970’s. The four speakers are arranged symmetrically in a square shape.
- **5 Music**: This five-channel surround sound configuration is comparable to top-of-the-line home theater arrangements and movie theaters systems, known as, for example, Dolby Digital™ or DTS™. This system provides you with three front channels (left, center, right) and two surround channels (surround left, surround right).
- **5 Pentaphonic**: This configuration delivers five-channel surround sound, where the five channels are arranged symmetrically in a circle.
- **6 Music**: This configuration corresponds to a 5 Music configuration, but contains an additional rear center channel. This arrangement is used by, for example, the surround sound systems Dolby Digital EX™ and DTS-ES™.
• **6 Hexaphonic**: This configuration delivers six-channel surround sound where the six channels are symmetrically arranged in a circle.

• **7 Cinema**: This configuration delivers seven-channel surround sound as it can often be heard in films. Well-known surround sound systems of this type include SDDS™ and IMAX™. This configuration combines the 5 Music configurations with two additional front center channels (center left, center right).

• **7 Music**: This configuration delivers seven-channel surround sound. It is comparable with the 6 Music configuration, but the surround center channel is divided between the two rear channels “surround center left” and “surround center right”.

• **7 Heptaphonic**: This configuration delivers seven-channel surround sound, where the seven channels are symmetrically arranged in a circle.

• **8 Octaphonic**: This configuration delivers eight-channel surround sound, where the eight channels are symmetrically arranged in a circle.

For any of these configurations, you can then set the assignment of each channel to the available audio outputs of the stand-alone version. The audio outputs that you configured in the Audio and MIDI Settings dialog are at your disposal in the various Channel menus sitting in the panoramic field (the position and number of these menus vary with the selected configuration, see above).

**Low Frequency Effect Channel**

For all configurations but the last 8 Octophonic, you can activate an additional LFE (Low Frequency Effects) or Subwoofer channel. To enable it, click on the little LFE button at the bottom left of the Surround page.

The LFE channel settings

When activated, you see other parameters appearing on its right:

• **Channel menu**: An additional Channel menu lets you define the output to assign to the LFE channel.
- **Frequency control**: Lets you define the cutoff frequency (in Hz) for this channel.
- **Damping control**: Lets you adjust the level (in dB) of this particular channel according to your subwoofer.

When using ABSYNTH 5 as a plug-in, the host automatically chooses the correct setting for the track in which ABSYNTH 5 is used: a particular plug-in will be used depending on whether you use ABSYNTH 5 as an instrument or as an insert effect, and whether the according track is a stereo track or a surround track.

### 3.4.3 Browser Page

In the Browser page, you can set options in relation with the Database.

The Browser page of the Options dialog

In the top part of the page, you find the following settings:

- **Default Author**: Allows you to define a default text string for the Author field in the Meta Information of the Sounds.
- **Use Default Author for New Sound**: If this option is activated, the default Author name defined above is inserted into the Meta Information of all newly created Sounds.
• **Use Default Author for Save Sound As:** If this option is activated, the default Author name defined above is inserted into the Meta Information of all Sounds stored via the command Save Sound As (see 3.1, “File Menu”, above).

• **Database Hit-Count:** This menu allows you to customize the displayed information for each Attributes in the Browser Window. If None is selected, only the Attributes’ names are shown. If Indicate Empty Categories is selected, the Attributes for which there is no Sound are grayed out. If Show Count as Number is selected, the Browser displays after each Attribute’s name the number of Sounds having this Attribute.

⚠️ Note that for the two last entries Indicate Empty Categories and Show Count as Number, the current state (and number) displayed after each Attribute name depends on the current selection of Attributes: for example, if the Attribute Solo/Single is selected in the category Source for the Instruments, the Attribute Ensemble/Kit will logically be grayed out (and the number behind it will be 0). This allows you to quickly see, upon each selection you make, which other Attributes are possible (and how many Sounds have these Attributes).

In the bottom part of the page, you can define the list of folders to scan for Sounds. You can add/remove folders to/from the list via the respective buttons at the bottom. Remember that subfolders in the selected folders will automatically be included in the search as well.

Should you ever make changes in this page, or delete/add individual Sound files in the corresponding folders using your operating system, then you must rebuild the Database. In order to do this, use the Rebuild Database button (labeled Rebuild DB), at the bottom right corner of the page. Depending on the number of available KORE SOUNDS, this process can be time-consuming. Only then will the changes take effect in the Database.
4 Navigation Bar

The Navigation Bar is located at the very top of the ABSYNTH 5 interface:

The Navigation Bar

It consists of two lines:

• In the top line of the Navigation Bar you see (from left to right) the ABSYNTH logo, the tabs opening the different Windows, the Record button, the CPU meter, the Input and Output Level meters, the Panic button and the NI logo. More information about these features is available below.

• The bottom line includes mostly options to load and save Sounds and navigate through the Library.

4.1 Top Row: Global Controls

4.1.1 ABSYNTH 5 Logo

Interactive ABSYNTH button

Clicking on the ABSYNTH 5 logo has the same effect as clicking on the NI logo: both open the About screen. This About screen contains some important information: the version number, license type and serial number of your copy of ABSYNTH 5, along with the list of all the people who worked on this great synth!
4.1.2 Window Tabs

Window tabs in Navigation Bar

These eight tabs allow you to select a particular Window to display. As already mentioned, a Window is a specific work environment in ABSYNTH 5 (see section 2.1, “Windows, Pages, Panels and Tabs”, above). The following Windows are available: Browser, Attributes, Perform, Patch, Effect, Wave, Envelope and LFO. To activate a particular Window, click on the eponymous tab. ABSYNTH 5 replaces the currently displayed Window with the new selected one and the corresponding tab gets highlighted.

Opening Several Windows Simultaneously

In the stand-alone version of ABSYNTH 5 you can open a Window in the main ABSYNTH 5 interface in a new pop-up window instead of replacing esion of ABSYNTH 5:, hold [Ctrl] (Windows Vista/XP) or [Cmd] (Mac) depressed while clicking on one of the tabs in tup Window instead. This works for the following tabs/Windows: Patch, Effect, Wave, Envelope and LFO. This can be very handy, especially if you have a large computer screen: you can display two or more Windows, place them where you want on your screen and work simultaneously on different parts of ABSYNTH 5, both giving you a better overview of various ABSYNTH 5 components and preventing you from switching back and forth between different Windows.

⚠️ Opening Windows simultaneously is only available in stand-alone mode!

4.1.3 Record Button

Record button

A click on the button shows/hides the Audio Recorder. For more info on the Audio Recorder, please refer to section 12.2 “Audio Recorder”.
4.1.4 CPU Meter

The CPU meter indicates the processing load being used by ABSYNTH 5.

When the computer’s processor is overloaded, distortions and audio drop-outs are very likely to happen during playback. To avoid this, it is worth keeping an eye on the CPU meter.

The processing load depends above all on two factors: the complexity of the Sound and the number of voices played. ABSYNTH 5 uses a dynamic voice allocation; voices that are not played do not contribute to the processing load. The more notes are played simultaneously, the higher the CPU read-out will go. If the CPU overloads, it is recommended to leave out a couple of notes in order to reduce the processing load. If your computer reacts sluggishly to incoming commands, it is probably because your CPU is overloaded and there is not enough resources available for generating the image on the screen. If this happens, try to decrease the load by releasing a few notes.

If ABSYNTH 5 overloads the CPU, the audio hardware installed on your computer might get out of step and no longer be able to accurately produce sound. In such a case, you have several options to restore operations back to normal:

► Release all of the notes on your MIDI keyboard. This releases resources used by ABSYNTH 5 for every voice.

► Click on the Panic button in order to reset the ABSYNTH 5 engine, and stop playing (see section 4.1.6 below).

► Click on the Next or Previous Sound button to switch to another Sound (see section 4.2.3 below).

► Click on a Module Slot frame in the Patch Window to turn a Module on or off. This will also reset ABSYNTH 5’s audio engine.
4.1.5 Input and Output Level Meters

The Input and Output Level meters indicate the levels of the incoming and outgoing audio signals:

Input Output Level meters

The four LED chains labeled In indicate when a signal is going into an Oscillator module. You can read the levels of the outgoing signals on the eight LED chains labeled Out. As explained in the section on surround configurations in the Options dialog (see 3.4 above), ABSYNTH 5 can handle up to eight simultaneous audio outputs. Each of these eight outputs has its own LED chain.

4.1.6 Panic Button

Panic button

The Panic button allows you to interrupt the audio playback in ABSYNTH 5, in case something goes wrong and unwanted sound is being produced. Click on the Panic button to reset the audio engine of ABSYNTH 5 and to stop the playback process. All of the MIDI notes that have been “left hanging” will also reset.

4.1.7 NI Logo

Interactive NI logo

Clicking on the NI logo has the same effect as clicking on the ABSYNTH 5 logo: it opens the About screen. This About screen contains some important information: the version number, license type and serial number of your copy of ABSYNTH 5, along with the list of all the people who worked on this great synth!
4.2 Bottom Row: Sound Management

4.2.1 File and Edit Menus

File menu and Edit menu

The File menu and Edit menu mirror the File menu and Edit menu of the Application Menu Bar in stand-alone mode, except the entries Audio and MIDI Settings... and Exit, missing from the File menu here.

Therefore, please refer to section 3.1, “File Menu”, and 3.2, “Edit Menu”, for more info on the commands found in the File menu and Edit menu, respectively.

4.2.2 Sound Name Display and Sound Menu

Sound Name display / Sound menu

The Sound Name display / Sound menu shows the name of the Sound currently loaded. A click on the display opens the Sound menu that lets you choose another Sound to load from the current Search Result List or from the current folder:

- If you used the Browser’s Database view to find and load the current Sound from the Search Result List, then a small magnifying glass icon appears to the left of the Sound Name display. The Sound menu then shows the Sounds from the current Search Result List (see section 11.2.1 “Database View” for more info).

- If you loaded your Sound from the File Tree view, then a small folder icon appears to the left of the Sound Name display, and the Sound menu shows the Sounds available within the same folder from which you loaded the current Sound (see section 11.2.2, “File Tree View”, for more info).

- If you loaded your Sound from the Program List, a small MIDI plug labeled PC appears instead, and the Sound mMenu displays all Sounds that you added to the Program List (see section 11.2.3 “Programs” for more info).
At the top of the Sound menu, the subentry Mutate History allows you to select one of the existing Sound Mutations stored in the Mutation History. For more info on the Mutator and the Mutation History, please refer to section 11.3, “Mutator.”

4.2.3 Previous/Next Sound Buttons

Previous/Next Sound buttons

These buttons allow for quick-scanning through the Search Result List, the current folder or the Program List: the behavior of the Previous/Next Sound buttons depends on the view that you used to load the current Sound:

• If you used the Browser’s Database view, they scroll through your current Search Result List.
• If you used the Browser’s File Tree view, they scan the content of the folder from which you loaded the current Sound.
• If you used the Program List, they scroll through your Program List.

For more info on these concepts, please refer to section 11.2, “Searching and Loading Sounds with the Browser”.

4.2.4 Mutate and Retry Buttons

Mutate and Retry buttons

The Mutate and Retry buttons are shortcuts for the Mutate button and Retry button of the Mutator in the Browser. For more info on their functions, please refer to section 11.3, “Mutator”.

ABSYNTH 5 Reference Manual – 34
4.2.5  Save and Save As Buttons

The Save and Save As buttons are shortcuts for the Save and Save As... commands found in the File menu (see their description at section 3.1, “File Menu”, above).

Further instructions on loading, saving and administration of Sounds can be found in chapter 11, “The Browser and Attributes Windows”, which also provides an extensive description of ABSYNTH 5’s Browser.

4.2.6  Database Activity Indicator

The Database Activity indicator shows up when ABSYNTH 5’s Database is being updated. The indicator only appears when ABSYNTH 5 currently does maintenance work on the Database – typically when you triggered the Rebuild Database button.

! You can continue your current work during Database activity, but the Browser might not display all results in Database view: wait a few moments, and the Database will be fully functional again.

4.2.7  Keyboard Button

A click on the Keyboard button shows/hides the Virtual Keyboard at the bottom of ABSYNTH 5’s interface. For more info on the Virtual Keyboard, please refer to section 12.1, “Virtual Keyboard”.

5  Patch Window

The Patch Window is the control center of ABSYNTH 5 where you assemble the components that make up a Sound. These components contribute to producing and shaping the desired output. The modules represent the individual components in the Patch Window. There are different types of modules: Oscillator modules are the sound sources of ABSYNTH 5. Modulator modules, Filter modules and Waveshaper modules shape the sound. In the following sections you will find detailed descriptions of the different modules and their features.
5.1 Signal flow in the Patch

As you know from the Getting Started guide, the design of ABSYNTH 5 is semi-modular. That means that you can determine the arrangement of certain components yourself. Other components have a permanent place in the signal flow.

5.1.1 Combining Modules in the Channels

The Patch Window organizes the modules components into three Channels. These Channels are designated with the letters A through C and they each consist of three vertically arranged fields, the Module Slots. Each of these Module Slots can be filled with a module. To turn a module on or off, click on the extended border on the left side of the Module Slot – where the writing indicates the type of module.

When inserting the modules, the following rules apply:

- The Module Slots A-C at the top of the three Channels can only be loaded with an Oscillator module.
- The remaining Module Slots 1 and 2 of any Channel can be loaded with Modulator, Filter or Waveshaper modules.

While the Oscillator module always works as a signal source, the other modules can shift between different types of operation: If you turn on a module, then this module type will appear in the border of the Module Slot. Once activated, its Type menu allows you to switch between the operating modes Filter, Modulator and Waveshaper. So, for example, you can insert Filter modules into both Slots of one Channel, and insert two Waveshapers into another Channel.
5.1.2 Channel Level controls

Beneath Channels A, B, and C you can see three horizontal sliders, known as the Channel Level controls. These sliders allow you to adjust the levels of the three Channels:

Channel Level controls

ABSYNTH 5 can also adjust the levels automatically so that the sum of the three audio signals never exceeds 0 dB, even after a value in one of the three Channels has been changed. To activate automatic volume levels, activate the option Auto balance patch channels in the General page of the Options dialog (see section 3.4, “Options Dialog”, for more info). You also have the possibility to balance Channels manually, giving the same level to each. To do this, select the entry Balance Levels from the Edit menu in the Navigation Bar or in the Application Menu Bar (stand-alone version on

5.1.3 Surround Pan Switch

The Surround Pan switch, which is located in the lower left-hand corner of the Patch Window, allows you to activate/deactivate the Surround Pan mode:

Surround Pan switch

This mode allows you to freely position the three Channels in the surround panorama. This function can be used for impressive spatial effects, for example, by modulating the surround position of the Channels independently of one another with an LFO or an Envelope. More information about this is available in the chapters 8, “Envelope Window”, and 9, “LFO Window”.

5.1.4 Master Channel

Active Master Channel modules

The signals delivered by the activated Oscillator modules run through the other activated modules in each Channel, and are then mixed in the Master Channel, which is arranged horizontally at the bottom of ABSYNTH 5‘s interface. In the Master Channel, the signal runs from the left to the right.

In this Channel, there is a Module Slot reserved for a particular module: the Effect module, which can always be found at the bottom-right of the Patch Window – thus at the end of the module chain. The other two Module Slots in the Master Channel can be inserted with Modules of your choice (except Oscillator modules).

After the Effect module, the final signal leaves ABSYNTH 5.

💡 The glowing connection wires between activated modules visualize the signal flow!
5.1.5 Mono Mode and Poly Mode in the Master Channel

The modules in the Master Channel have two operating modes: Poly mode and Mono mode. You can switch between both modes by clicking on the Mono/Poly switch:

Mono/Poly switch

- In Mono mode (three arrows meeting each other), the signals coming from the three Channels A-C are summed up before being processed by the module.
- In Poly mode (three parallel arrows), the module processes each Channel separately.

As a logical consequence, you cannot have a module in Poly mode sitting after a module in Mono mode, since the three Channel signals have already been summed up by the first module...

The difference between the two modes can be heard particularly clearly in the Waveshaper module: In Poly mode every voice has its own, independent Waveshaper. The distortion affects every voice separately – in the same way as if every string on a guitar had its own amplifier. In Mono mode, only one Waveshaper is used for the different voices, which means that many of the notes played interact – similar to the way that they do in chords played on a distorted electric guitar. You can try out the effect simply by inserting a Waveshaper module into the Master Channel. Play a couple of sounds and switch between both modes by clicking on the Mono/Poly switch. You will see that the Mono mode reacts with significantly stronger distortion as you begin to play multiple notes. This is because the signals of the different voices are assembled before the Waveshaper input, which results in a higher input gauge. In Poly mode, by contrast, the voices are distributed among multiple Waveshapers and thus produce lower signal levels.

For low level input signals, the Waveshaper in Mono mode works like a simple compressor and lends itself well to compressing and heating up the input signal.
5.2 Common Features for all Modules

The various modules available in the Patch Window share these common features:

- Edit menu
- Panels and tabs
- Template functionality and Universal Library

5.2.1 Edit Menu

The Edit menu for a Filter module.

Each module offers an Edit menu in its upper left corner. This Edit menu holds global functions for that module. Its entries are grouped as follows:

- The first entries allow you to copy the current settings of the module to the clipboard in order to paste them later in another module of the same type, and to paste within the module the settings previously stored in the clipboard. The Oscillators additionally offer to copy/paste the entire Channel.

- The following entries allow you to save and load Templates, i.e. pre-configured modules/Channels with all their settings (see the section 5.2.3, “Universal Library”, below for more info on this).

- The last two entries allow you to apply a Mutation and to retry a Mutation, both for that particular module. The settings for this Mutation are those defined in Mutation section Mutator section (see section 11.3, “Mutator”, for more on this).
5.2.2 Panels and Tabs

Each module can have up to three panels organizing the various module parameters. Each panel can be called by clicking on the corresponding tab at the top of the module.

The available panels depend on the type of the module (Oscillator, Filter, Modulator or Waveshaper) as well as on the specific mode for each module type. You will find a complete list of available panels in the module-specific sections below.

5.2.3 Universal Library

The Universal Library in ABSYNTH 5 makes it easier to bring together complex Sounds. You can save and load so-called Templates for individual Waveforms, Envelopes, Effects, complete modules with the appropriate Envelopes, and even entire Channels from the Universal Library.

![warning]
The actual location of the Universal Library on your hard drive can be changed in the Options dialog via the option Template Libraries Directory of the General page (see section 3.4, “Options Dialog”, for more info on the Options dialog).

In the Patch Window, you can save and load Channels, modules and Effect settings together with all their relevant Envelopes. When you save a Channel, a module or Effect settings as a Template in the Universal Library, the Envelopes are automatically filed with it.

To load Templates, choose the category you want from the module’s Edit menu:

- In an Oscillator, select the option *Load Oscil Template* to load a pre-configured Oscillator. The command *Load Channel Template* allows you to load a complete Channel.

- In a Filter, Modulator or Waveshaper module, the Edit menu solely offers a *Load Template option* that loads the settings for that module.
To save Templates, the method is similar:

- In an Oscillator, select the option *Save Oscil Template* to save a pre-configured Oscillator. The command *Save Channel Template* allows you to load a complete Channel.
- In a Filter, Modulator or Waveshaper module, the Edit menu solely offers a *Save Template* option that saves the settings for that module.

⚠️ ABSYNTH 5 sorts the Library automatically for you: for example, you cannot load a Filter Template into an Oscillator nor save a Waveshaper Template in the Envelopes folder.

The Patch Window is not the only location with access to the Universal Library. In the Envelope Window and in the Wave Window you can also load and save Templates. For example, you can store individual Envelopes and Waveforms in the Library. In the Envelope Window and Wave Window, you can access the Universal Library via the Transform menu.

ABSYNTH 5 includes an extensive Library of Channels, modules, Envelopes, Effects settings and Waveforms. To see how quickly the prefabricated Channels from the Library can help you to build a complex Sound, simply do the following:

1. Click on the left margin of an empty Oscillator Module Slot in the Patch Window to activate the Oscillator.

2. Choose the entry *Load Channel Template…* from the Edit menu on the upper left corner of the Oscillator. The Channel Templates list opens up immediately.

3. Choose the desired entry from that list and click on “OK.” Your Channel is now well populated.

4. Do the same with the other two Channels.
   → You created a complete Sound in just a few seconds where it could have taken hours “by hand!”
Using Old Personal Templates

If you want to use ABSYNTH 4 Templates in ABSYNTH 5, you need to copy them to the new Libraries folder.

- On Mac OS X, your old Templates are located by default in the directories “HD:Library/Application Support/Native Instruments/Absynth 4/Libraries/[subdirectories]”.

⚠️ Please be careful! On a Mac, you should not replace the ABSYNTH 5 Libraries folder with the ABSYNTH 4 Libraries folder, since Mac OS X would overwrite all the new ABSYNTH 5 Templates! Instead, you should open each folder contained therein and copy the contents of each of the lowest level subfolders manually to the corresponding subfolder in the ABSYNTH 5 Libraries directory.

- On a PC, your old Templates are located by default in the directories “C:\Programs\Shared Files\Native Instruments\Absynth 4\Libraries\[subdirectories]”. You should be able to simply copy and paste the whole ABSYNTH 4 Libraries folder to the ABSYNTH 5 Libraries folder and click on “Replace all”.

In any case, we recommend you to back up your ABSYNTH 5 Libraries folder before touching it!

5.3 Common Features in Many Modules

The following features appear in many situations. Knowing them is very helpful for understanding of the modules’ capabilities:

- Waveform Selector and Waveform Selection dialog
- Frequency menu/control
- Anti-Alias Switch
- Phase Inverter
5.3.1 Waveform Selector and Waveform Selection dialog

Waveform Selector

The Waveform Selector is available for all oscillator modes based on a wavetable. It allows you to choose the Waveforms for the oscillators in ABSYNTH 5. This is not only the case for the various oscillators within the Patch Window, but also for all other functions in ABSYNTH 5 using Waveforms as a foundation. For example, you will also find the Waveform Selector in an identical form in the LFO Window and in the LFO area of the Envelope Window.

A click on the Waveform Selector opens the so-called Waveform Selection dialog. This dialog essentially contains a list of all available Waveforms:

Using the three buttons above the list, you can switch it between three categories of Waveforms:

- **Simple Waves** are single cycle Waveforms that are read from a wavetable. This relates to the tiny samples that contain one period of a particular Waveform. In this rubric, next to the standard forms like *Sine, Triangle, Saw and Square*, you also find instrumental and atonal Waveforms.

- **Morph Waves** are Waveforms that use the function Wave Morph (see section 7.5 “Wave Morph”). From a technical point of view, Morph Waves are two Waveforms saved in one unit of data, which seamlessly blend (“morph”) with one another.

- **Library Waves** are the Waveforms from the Universal Library of ABSYNTH 5.
In order to display the Waveforms of a particular category in the list, click on the corresponding button at the top of the Waveform Selection dialog.

To load a Waveform into the module, click on its entry in the list. The new Waveform becomes immediately active, so that the effects on the sound can be heard as soon as you press a key on your MIDI keyboard. The small waveform display next to the Waveform Selector also displays the new Waveform straightaway. When you have decided on a Waveform, click “OK” at the bottom of the Waveform Selection dialog.

► In order to create a new Waveform, select a Waveform in the list and click on the New Wave button (labeled New), at the top of the dialog:

→ A new Waveform based on the selected Waveform is generated and loaded into the Wave Window. ABSYNTH 5 switches the current Window automatically to this Wave Window.

⚠️ Remember that your work does not affect the original Waveform, but rather produces an independent copy of it.

► If you want to work on a Waveform that already exists, click on the Edit Wave button (labeled Edit), at the top of the dialog.

→ ABSYNTH 5 loads the selected Waveform automatically into the Wave Window and switches the Window in an according fashion.

You can only work on Waveforms that you created yourself (by clicking on the New Wave button in the past). You cannot modify the Factory Waveforms.

The chapter 7, “Wave Window”, gives you all details about working with the Wave Window.
5.3.2 Frequency Menu and Frequency Control

Frequency menu in Trans mode

All oscillators can be set to react to incoming notes in various ways. These are key modes. Using anel’s Frequency menu and its companion thcy control sitting at its right, you can to choose from the following Frequency modes:

- **Trans**: The oscillator follows the pitch of the played note. The Frequency control determines the transposition in semitones. For example, setting the Frequency control to 1.5 will lead to a transposition of one and a half tone compared with the pitch of the played note. The Frequency control has a resolution of 1/1000 of a halftone.

- **Ratio**: Tranposes the oscillator according to a frequency ratio (for example along the harmonic sequence: 2 corresponds with a transposition of 12 halftones, 3 with a transposition of 19 halftones, etc.). This mode is especially useful when using frequency modulation and ring modulation.

- **Hz**: Fixed pitch in Hertz. In this mode, also useful for frequency and ring modulation, the oscillator ignores the pitch of the note played. Rather, the pitch of the oscillator does not reacts to information like pitch bend or to signals coming from an LFO, but it can be controlled via an Envelope.

- **Note**: Fixed pitch corresponding to a selectable MIDI note. This mode is similar to the Frequency Mode Hz, but is more appropriate when you want to use the oscillator on a note-bound frequency (e.g. 60.5 = C3 plus a quarter-ton).

💡 You can switch between the Frequency mModes Hz and Notes to display the exact frequency of particular notes.
5.3.3 Anti-Alias Switch

The Anti-Alias switch enables you to smooth peaks in various situations. Anti-aliasing provides a smooth, almost analog sound. In order to turn on the anti-aliasing, click on the Anti-Alias switch (the small steps/ramp button).

When the symbol displays little steps, the anti-aliasing function is off. A smooth line (ramp) indicates that the function is on for this oscillator.

This makes a big difference with high frequencies. Without it, you would probably hear something called “fold back” – a not so subtle form of digital distortion that makes high tones sound coarse or harsh (two properties that are sometimes desired, but usually not). Anti-aliasing reduces the fold back to a large extent. Keep in mind that when an oscillator smoothes over edges, it uses more CPU power. If you can discern no difference between enabled and disabled anti-aliasing, it would be best if you left it turned off.

⚠️ For compatibility reasons, all patches created with ABSYNTH 1 are opened with the Anti-Alias switch deactivated. With ABSYNTH 5, you can create patches for which some Channels have the Anti-Alias switch enabled and some others have not.
5.3.4 Phase Inverter

The Phase Inverter is available in all Oscillator's synthesis modes based on a wavetable. When activated, it simply inverses the phase of the signal generated by the oscillator – in other terms, it shifts the phase by 180°.

5.4 Oscillator Module

Oscillator module

The three Oscillator modules are the only sound sources in ABSYNTH 5. All other modules only modify the sounds produced by the Oscillators. If none of the Oscillators are turned on, you will hear no sound, and none of the other modules can be activated. Accordingly, the modules of a Channel are only available when its Oscillator is active.

The Oscillators can run in numerous different operating modes, which primarily differentiate by their synthesis process. In the following sections, you will learn more about these individual operating modes. But we will first present the general layout and common features for all Oscillators.

The Oscillator can be inserted into the first Module Slot at the top of each Channel A, B or C of the Patch Window.

To activate an Oscillator module, do the following:

► Click on the extended left margin of the desired Module Slot to activate it.
5.4.1 Oscillator’s Panels and Tabs

The Oscillator always provides you with the following panels: Main, Mod, and Uni (albeit occasionally inactive). Click on a tab to activate the corresponding panel.

Oscillator panels

Main Panel

The Main panel contains all the parameters dealing with the main oscillator of the Oscillator module. The most important element of this Main panel is the Synthesis menu, which defines the type of synthesis performed for the main oscillator. The synthesis modes available in this Synthesis menu are sorted into three groups (separated by horizontal lines):

- Wavetable synthesis (Single, Double, FM, Ringmod, Fractalize, Sync Granular): The Oscillator produces signals based on monocyclic Waveforms.
- Sampling (Sample, Granular): The Oscillator produces signals based on a sample.
- External audio signal (Audio In): The Oscillator delivers an audio signal, which itself comes from an external source.

The other parameters of this panel depend on the selected synthesis mode. We will detail them in the sections describing each individual synthesis mode below.

Mod Panel

The Mod panel (Modulation) holds all parameters of the modulation oscillator. The available parameters depend on the synthesis mode selected in the Main panel. Information about these specialized parameters can be found in the sections describing each individual synthesis mode below.
Uni Panel

The Uni panel (Unisono) allows you to implement multi-voicing at the oscillator level.

Available for the synthesis modes Single, Double, FM, Ringmod and Fractalize, the Uni panel provides you with following parameters:

- **Num Voices**: Sets the number of voices produced by each note played. The highest value is 8.
- **Trans**: Controls the amount of detuning (in semitones) between the original voice and the additional voices. This parameter affects the sound only if the Num Voices value is larger than 1 – in other words, if there are some additional voices to detune.
- **Rand Trans**: Adds a quota of random detuning (upwards and downwards) in half-tones.

The function Unisono allows you to “stack” voices quickly and produce fuller, stronger sounds. If you raise the Num Voices value by 1, a new voice will be added and mixed with the output signal of the Oscillator.

The Trans value determines what interval you desire between the original sound and the tone pitch of the additional voices. Even-numbered additional voices are transposed downwards, odd-numbered voices upwards.

💡 If, for example, you were to set the value for Num Voices at 3 and the value for Trans at 1, every note would be accompanied by a voice that has been transposed one semitone deeper and by another one transposed one semitone higher. If you raise the number of voices to 4, a new (even-numbered) voice will be attached which is a half-tone under the last even-numbered voice (that is, two half-tones under the basic tone). If you were to set the value for num voices at 5, a new (odd-numbered) voice would be attached, which would be one half-tone lower than the last odd-numbered voice.
The parameter Rand Trans produces accidental detuning of the voices with every note in the sequence. Subtly put to work, with a low value for Num Voices, Rand Trans can produce the effect of a sloppy or imprecise intonation (in order, for example, to imitate a string instrument without tension or to give atonal percussion sounds some natural variation). You can get some unpredictable and exciting results by playing around with different selections! In the operating modes Sync Granular, Sample, Granular and Audio In, the Unisono function is not available and the Uni tab and panel are inactive.

5.4.2 Oscillator’s Edit Menu

The Edit menu, located in the upper left-hand corner of the Oscillator, is available for all kinds of Oscillators. It provides the following options:

- **Copy Oscil**: Copies the settings of the selected Oscillator to the clipboard.
- **Copy Channel**: Copies to the clipboard the settings of all active modules in that Channel.
- **Paste Oscil**: Places the settings stored in the clipboard (via the command Copy Oscil) into the selected Oscillator.
- **Paste Oscil and Envelopes**: Places the settings stored in the clipboard (via the command Copy Oscil) into the selected Oscillator. Any Envelopes linked to the Oscillator are also placed within the Oscillator.
- **Paste Channel**: Places the Channel settings stored in the clipboard into the current Channel.
- **Load Oscil Template**: Opens a dialog allowing you to choose Oscillator settings to load from a list of predefined Oscillator Templates. Click on the desired entry in the list and click “OK” to load that Template.
- **Load Channel Template**: Opens a dialog allowing you to choose Channel settings to load from a list of predefined Channels Templates. Click on the desired entry in the list and click “OK” to load that Template.
- **Save Oscil Template**: Allows you to save the current Oscillator settings as a Template in the Universal Library. In the dialog that opens, choose the name and saving location for the Template, then click then on “OK” to save the Template.
• **Save Channel Template**: Allows you to save the current Channel settings as a Template in the Universal Library. In the dialog that opens, choose the name and saving location for the Template, then click then on “OK” to save the Template.

• **Mutate Oscil**: Applies a Mutation to that particular Oscillator.

• **Retry Mutate Oscil**: Retries the Mutation for that particular Oscillator.

For the last two entries, the Mutation settings are those defined in the Browser’s Mutator section (see section 11.3, “Mutator”, for more on this).

### 5.4.3 Single Mode

![Oscillator in Single mode](image)

In the Single mode, a single main oscillator is active.

The Main panel contains all parameters controlling the main oscillator:

• **Synthesis menu**: Selects the desired synthesis process (see section 5.4.1 “Oscillator’s Panels and Tabs” above for details).

• **Waveform Selector**: A click on the Waveform Selector opens the Waveform Selection dialog where you can select the Waveform for the Oscillator (see section 5.3.1, “Waveform Selector and Waveform Selection dialog”, above for details).

• **Anti-Alias switch**: Turns the anti-aliasing on and off (see section 5.3.3 “Anti-Alias Switch” above for details).

• **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). See section 5.3.2, “Frequency Menu and Frequency Control”, above for details.
• **Phase Sync switch:** Setting the Phase Sync switch to Phase will reset the phase of the oscillator with every incoming MIDI note. When the Phase Sync switch is set to Free, the oscillator will not be reset. When only one oscillator is active and you have set one voice in the Uni panel, the mode Free has almost no effect. When you have a higher Unisono number of voices or multiple active oscillators, every note leads to an audible change in the sound.

• **Phase control:** Sets the phase of the Oscillator. The effect is only audible if a second Oscillator is active. This parameter is useful when using integer values for frequency ratios between carrier and modulator, as it is the case in FM.

### 5.4.4 Double Mode

Oscillator in Double mode

In Double mode, a pair of oscillators – consisting of the Main oscillator and the Mod oscillator – is active. The signals of the two oscillators are mixed.

On the Main panel, you will find the same parameters as in Single mode. For more info on these parameters, please refer to the section 5.4.3, “Single Mode”, above.

On the Mod panel, the following parameters are available:

• **Balance control:** Controls the balance between the oscillators Main and Mod within the Oscillator’s output signal.

• **Waveform Selector:** This opens a dialog where you can choose the Waveform for the Mod oscillator (see section 5.3.1, “Waveform Selector and Waveform Selection dialog”, above for details).

• **Frequency menu and Frequency control:** Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). See section 5.3.2, “Frequency Menu and Frequency Control”, above for details.
• **Phase control**: Sets the phase of the Oscillator. The effect is only audible if a second Oscillator is active. This parameter is useful when using integer values for frequency ratios between carrier and modulator, as is the case in FM.

  An Oscillator in Double mode uses less CPU power than two Oscillators in Single mode.

### 5.4.5 FM Mode

Oscillator in FM mode

Frequency modulation was discovered in the late 1960’s by John Chowning and achieved great popularity in the 1980’s through Yamaha’s DX7 synthesizer. Much has already been written about FM synthesis so we will not go into detail here.

In FM mode, the Mod oscillator modulates the frequency of the Main oscillator.

On the Main panel, you find the same parameters as in Single mode. For more details, please refer to the section 5.4.3, “Single Mode” above.

On the Mod panel, the following parameters are available:

• **FM Index**: This determines the depth of the Frequency Modulation.

• **Waveform Selector**: Clicking the Waveform Selector allows you to choose the Waveform for the oscillator (see section 5.3.1, “Waveform Selector and Waveform Selection dialog”, above for details).

• **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). See section 5.3.2, “Frequency Menu and Frequency Control”, above for details.
• **Phase control**: Sets the phase of the Oscillator. The effect is only audible if a second Oscillator is active. This parameter is useful when using integer values for frequency ratios between carrier and modulator, as it is the case in FM.

### 5.4.6 Ringmod Mode

In Ringmod mode, the signals from the main oscillator and the mod oscillator are multiplied with one another.

On the Main panel, you find the same parameters as in Single mode. For more details, please refer to the section **5.4.3, “Single Mode”, above.**

On the Mod panel, the following parameters are available:

- **Balance control**: Controls the balance between the oscillators Main and Mod within the Oscillator’s output signal.
- **Waveform Selector**: Click on the Waveform Selector to open a dialog where you can choose the Waveform for the oscillator (see section **5.3.1, “Waveform Selector and Waveform Selection dialog”, above for details).**
- **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). See section **5.3.2, “Frequency Menu and Frequency Control”, above for details.**
5.4.7 Fractalize Mode

Oscillator in Fractalize mode

Experienced ABSYNTH users will recognize the Fractalize mode as a real time version of the function Fractalize available in the Transform menu of the Wave Window (which also functions very similarly). In Fractalize mode, the selected Waveform is copied to itself, so that you can see smaller elements of the Waveform that are similar to the image of the whole. You can use the Fractalize mode to add overtones to a plain Waveform.

On the Main panel, you find the same parameters as in Single mode. For more details, please refer to the section 5.4.3, “Single Mode”, above.

On the Mod panel, the following parameters are available:

- **Iterations**: With this parameter you can choose the number of similar repetitions that you want of the same sound, and how much you want to deviate from the original Waveform. The value area is between 2 and 7; higher values lead to more complex, lighter-sounding sounds – and to a heavier CPU loads.

- **Amount**: With this you can define the mixing relationship between the original waveform and its copies.

- **Displace**: With this parameter you can define the shift of the copied area relatively to the original Waveform: 0 corresponds to a position before the Waveform, 1 to a position after the Waveform. With a value of 0.5, the area is directly central to the Waveform. If you modulate this parameter with an LFO or an Envelope, interesting movements inside the sound will result.

The function Fractalize in the Wave Window gives you an idea of what happens. Load a simple Waveform (such as a sine) into the Wave Window. Check under the Wave View: so far nothing has happened. Choose the entry Fractalize from the Transform menu. Set Iterations to 2 and Displace to 9. Slowly increase the value for Displace up to 25. You see how the waveform distends. Change the value for Iterations; the higher the value, the more dislocated the Waveform becomes.
In Fractalize mode, the Uni panel contains a somewhat different combination of parameters than in the modes Single, Double, FM and Ringmod: Trans and Rand Trans work in exactly the same way as in the other modes. But instead of the parameter Num Voices, the parameter Iterations operates a similar function in setting the number of voices in Fractalize mode.

Fractalize mode works particularly well with Waveforms that contain limited, yet strong harmonics: you will see new overtones emerge around the basic harmonics. By choosing the right Waveform you can achieve interesting, formant-style effects. With harmonically dense Waveforms (e.g. the saw from the ABSYNTH 5 Waveform Library) the effect is not as striking.

5.4.8 Sync Granular Mode

The Sync Granular mode works along the same lines as the Granular mode (see section 5.4.10, “Granular Mode”, below for more details): It divides a Waveform into the smallest parts (the so-called “grains”) and then brings these parts back together. The difference between the granular synthesis processes in ABSYNTH 5 relates to the input material that is used: In Granular mode, the grains are taken from a sample, whilst the Sync Granular mode uses a Waveform from the Library. In Sync Granular Mode, you can take your own Waveforms or an existing Waveform from the Library, tear it apart, and then put it back together again in a new way.

Before putting the grains back together through a process known as resynthesis, you can influence the grain “cloud”: You can change the frequency of the grains, change the Density control value to determine how individual grains overlap, and use the parameter Scatter to manipulate the level of diffusion of the grain cloud.

These options allow you to create very effective sounds and, for example, convincingly simulate the blowing sound of a wind instrument such as a pipe or flute.

On the Main panel, you find the same parameters as in Single mode. For more details, please refer to the section 5.4.3, “Single Mode”, above.
On the Mod panel, the following parameters are available:

- **Balance control**: Here you set the mix relationship between the original Waveform and the Waveform produced by resynthesis. With a value of 0 only the original Waveform can be heard, with a value of 1 only the resynthesized Waveform.
- **Dens control**: Here you define the density of the grain cloud by setting how individual grains overlap. The values range from 3 to 8; small values give a raw sound, higher value a more polished sound.
- **Scatter control**: With this you can control the diffusion, that is, the accidental scattering of the grain cloud.
- **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). See section 5.3.2, “Frequency Menu and Frequency Control”, above for details.

### 5.4.9 Sample Mode

![Oscillator in Sample mode](image)

The Oscillator module rules two sample-based modes: Sample and Granular. These modes make it possible for you to use ABSYNTH 5 as a sampler, playing back previously uploaded sound data in the WAV or AIFF format.

The basic control is the same in both modes, so the following instructions on the Sample mode also apply to the Granular mode described in the next section.

In contrast to conventional sampling instruments, ABSYNTH lacks the usual functions such as key mapping, velocity layering or AKAI import. Unlike the conventional samplers, ABSYNTH’s emphasis is not on the realistic reproduction of sampled instruments, but rather the creative possibilities that sample-supported synthesis provides.
All three Oscillator modules can load a sample; in a single Sound you can use up to three different samples.

Before you experiment with ABSYNTH’s sampling possibilities, you should first load a neutral patch. Choose the New Sound option in the File menu of the Navigation Bar, and then open the Patch Window.

In order to load a Sample into an Oscillator module, do the following:

1. Choose the Sample entry from the Synthesis menu. On the Sample Selector below, you will see (none) displayed:

![Sample Selector](image)

2. Click on this Sample Selector. This activates a dialog that allows you to choose a sample to open on your hard drive.

3. Choose a sample file that you would like to load and click on “Open.”
   
   → The Sample is now loaded, and the Sample Selector displays its name.

ABSYNTH 5 can read AIFF and WAV data (stereo or mono) ranging from 16 to 32 bit and any sampling rate.

In Sample mode, the Main panel holds the following parameters:

- **Sample Selector**: See description above.

- **Mono/Stereo switch**: Stereo samples can be reproduced in stereo or mono, depending on your liking. If you have loaded a stereo sample, you can use the Mono/Stereo switch to switch between mono and stereo reproduction. If your sample cannot be switched to stereo, then it is a mono sample.

- **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note). The Sample will be reproduced with its original speed when the MIDI Note C3 is played. Lower notes produce a slower, lower sound, while higher notes sound higher and faster. See section 5.4.2, “Oscillator’s”, above for more info on these controls.
• **Start control**: Defines the starting point of the playback within the Sample relatively to the overall sample duration.

The Mod panel offers you one parameter:

• **Play Mode menu**: This menu lets you choose from three playback modes. If No Loop is selected, the sample is played once (good for percussion sounds). If Loop All is selected, the entire sample is played as a loop (this works best if you edit the loop beforehand to create a seamless loop). If Loop Edit is selected, two additional parameters allow you to adjust the start point and end point of the loop.

### 5.4.10 Granular Mode

The Granular mode also uses a sample as basis for the sound creation. However, this mode divides the sample into many small grains, each containing a tiny fragment of the sound. In this way you can independently control the sample’s pitch and duration. In Granular mode, the duration of a Sample remains the same over the entire keyboard, whilst the notes determine the pitch.

On the Main panel, you find the same parameters as in Sample mode. For more details, please refer to the section **5.4.9, “Sample Mode”, above.**

The Mod panel contains following parameters:

• **Time %**: Determines the playback speed of the sample. 50 % corresponds to half of the original speed while 200 % doubles the speed of your sound. If you set this value to zero, the Sample for that length of time will “freeze.” When you have frozen a sample, you can use the parameter Start control on the Main panel to establish when exactly it should freeze.
• **Dens**: Determines the number of grains played simultaneously. Here you can set values between 1 and 8. A lower value produces a thinner sound, whereas a value of 8 produces a dense granular cloud. Remember: Big Dens values use a lot of CPU power!

• **Size**: Determines the length of every grain (in samples – here in its signal processing meaning!). Smaller values are good for percussive sounds, whereas higher values function well for pad-like sounds or string instruments. Bear in mind that small values tend to conceal the character of the sample and produce typical granular artifacts in the form of noise. The maximum value for the parameter is 9,999 samples (approximately 225 ms at a sampling rate of 44.1 kHz).

• **R Time**: Defines the randomness of the grains’ playback speed. Zero corresponds to no randomness during grain playback, whilst 100 means that the grains are played completely at random – within the time window defined by the Size parameter.

• **R Freq**: Changes the pitch of individual grains randomly. Zero means no randomness, whereas 100 assumes complete randomness concerning pitch.

• **R Amp**: Changes the amplitude (“loudness”) of the individual grains randomly. A value of zero means no randomness whilst 100 means complete randomness.

### 5.4.11 Audio In Mode

![Oscillator in Audio In mode](image)

In the operating mode Audio In, the Oscillator does not produce the signal itself, but rather transmits incoming audio signals to its output. That makes it possible for any audio signal to work with the other modules in ABSYNTH 5 in real time. ABSYNTH 5 can thus be used as an effect and work with live audio signals being played elsewhere. You can also load ABSYNTH 5 as an effect plug-in in your audio MIDI sequencer and let it process any audio track.
When you have created a Sound in which some Oscillators work in the Audio In mode, you should assign this Sound to the category “Effect” in the Attribute Window, so that it appears in the relevant search results within the Browser Window.

You can access all of the Audio In parameters through the Main panel:

- **Mono/Stereo switch**: You can choose between mono and stereo signals. If you choose mono, you will only see one Input menu below. If you choose stereo, then a second, identical Input menu appears.

- **Level control**: Increases or attenuates the input signal level. At the default value of 0 dB, the signal passes through the input stage unchanged.

- **Input menu**: Chooses from one of six possible audio inputs, which you can configure in the Audio and MIDI Settings dialog of the stand-alone version (in the File menu of the Application Menu Bar).

External audio signals run through ABSYNTH 5’s signal path in exactly the same way as internally created signals and so are also influenced by ABSYNTH 5’s Envelopes. This means that you do not hear audio signals from external sources unless ABSYNTH 5 has received MIDI notes and used them to trigger the Envelopes!

### 5.5 Filter Module

The Filter module provides a number of filters to work with. You can work on the frequency spectrum of a sound by, for example, emphasize the high frequencies while reducing the lower frequencies.

#### 5.5.1 General Functioning

The Filter modules can be inserted in any Module Slot of the Patch Window, except the first Slot in each Channel A-C (these are reserved for Oscillator modules) and the last Slot in the Master Channel (reserved for the Effect module).
To activate a Filter module, do the following:

1. Click on the extended left margin on a Filter, Modulator or Waveshaper Module Slot to activate it.
2. Choose one of the filter types from the Type menu (the first and biggest group in the menu).

### 5.5.2 Filter’s Panels and Tabs

Like all other modules, a Filter module can have up to three panels organizing the various module parameters. Each panel can be called by clicking on the corresponding tab at the top of the module.

The available panels depend on the type of filter. You will find a complete list of available panels in the module-specific sections below. But we can already give here two basic rules for these panels:

- All filter types but the Cloud offer a Main panel as first panel, holding the main parameters for that filter type.
- The filter types LPF 2 Pole, LPF 4 Pole, LPF 8 Pole, Allpass 2, Allpass 4, Allpass 8 and Supercomb have an additional FB panel controlling the new feedback loop introduced in ABSYNTH 5 for these filters (see next section).

### 5.5.3 Feedback Loop and Feedback Panel

ABSYNTH 5 introduces a new functionality to some of its Filter modules: a feedback loop. This feedback loop allows you to send a portion of the filter’s output back to its own input… without forgetting to further process the signal on the way! The feedback loop is available for following filter types: LPF 2 Pole, LPF 4 Pole, LPF 8 Pole, Allpass 2, Allpass 4, Allpass 8 and Supercomb.

For all of these filter types, the feedback loop settings are located on the Feedback panel (labeled FB), next to the Main panel:
A typical Feedback panel

Worth to note is that the feedback loop is built inside the resonance loop of the Filters. Therefore, the amount of signal sent in the feedback loop is also affected by the Resonance parameter found on the Main panel of each Filter (except for the Supercomb, where it is called Feedback control).

The panel’s upper line always holds the two following parameters:

- **Anti-Alias switch**: Enables/disables the anti-aliasing, which smoothes peaks in the feedback loop. Click on the Anti-Alias switch – the small steps/ramp button – to change its state (more info on the Anti-Alias switch can be found in the section 5.3.3, “Anti-Alias Switch”).
- **Feedback Mode menu**: This menu allows you to select the desired feedback mode. If Normal is selected, the feedback loop is deactivated. The three other modes available in the Feedback Mode menu are described in the following sections.

### Waveshape Feedback Mode

When this mode is selected in the upper Feedback Mode menu of the Feedback panel, the signal in the feedback loop is processed by a mini-Waveshaper. Hence, the parameters in the lower part the Feedback panel are very similar to those of the Waveshaper module.

The few differences are listed here:

- A Phase Inverter appears next to the Waveform Selector (for more info on the Phase Inverter, see section 5.3.4, “Phase Inverter”).
- The In dB and Out dB controls from the Waveshaper module are here replaced with an Amount control, which defines the proportion of signal processed by the Waveshaper.

The rest is exactly the same as in the Waveshaper. Please refer to section 5.7, “Waveshaper Module”, for more info on its principle, functioning and parameters.
Freqshift Feedback Mode
When this mode is selected in the upper Feedback Mode menu of the Feedback panel, the signal in the feedback loop is processed by a mini-Freqshifter. Hence, the parameters in the lower part the Feedback panel are very similar to those of its big brother, the Modulator in Freq Shift mode.

The few differences are listed here:

- An Anti-Alias switch appears at the top left corner (for more info on the Anti-Alias switch, see section 5.3.3, “Anti-Alias Switch”).
- The Feedback control from the Modulator module in Freq Shift mode was replaced with a Mix control, which defines the proportion of signal processed by the Freq Shifter.

The rest is exactly the same as in the Modulator module in Freq Shift mode. Please refer to section 5.6.3, “Frequency Shift”, for more info on its principle, functioning and parameters.

Ringmod Feedback Mode
When this mode is selected in the upper Feedback Mode menu of the Feedback panel, the signal in the feedback loop is processed by a mini-Modulator module in Ringmod mode. Hence, the parameters in the lower part the Feedback panel are very similar to those of its big brother.

The few differences are listed here:

- An Anti-Alias switch appears at the top left corner (for more info on the Anti-Alias switch, see section 5.3.3, “Anti-Alias Switch”).
- The Balance control from the Modulator module in Ringmod mode was replaced with a Mix control, which defines the proportion of signal processed by the Ring Modulator.

The rest is exactly the same as in the Modulator module in Ringmod mode. Please refer to section 5.6.2, “Ring Modulation”, for more info on its principle, functioning and parameters.
5.5.4 Lowpass

The lowpass filters weaken the signal above an adjustable cutoff frequency. The slope gradient of the signal attenuation is given in dB per octave. A value of -12 dB/octave means that the filter dampens the signal by 12 dB more at one octave higher. Other values for slope gradient are -6 dB and -24 dB.

The slope gradient can also be referred to as the n-pole (this is the most usual case with synthesizers and other electronic sound generators). Most of the time, n stands for an even number between 2 and 8. This data can be easily translated into the dB/octave schema if you remember that every filter pole corresponds to a steepness of -6 dB/octave. So a 1-pole filter has a gradient of -6 dB/octave, a 2-pole filter dampens the signal by -12 dB/octave, and so on.

As a consequence, ABSYNTH 5's lowpass filter LPF 2 Pole and LPF -12dB have for example the same slope gradient. The same applies to the LPF 4Pole and LPF -24dB. Yet they sound different because of their different internal constructions: The first three filters in the list below have a softer, rounder character, whereas the filters in the second group sound rougher and more aggressive.

The following lowpass filters are available in the Type menu:

- **LPF 2 Pole**: 2-pole lowpass filter with resonance control and analog design.
- **LPF 4 Pole**: 4-pole lowpass filter with resonance control and analog design.
- **LPF 8 Pole**: 8-pole lowpass filter with resonance control and analog design.
- **LPF -6dB**: 1-pole lowpass filter with resonance control.
- **LPF -12dB**: 2-pole lowpass filter with resonance control.
- **LPF -24dB**: 4-pole lowpass filter with resonance control.
Main Panel

All lowpass filters in ABSYNTH 5 contain the following parameters on their Main panel:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the cut-off frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.
- **Resonance control**: Sets the resonance at the cutoff frequency.
- **Damping control**: Allows you to balance out the volume level. If the signal level at the filter output seems too weak, increase this value.

Feedback Panel

Furthermore, the filter types LPF 2 Pole, LPF 4 Pole and LPF 8 Pole are equipped with a feedback loop. Its function and parameters are detailed at section 5.5.3 “Feedback Loop and Feedback Panel” above.

5.5.5 Highpass

Highpass Filter HPF -12dB

Highpass filters permit all frequencies above a cutoff frequency and suppress the frequencies below it. Their remaining functions are identical to those described for the lowpass filters in the section 5.5.4, “Lowpass”, above.

The following highpass filters are available in the Type menu:

- **HPF -6dB**: 1-pole highpass filter.
- **HPF -12dB**: 2-pole highpass filter with resonance control.
Main Panel

The highpass filters in ABSYNTH 5 contain the following parameters on their Main panel:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the cut-off frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.
- **Resonance control** (HPF -12dB only): Sets the resonance at the cutoff frequency.

5.5.6 Allpass

Allpass filters allow all frequencies to pass through the output with similar strength, but modify the phase of the signal. Allpass filters are useful for creative filtering as they can easily produce phasing or resonating effects. With allpass filters, the number of poles define the number of peaks in the frequency spectrum of the filtered signal. With high resonance values, an 8-pole allpass filter can sound very similar to a bell.

The following allpass filters are available in the Type menu:

- **Allpass 2**: 2-pole allpass filter.
- **Allpass 4**: 4-pole allpass filter.
- **Allpass 8**: 8-pole allpass filter.

Main Panel

Every allpass variant shares the following two parameters on the Main panel:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the cut-off frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.
- **Resonance control**: Sets the resonance.
Feedback Panel
Furthermore, the allpass filters are equipped with a feedback loop. Its function and parameters are detailed at section 5.5.3, “Feedback Loop and Feedback Panel”, above.

5.5.7 Bandpass

Bandpass filters combine a highpass and a lowpass filter: they dampen all frequencies that lie outside a particular frequency range defined by two cutoff frequencies (or by a middle frequency and a bandwidth). This means that this particular frequency range is allowed to pass through, whilst lower and higher frequencies outside the range are suppressed.

Main Panel
ABSYNTH 5’s bandpass filter BPF has the following parameters:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the middle frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.

- **Q control**: Sets the bandwidth of the filter around the middle frequency. Its values go from 0 to 1000 Hz.

- **Damping control**: Allows you to balance out any level fluctuations introduced by the filter (in dB).
5.5.8 Notch

Band Elimination Filter (Notch)

Notch is a band rejection filter with resonance. Band Reject filters work in the opposite fashion as bandpass filters: they only weaken frequencies within a particular frequency range, defined by two cutoff frequencies on both sides (or by a middle frequency and a bandwidth). Higher and lower frequencies can pass through unhindered.

Main Panel
The Notch Filter has the following parameters:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the middle frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.
- **Resonance control**: This control (labeled Res) allows you to adjust the resonance of the filter.
- **B-width control**: Sets the bandwidth of the filter around the middle frequency. Its values is measured in octaves.
5.5.9 Comb

Comb Filter

Comb filters change the sound by delaying the signal by a few milliseconds and then mixing the delayed signal with the original. As a result, the level of certain frequencies may be raised or attenuated in the filtered signal.

Effects such as the phaser and the flanger use this phenomenon. By modulating the Comb's parameters, you can quickly produce a nice flanging effect.

Main Panel

The Comb Filter has the following parameters:

- **Frequency control and Frequency menu**: The Frequency control allows you to set the cut-off frequency in semitones (Trans) or in Hertz (Hz), upon the selection in the nearby Frequency menu.

- **Feedback control**: Sets the amplification factor for the delayed signal. Higher values induce steeper frequency peaks/cancellations.

- **Damping control**: Allows you to balance out any level fluctuations introduced by the filter (in dB).
5.5.10 Supercomb

Supercomb Filter

The Supercomb filter is a new Filter type introduced in ABSYNTH 5. Basically, it is a Comb Filter equipped with a feedback loop and a tonal control borrowing characteristics from the Resonators and Pipe Effects. For more info on the basic functioning of the Comb filter, please refer to the previous section 5.5.9, “Comb”.

In order to control the additional capabilities of the Supercomb filter compared to those of the Comb filter, the Supercomb provides you with three panels:

- The Main panel is the same as the Comb’s Main panel.
- The Feedback panel contains the parameters related to the feedback loop.
- The Tone panel holds parameters controlling the tone of the filter.

Main Panel
The Supercomb’s Main panel offers the same parameters as the usual Comb filter – again, please refer to the previous section 5.5.9, “Comb”, where they are described.

Feedback Panel
The function and parameters of the Feedback panel are detailed at section 5.5.3, “Feedback Loop and Feedback Panel”, above.
Tone Panel

The Supercomb’s Tone panel contains following parameters:

- **Tone Mode menu**: selects from a set of resonance modes. The higher the feedback is turned up, the more pronounced the effect is. The Tone mode changes the color of the decay.

- **Tone control**: This controls affects the sound differently according to the mode selected in the Tone Mode menu above. It is not available for the mode Raw.

- **HP control**: Low frequency damping. Low frequencies decay faster as this control is turned up.

- **LP control**: High frequency damping. High frequencies decay faster as this is turned down. This control is useful for a more natural resonance.

- **Position control**: Controls the ratio of the delay taps (see 5.5.9, “Comb”, above). This control changes the color of the comb filter.

Don’t hesitate to play with these controls to understand how they affect the sound. In particular, modulate the Position parameter to get nice effects!

5.5.11 Cloud

Cloud Filter

The Cloud filter is another new filter introduced in ABSYNTH 5. It is the little brother of the new Aetherizer effect, a granular delay with multiple feedback and tone controls. It inherits the most important parameters of the Aetherizer. We recommend you to read the section 6.7, “Aetherizer”, first in order to understand how this filter works.

The Cloud filter does not have the usual panels to be found in other filter types. Instead, it presents the three following panels:

- The Grain panel holds parameters controlling the grain cloud.

- The Tone panel allows you to activate a filter and to adjust its parameters.

- The Mix panel allows you to adjust the mix between the dry and processed signals and the level of the output signal.
Grain Panel
On the Grain panel, you find the following parameters:

- **Transpose control**: Sets the global transposition of the grains.
- **Rate control**: Defines the number of grains created during one second.
- **Delay control**: Adjusts the pre-delay involved in the grain creation.

These parameters are equipped with individual Random controls that allow you to randomly deviate from the setting defined for the corresponding parameter.

Tone Panel

The Tone panel

On the Tone panel, you find the following parameters:

- **Filter switch**: Activates/deactivates the Cloud’s internal filter.
- **Frequency control (Hz)**: Defines the cutoff frequency of the internal filter.
- **Resonance control (Q)**: Adjusts the resonance of the internal filter.
- **Filter Quantize menu**: Activates/deactivates the quantization of the filter, and allows you to select the quantization mode. The quantization distributes the possible cutoff frequency over the predefined scales available in the menu.
- **Quantize Transpose control**: Adjusts the base pitch of the scale on which the cutoff frequencies are quantized. This parameter appears for all quantization modes except Vowel (and None of course). For Vowel, the parameter Vowel Mix allows you to morph between various vowels.
The Frequency, Resonance, Quantize Transpose and Vowel Mix controls also have their own dedicated Random controls that allow you to randomly deviate from the setting defined for the corresponding parameter.

**Mix Panel**

The Mix panel

On the Mix panel, you find the following parameters:

- **Balance control**: Adjusts the mix between the dry and the wet signals at the filter’s output.
- **Gain control**: Defines the make-up gain applied to the filter’s output.

One more time, for more info on all these parameters, give a look to the section 6.7, “Aetherizer”.
5.6 Modulator Module

The Modulator module uses its own built-in oscillator in order to change and modulate the incoming signal.

5.6.1 General Function

The Modulator modules can be inserted as the same places as the Filter modules: in any Module Slot of the Patch Window, except the first Slot in each Channel A-C (these are reserved for Oscillator modules) and the last Slot in the Master Channel (reserved for the Effect module). To activate an Modulator module, do the following:

1. Click on the extended left margin on a Filter, Modulator or Waveshaper Module Slot to activate it.
2. Choose the Freq Shift or the Ringmod modulation type from the Type menu (at the very bottom).

As with some of the oscillators in the Oscillator module, the Modulator modules use the Waveform Selector to select or produce a Waveform.

The Modulator modules only have one panel: the Main panel.

We describe below the two operating modes Freq Shift and Ringmod.

The oscillator of the Modulator module never produces an audible signal on its own – what you hear is the result of its interaction with the input signal.

5.6.2 Ring Modulation

Ring Modulator
The function Ringmod produces ring modulation and is very similar to the Ringmod mode of the Oscillator module. The amplitudes of the incoming signal and of the signal produced by the Modulator oscillator are multiplied with one another.

The Main panel of the Modulator module in Ringmod mode contains the same parameters as the Mod panel of the Oscillator module in Ringmod mode, that means the following elements:

- **Waveform Selector**: A click on the Waveform Selector opens the Waveform Selection dialog where you can select the Waveform for the oscillator.
- **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note).
- **Balance control**: Controls the balance between the incoming original signal and the modulated signal.

You will find more in-depth explanations about the Waveform Selector and the Frequency menu/control in the section 5.3, “Common Features in Many Modules”, above.

### 5.6.3 Frequency Shift

Frequency Shifter

In Frequency Shift mode, the Modulator module produces a frequency shift via a feedback loop. From a functional point of view, the frequency shift resembles the ring modulation, and it can also bring similar sonic results. From a technical point of view, though, there is the following difference: While the Ring Modulator produces frequency sums as well as frequency differences, the Frequency Shifter limits itself either to frequency sums or differences. Practically, this means that the Freq Shift mode produces subtler, better to control effects than the Ringmod mode.
The Main panel of the Frequency Shift mode contains the following parameters:

- **Direction switch**: If this button is on “+”, it produces frequency sums. If the button is on “-”, the module produces frequency differences.

- **Waveform Selector**: A click on the Waveform Selector opens the Waveform Selection dialog where you can select the Waveform for the oscillator.

- **Frequency menu and Frequency control**: Enables you to enter the oscillator’s frequency as a transposition of the played note (Trans), as a relationship (Ratio) with the played note, as a fixed Frequency (Hz) or via a fixed MIDI note (Note).

- **Feedback control**: Adjusts the amount of feedback.

You will find more in-depth explanations about the Waveform Selector and the Frequency menu/control in the section 5.3, “Common Features in Many Modules”, above.

A light detuning between the input signal and the modulator signal combined with a moderate Feedback value can induce a nice phasing effect. Very low frequency settings (e.g., 1 Hz) can lead to similar effects.

Because there is no interference between sum and difference frequencies, the Freq Shift frequently sounds cleaner than the Ringmod in situations involving complex input signals (e.g. samples or saw tooth Waveforms).

Frequency shifting is not the same as pitch shifting. In pitch shifting, the Pitch Shifter multiplies the frequencies contained in a signal by a known factor: as a result, harmonic relations between the frequencies remain. A frequency shifter, by contrast, attaches a known value to the frequencies contained within the input signal, thus altering the harmonic relations it may contain.
5.7 Waveshaper Module

The Waveshaper module uses a Waveform to shape an input signal. This idea is used in guitar amplifiers and distortion effects. Waveshaping reacts to the amplitude of the input signal: the sound changes depending on the volume envelope of the oscillator or any other form of oscillator-volume control. Additionally, waveshaping emphasizes phasing and detuning effects in the signal.

You can always use the Waveshaper module when you want to enrich a signal with harmonics. Its action ranges from subtle density to cutting distortion. The waveshaper reacts to changes in the amplitude. The level of distortion changes with every fluctuation of the input signal so the effect sounds very energetic.

5.7.1 General Function

The Waveshaper modules can be inserted as the same places as the Filter and Modulator modules: in any Module Slot of the Patch Window, except the first Slot in each Channel A-C (reserved for Oscillator modules) and the last Slot in the Master Channel (reserved for the Effect module).

To activate an Waveshaper module, do the following:

1. Click on the extended left margin on a Filter, Modulator or Waveshaper Module Slot to activate it.
2. Choose the Waveshaper entry from the Type menu (near the bottom).

As with some of the oscillators in the Oscillator and Modulator modules, the Waveshaper modules use the Waveform Selector to select or produce a Waveform.

The Waveshaper modules only have one panel: the Main panel.
5.7.2 Main Panel

Main panel of the Waveshaper

The Main panel of the Waveshaper contains following parameters:

- **Waveform Selector**: A click on the Waveform Selector opens the Waveform Selection dialog where you can select the Waveform for the oscillator. This Waveform will define the character of the distortion. Please refer to section 5.3.1, “Waveform Selector and Waveform Selection dialog”, for more info on this.

  Create a new Waveform for the wave shaping and work on it in the Spectrum page of the Wave Window in order to make yourself more comfortable with the effect of the Waveshaper.

- **In dB control**: Defines the input level of the Waveshaper in decibels. Increasing this value usually strengthens the distortion. This strengthening is not linear, however, and depends on the selected Waveform and the Phase control value – experiment with different settings to get the sound you want.

- **Out dB control**: Defines the output level of the Waveshaper in decibels. Here you can reduce the level of a signal when the Waveshaper makes it very loud.

- **Phase control**: Sets the phase of the Waveform. This parameter has an extreme effect on the sound especially when working with complex Waveforms. Indeed, these react very sensitively to any manipulation of the Phase.
6  Effect Window

In the Effect Window you can manipulate all of the settings for ABSYNTH 5’s effects: Here you find the switch allowing you to activate the effect section in the signal flow. You can further determine which effect should be applied to the signal produced within the Patch Window. Its individual parameter settings can be determined here as well. The Input Mixer allows you to adjust the levels of the Patch Window’s individual channels feeding the effect. On the output side, the Effect Window lets you position (and move) the effect in the surround field. Lastly, it also allows you to establish a link between the effects and the ABSYNTH 5 functions for automation and remote control.
6.1 General Interaction

The Effect Window is divided into several sections:

- On top you find the elements for using the basic functions, e.g. the On/Off button for the entire Effect section or the Input Mixer.
- In the lower Master section you have access to the different parameters, which allow you to regulate the active effect’s main parameters. In the case of the effect called Echoes, we have the maximum delay time.
- The lower section features the special parameters allowing a more differentiated intervention into the sound processing, such as the delay times for the single delay lines of an echo effect.

6.1.1 Change of Status and Selecting an Effect

The Effect switch turns the Effect section on and off. If you use a simple sound without effects, you can reduce the CPU load caused by ABSYNTH 5. To turn the Effect section on or off, click on the colored field labeled Effect (directly underneath the Navigation Bar’s File menu). Turning the Effect module in the Patch Window on or off has the same effect on the operating status of the Effect Window.

In the same section you find the Effect Selector, a list of six available effect types.

- To choose an Effect, click on the name of the desired effect.

Only one effect can be active at any given time. In the list, the currently active effect mode is marked by a status light and is highlighted. Each newly selected effect is reflected in the lower section of the Effect Window, where the individual parameters of the selected effect are indicated.
6.1.2 Signal Pathway

The Input Mixer on the right, next to the Effect Selector, controls the level of the signals produced by the oscillators in the Patch Window. The Patch Window is divided into three Channels and a Master Channel. The Effect module always occupies the last place in the Master Channel and, hence, is the last module in the signal path. Additionally or alternatively you can also feed the signals from Channels A, B and C directly into the Effect module. The individual Channels’ and the Master Channel’s levels can be regulated via the Input Mixer’s Channel Input Level controls. The levels of all four signals linked to the Input Mixer can be modulated through Macro Control, creating a very lively sound – see also the two sections below and the chapter 10 “Perform Window” later in this manual.

After the Input Mixer, the signal runs through two filters connected in series, which together define the frequency bandwidth to be manipulated. A lowpass first defines the upper cutoff frequency for the frequency band: all frequencies below the cutoff frequency selected in the Input Lowpass control can pass through freely. Subsequently a highpass defines the cutoff frequency at the lower end, by only letting through frequencies lying above the cutoff set in the Input Highpass control.

With its Wet control and Dry control, the Output Mixer controls the levels of the processed and not processed signal at the Effect module’s output, respectively.

6.1.3 Surround Panner

ABSYNTH 5’s effect unit is tightly integrated into the synthesizer’s general surround design. All six effect operation modes feature multiple channels – from multiple delay taps to independent resonators – which can be placed separately within the surround panorama.

Using the surround capacities of ABSYNTH’s effect unit greatly extends its spatial flexibility. For example, you can make the echoes come from behind your listening position. Or you can make the pipe circle around you. The creative possibilities are vast.
After switching the Surround switch in the top left corner on, up to six yellow dots appear in the ring to the right. Each of them represents one channel of the current effect: If you use the Echoes effect with only two echoes active, two dots are displayed. If you use all six slots of the Multicomb effect, six markers are displayed.

This ring represents the surround panorama with the front heading up. The channels’ position within this panorama depends on three factors:

• The channel’s **individual Pan setting**: Except for the Resonators and Aetherizer effects, you can adjust an individual panorama for each channel. This value ranges from 0 to 100, where 0 is completely left, 50 in the middle and 100 at the right.

  By default, the Resonators are distributed evenly, i.e. with pan settings of 0, 50 and 100. The grains in the Aetherizer are randomly panned in the field.

• The **global Spread value**: If you imagine the stereo panorama as a line from left to right, you can bend it to form a ring around your central listening position. The Spread value determines how much the line is stretched and bended.

• The **global Position value**: Turning this knob moves the complete channel arrangement. At a middle value, the mean position of the arrangement is in front of the listener (graphically, at the display’s top). The more you increase the Position value, the more this mean point moves clockwise.

**Spread Control**

The Spread control bends the left-right stereo line to form a ring around the listening position. More precisely, it acts as follows:

• There is no spatial extension at a minimum value, i.e. the line is reduced to a point in front of the listener.

• The line is formed to a semicircle at a middle Spread value.

• This ring is closed at maximum Spread value.
For example, if you have your delay taps with panning values of 0, 50 and 100 (i.e. at the left, middle and right), all of them will be in front of you at a minimum Spread value. If you now increase this setting to a middle position, the left tap will move counter-clockwise and the right tap clockwise until they form a semi-circle with the unaltered middle tap in-between. Increasing the Spread control to its maximum makes the left and right tap finally meet behind the listener, at the opposite of the middle tap.

**Bringing Motion**

After setting up, you can allow the effect channels to automatically change their position: Activating the Rotate switch routes an internal LFO to the Position value and makes the position markers move around on the circle.

On its right, pushing the Inverse switch lets the channels move counter-clockwise instead of clockwise.

The speed with which the channels circle around is set by the Period control at the bottom (labeled Sec): this adjusts the number of seconds a marker needs to reach its origin again – longer times result in slower transitions.

The Period control works like a knob within the user interface: To modify its value, click on the value display and drag your mouse up/down to increase/decrease the Period value, respectively. By double-clicking on the value display, you can enter a new value with your computer keyboard; press [Enter] to confirm.

The Surround Panner can also be used if a stereo set-up is chosen from the Options dialog of the File menu. However, the surround signal will be mixed down to a stereo signal without particular psycho-acoustic algorithms. Nonetheless, an effect will be audible, particularly if the Rotate switch is activated.
6.1.4 Control Area

In the Control area, on the right in the Effect Window’s upper section you can select one of the Macro Controls and define how the effect should react to the arriving control information. You can regulate two parameters: Depth control fine-tunes the modulation depth, that is, the intensity affecting the incoming control information. The depth of this modulation can be regulated through the several Sensitivity controls, which will be described in the next paragraph. The Lag controls determine the sluggishness with which the effect parameters react to the control information.

You can use the Macro Control function to modulate certain parameters depending on the effect type, for example the delay time in the types Multitap and Echoes. Related details can be found in the following section.

You can assign the parameters of each effect type in the Master section independently of special parameters to a Macro Control. Right-click and select the desired Macro Control from the context menu.

6.1.5 Modulation and Sensitivity Control

The Sensitivity controls limit the signals received via Macro Control to a certain value. With the Sensitivity controls sitting in the column Ctrl Sens, you can set the influence of the control signal on the parameter value.

This can be best explained through an example: In case of the Effect type Echoes the settings could be:

- Master Time control = 0.5 second
- Time control Echo 1 = 50%
- Sensitivity control Echo 1 = 75%

This has the following consequence: Echo 1 has a delay of 50% of the value of half a second set in the Master Time control, i.e. 0.25 second. The modulation signal received through the Macro Control can change this value to 75% (that is: 0.25*0.75 = 0.1875 second). Hence, the minimum delay value that can be reached via the control signal is 0.25 - 0.1875 = 0.0625 second. If you click on the Inversion switch, the parameters act in exactly the opposite fashion: a minimal value of the control signal sets the delay to 0.25 second, the maximum signal value results in a delay of 0.0625 second.
6.2 Pipe

Pipe effects

The effect type Pipe replicates the physical qualities of resonating bodies and resembles a simple waveguide application. Unlike waveguides based on physical modelling, ABSYNTH’s pipe algorithm does not attempt to realistically simulate existing instruments or other natural resonating bodies. It is helpful to imagine Pipe as a kind of string or pipe.

Let’s take the image of a string. A loudspeaker (a contact loudspeaker) is connected to a string, which begins to vibrate as a result. You can determine the position of this virtual loudspeaker on the string via the parameter Input Position. Above the string are two pickups, similar to an E-Guitar. The pickups’ positions can be determined through the parameter Output Positions. Changing those two parameters can be compared with changing two microphones. You can modulate the string’s length and the pickups’ position through the LFOs or a MIDI Controller. This way, various flanging, pitch-shifting and rotary speaker effects can be achieved. These effects are particularly apparent when the modulation of the pickups are modulated in opposite directions.

Consider the following: When one of the Output Positions crosses the Input Position (when loudspeaker and pickup would directly be facing each other) a muffled side tone can be heard. By modulating the parameter called Length, which relates to the string’s length, the crossing values for Length and Input can produce a muffled click. However, it is not a problem to cross the Output Positions. The graphic representation of the effect Pipe shows the current settings of the parameters for Input Position, Output Position and Length, as well as for the adjacent modulations. It should help you to prevent undesired crossovers with the Input Position.
LFO modulation in opposite directions of the output positions deliver interesting Panning effects. If the two points intersect, the sound characteristics become mono.

### 6.2.1 Parameters

**Master Section**

- **Beat switch**: With the Beat switch you select whether the value in Master Length control should be indicated in seconds (Sec) or in beats (Beat), i.e. in quarter Master Length control: Determines the virtual string's maximum length. In terms of application this means: that's where the maximal delay can be set.

- **Master Sensitivity control**: Defines the Macro Control’s impact on the value of the Master Length’s parameter.

- **Inversion switch**: If you turn on the Inversion switch, the effect of the control signal received via the Macro Control is inverted (see the section on Modulation und Sensitivity control).

- **Master Feedback control**: Determines the level of the feedback signal in percentage of the original level; at higher values, the virtual string resonates longer, at lower values it is silenced faster.

- **Lowpass control**: Defines the cutoff-frequency of the Lowpass filter, through which the feedback signal passes (in Hz). It changes the string’s sustain characteristic.

**Pipe Section**

- **Input Position**: defines the position for the element that animates the virtual string to vibrate.

- **Output Positions L/R**: define the positions for the two pickups L and R.

- **Sensitivity control**: Determines the impact of the control signal received via the Macro Control on the value of the Output Position controls, i.e. the position of the pickups.
6.3 Multicomb

The Multicomb effect offers up to six independent Delay Lines, based on comb filters that use Lowpass filters in the feedback loop. Multicomb specializes in modulation effects; with parallel series comb filters and an appropriate modulation source, you can easily achieve flanging and other effects based on phase shifts. For subtle to moderate phase modulations, choose medium values. High feedback rates meanwhile, produce tuneable resonance effects that sound like chords.

6.3.1 Parameters

Master Section

- **Beat switch**: With the Beat switch you select whether the value in Time control should be indicated in seconds (Sec) or in beats (Beat), i.e. in quarter notes.

- **Master Time control**: Determines the maximum delay of the feedback signal, i.e. the combfilter’s frequency. A high value results in a long delay and thus a long vibration, i.e. a deep frequency.

- **Master Feedback control**: Defines the maximum level of the feedback signal, as a percentage value related to the original signal’s level. At high levels, the combfilter has a high resonance, and the sound’s overtones produce a saw-tooth curve.

- **Master Lowpass control**: Determines the cut-off frequency of the Lowpass filter, which is run through via the feedback signal (in Hz).
Comb Section

- **On/Off switch**: Allows each of the six comb filters to be turned on or off.

- **Time control**: Defines the frequency (and hence the delay time) of the respective comb filter. This is measured in percentage, and correlates to the value you have selected in the Master Time control.

- **Sensitivity control**: Defines (as a percentage) how the Macro Control’s control signal affects the Time control of the comb filter.

- **Inversion switch**: If you turn on the Inversion switch, you invert the effect of the Macro Control’s control signal (see the section on Modulation und Sensitivity control).

- **Feedback control**: Establishes the feedback signals’ level of every individual filter as a percentage, which correlates to the value you choose in the Master Feedback control.

- **Lowpass control**: Controls the cut-off frequency of each Lowpass filter. This is measured in percent, which again correlates to the value set forth in the Master Lowpass control.

- **Gain control**: Determines the level of each respective comb filter signal at the output signal in dB.

- **Pan control**: Positions the signal of the respective comb filter within the panorama of the output signal. The value 0 corresponds to the position on the extreme left and 1 corresponds to the position on the extreme right. 0.5 corresponds to the middle position.
6.4 Multitap

Multitap effects

Multitap is a simple delay with three taps. The delays vary from one sample to 10 seconds. The input signal is delayed and transferred to the output according to the time set for the tap. This triples the transmitted signal. Multitap requires slightly more CPU power than Multicomb, but offers longer delay times and more modulation options.

Interesting effects can be achieved by re-routing the delayed signal after the first tap back into the input. This way, dense delay clusters can be produced. For the modulation sources of ABSYNTH 5, Multitap is an attractive option: Try to shift the positions of the three taps during the tonal progression through an envelope or an LFO. By setting the modulation source on the three taps’ Pan controls and feeding the Effect module with short, differentiated sounds, the signals will move around in a more powerful way.
6.4.1 Parameters

Master Section

- **Beat switch**: With the Beat switch you select whether the value in Time control should be indicated in seconds (Sec) or in beats (Beat), i.e., in quarter notes.
- **Master Time control**: Determines the maximum delay of the three taps.
- **Master Lowpass control**: Determines the cut-off frequency of the lowpass filter, which the feedback signal runs through (in Hz).

Tap Section

- **Time control**: Determines the delay of each respective tap in percent of the value selected in the Time control in the Master section.
- **Sensitivity control**: Defines the impact of the control signal received via Macro Control on each tap’s Time control (in percent).
- **Inversion switch**: Turning on the Inversion switch inverts the impact of the control signal received via Macro Control.
- **Gain control**: Defines the signal proportions for each tap at the output in dB. For example, a value of -6dB reduces the level by half.
- **Pan control**: Positions the respective tap's signal in the panorama of the output signal. A 0 value corresponds to a position at the extreme left, 1 to a position at the extreme right and 0.5 to the middle.
- **Feedback control**: This parameter exists only for the first Tap. It regulates the level of the signal, which is re-routed to the input, as a percentage of the original signal’s level.
6.5 Echoes

Echoes effects

The Echoes effect type manages classic echo-effects. The input signal can be delayed individually in up to three signal paths. This means the signal for each active delay path runs successively through the Lowpass, Highpass and Allpass filters. The three Pan controls enable the three delay paths' output signals to be separated. The signal manipulation here is particularly interesting: the adjacent signal is directly routed to the output (parameter Gain). At the same time, it is sent back to the input of the respective echo path by way of the Feedback function. An echo can lose high and low frequencies when sent through a filter and thus sound duller or more ethereal. The Allpass filter can produce phase shifts, which produces some interesting results, particularly using short delay times. These filter parameters can also be modulated using the Macro Controls, which increases the number of possibilities.

The parameters in the Master section (Time, Feedback and Beat switch) function in the same way as the Multicomb effect. Each of the three delay lines has the same set of parameters: Time, Feedback, Sensitivity control, Gain and Pan, which work in the same way as their equivalents in the effect types Multicomb and Multitap. The allpass filter’s parameters in the Echoes effect achieve the most striking results if modulated by an envelope.
### 6.5.1 Parameters

**Master Section**
- **Beat switch**: With the Beat switch you select whether the value in Time control should be indicated in seconds (Sec) or in beats (Beat), i.e., in quarter notes.
- **Master Time control**: Determines the maximum delay of the three taps.
- **Master Feedback control**: Defines the feedback intensity.

**Echo Section**
- **Time control**: Determines the delay of each echo (in percent) relative to the value set in Time control in the Master section.
- **Sensitivity control**: Changes the impact of the control signal (received via Macro Control) on the echo’s Time control (in percent), by the value you set.
- **Lowpass control**: Determines the cut-off frequency of the Lowpass filter that is applied to the signal in the feedback loop. The value in Lowpass control can range from 1.0 to 22050 Hz.
- **Highpass control**: Determines the cut-off frequency of the Highpass filter that is applied to the signal in the feedback loop. The value in Highpass control can range from 1.0 to 22050 Hz.
- **Allpass control**: Determines the cut-off frequency of an Allpass filter, which is similar to the Allpass 4 function in the Filter Module in the Patch Window. Allpass filters let all frequencies pass through, but change the signal’s phase depending on the filter frequency. The Allpass filter produces its most impressive results when the parameters are modulated, thus creating phasing effects.
- **Gain control**: Defines the output signal’s level of the respective echo (in dB). A value of -6dB reduces the signal level by half.
- **Pan control**: Positions the respective echo signal in the panorama of the output signal. A 0 value corresponds to a position at the extreme left, 1 a position at the extreme right and 0.5 to the middle.
- **Feedback control**: Sets the level of an echo’s signal, which is routed back to the input, as a percentage of the original signal’s level.
6.6 Resonators

The effect type Resonators offers access to three “resonating bodies” (Resonators). These Resonators can produce delay- and hall-effects, or simulate the sound of specific objects such as metal bars, brake drums and bottles.

ABSYNTH 5 actually offers you three Resonators, which allows you to combine many different effects. Imagine for example an almost infinite hall-like effect, accompanied by a shorter, brighter sounding Room effect.

6.6.1 Parameters

Master Section

- **Size control**: Sets the maximum delay-length between 0% and 100%.
- **Feedback control**: Controls the feedback amount (from 0 to 100).
- **Tone control**: Controls the filters inside the resonators. The effect depends on which feature is selected in the Mode menu (see below).
- **Drive control**: Regulates the input level. This parameter determines the input signal’s degree of saturation. If a high input level distorts the signal, the resonators react differently to when stimulated by a clean signal. This is a very powerful setting, since it also affects all other parameters.
• **Predelay control**: Sets the delay in milliseconds, before the onset of the resonation effect.

• **Diffusion control**: Creates random delay variations. A good adjustment will reduce how much the resonator “rings” less, and higher values make it sound grainier. Range: 0 to 100.

• **ER switch**: Turns the “early reflections” on or off.

**Resonators Section**

• **Mode menu**: Select one of the following main features:
  - **Raw**: Dampened delay. The sound flutters and is less diffuse
  - **Natural**: More diffuse variation. Sounds rather dark.
  - **Resonant**: More diffuse, brighter sound.
  - **Synthetic**: Like Resonant, just more extreme. The parameter Tone control (see above) produces very different effects depending on which operating mode you are using. Have an experiment with this parameter’s extreme settings.

• **Delays Scale control**: The resonator size is the determined by the value set by the Master section’s Size control multiplied by this setting.

• **Delays Shape control**: Allows you to adjust the various delay ratios. For a hall effect, changing this value would be like changing the space’s volume or form.

• **Delays Ctl control**: Adjusts the sensitivity of the parameter. Size reacts to LFO or MIDI modulation commands. The Inversion switch inverts the sensitivity.

• **Tone Scale control**: The sounds created here are the result of a fixed Master Tone value multiplied by the setting selected in Tone Scale control.

• **Tone Spread control**: Increasing the value of this produces a more diffuse sound and also reduces feedback.

• **Tone Ctl control**: Defines how sensitive the parameter Tone reacts to LFO or MIDI modulation commands. The Inversion switch inverts the sensitivity.
6.7 Aetherizer

Aetherizer effects

The Aetherizer is a groundbreaking new effect introduced in ABSYNTH 5. Based on a granular delay, it allows you to further process the signal on the grain level via a transposition, a feedback loop and a bandpass or comb filter, before sending it to a full-featured post-delay section including its own feedback loop.

Each grain gets individually sent at a random position in the panoramic stereo field. This notably allows a distinct surround positioning for each single grain if you were to activate the Surround Panner!

Furthermore, every processing happening on the grain level can be randomized to your liking, thereby producing evolving and unpredictable results.

Last but not least, all parameters (including the randomization parameters) of the grain level can be controlled via a modulation source, internal (Envelope/LFO) and/or external (Macro Control).

The Master section corresponds to Aetherizer's post-delay. The lower part of the Aetherizer specifically deals with the grain cloud:

- On the left, the Grain section allows to control the shape of the grain cloud.
- On the right, the Tone section controls the pitch and filtering of each grain.
6.7.1 Master Section

The Master section of the Aetherizer contains the parameters for the effect’s post-delay section. These are:

- **Beat switch**: With the Beat switch you select whether the value in the nearby Post-delay Time control should be indicated in seconds (Sec) or in beats (Beat), ie in quarter notes.
- **Post-delay Time control**: Defines the post-delay duration.
- **Post-delay Feedback control**: Defines the proportion of the incoming signal that is sent to the post-delay's feedback loop (range: 0.00 to 99.99 %).
- **Post-delay Lowpass control**: Adjusts the cutoff frequency (in Hertz) of a lowpass filter within the feedback loop.
- **Post-delay Gain control**: Adjusts the gain (in dB) of the delayed signal.

6.7.2 Grain Cloud Parameters

Grain Section

The Grain section, in the lower left part of the Aetherizer, holds parameters controlling the grain cloud’s properties:

- **Predelay control**: Defines the position in the incoming signal at which the grains are taken. Increasing the Predelay value makes the grain start later in the input signal.
- **Rate control**: Rate at which the input signal is chopped (in other words, it is the number of grains taken from the input signal during one second).
- **Feedback control**: Amount of grain-level feedback.
- **Grain Duration control**: Adjusts the length of each grain. This parameter influences the density of the sound: less duration means less overlapping grains, thus making the sound thinner.

Note that the actual grain duration is also related to the chosen Rate: the faster the Rate, the shorter the grains.
**Tone Section**

The Tone section, in the lower right part of the Aetherizer, holds parameters modifying the tonal color of the grains:

- **Transpose control**: Adjusts the transposition of the grains (in semitones).
- **Filter switch**: Enables/disables the filter at the grain level.

When the Filter switch is activated, the Tone section offers you the following additional parameters to control the filter:

- **Filter Mode menu**: Selects between two filter modes: BP (bandpass filter) and Comb (comb filter).
- **Frequency control**: Defines the cutoff frequency of the grain-level filter.
- **Resonance control**: Defines the resonance of the grain-level filter.
- **Filter Quantize menu**: Allows you to select one of the Filter Quantization modes (see next section for a description of these modes).

If the filter is activated and Comb mode is selected in the Filter Mode menu, turn the Rate down to hear lower pitches better. For example if the Rate control is set at 200 Hz and the Frequency control at 50 Hz, the grain is too short for the pitch to build up in the comb filter. By lowering the Rate value, the lower frequencies should become audible ringing in the comb filter.

**Filter Quantization Modes**

The filter shaping the tone of each grain can have its cutoff frequency quantized according to various modes.

The quantization of the cutoff frequency can only happen if you allowed the cutoff frequency to “move” around the basic Frequency control value. You can achieve this by setting the Random Frequency control to its right at a non-zero value (see below for more details about the Random parameters).
The following Filter Quantization modes are available in the Filter Quantize menu:

- **None**: No quantization.
- **Chromatic**: Quantization across a chromatic scale.
- **Maj Scale**: Quantization across a major scale.
- **Maj 7**: Quantization across a major seventh chord.
- **Dom 7**: Quantization across a dominant seventh chord.
- **Min 7**: Quantization across a minor seventh chord.
- **Whole Tone**: Quantization across whole tones only.
- **Octotonic**: Quantization across an octatonic scale.
- **4th Stack**: Quantization across fourth stacks.
- **5th Stack**: Quantization across fifth stacks.
- **5th**: Quantization across a fifth chord.
- **Dim 5th**: Quantization across a half-diminished chord.
- **8ve**: Quantization across octaves.
- **Vowel**: Quantization across different vowels.

For all modes except Vowel (and None), an additional Quantize Transpose control allows you to transpose the selected scale in semitones.

For the Vowel mode, the additional parameter, named Vowel Mix and going from 0 to 100, allows you to morph between various vowels.
The Random Parameters

In both Grain and Tone sections, each parameter can be randomized by a certain amount. This amount is controlled by the parameter in the Random column next to each parameter. The Random parameters always go from 0 to 100 (measured in percents):

- At a Random value of 0, the corresponding parameter is precisely defined by its main value (the leftmost in the row) and all grains share this same value.
- By increasing the Random value, the corresponding parameter gets more and more randomized and each grain uses a different value for that parameter.

These Random parameters allow an incredible range of sonic possibilities. Actually, some of the Aetherizer parameters really find their full expression through their randomization. The next section show you an example of this.

The Random parameter for the Quantize Transpose control has a special behavior: In the range from 0% to 50%, frequencies are progressively distributed across the selected scale. Above 50%, frequencies increasingly deviate from the scale to become totally random.

Example: Shuffling the Input

If the Predelay value is at zero and if it is not randomized (i.e. if its Random Predelay control is also at zero), the grains will process all the samples of the input signal in sequential order. If you randomize the Predelay (by raising the Random Predelay control), each grain can start at a different (random) point of the input signal. This can be seen as mixing up the input signal in time.

💡 If you just play pads through it, not much will happen – but randomizing predelay becomes much more interesting with complex input, rhythmic loops or audio input!
6.7.3 Aetherizer Display

At the very bottom, the Aetherizer Display shows you a graphical representation of your grain cloud. The vertical axis is the pitch, the horizontal axis is the time. Each grain is depicted as a tiny triangle followed by an horizontal trail (which represents the grain’s length).

The picture follows your parameter settings in various ways:

- By playing with the Grain Duration control, the trails’ lengths change.
- By raising the Rate control, the grains get closer (and their trails shorter) and vice versa.
- By playing with the Transpose control, all grains move together on the y-axis.
- By raising the Random Transpose control, the grains spread across the y-axis. Indeed, by doing this, you set a different transposition value for each grain! (By the way, you can now better see the grains’ overlapping in time.)
- By activating the filter, the grains get a color related to the cutoff frequency.
- By raising the resonance (Q control), the grains’ color get more intense.
- Etc.

The Aetherizer Display can be very handy to get familiar with the function of each parameter and to “see” what happens.
7 Wave Window

In the Wave Window you can manipulate your own waves with one of the Waveform Selectors. Waveform Selectors can be found in the Oscillator Modules, in the LFOs and in the Waveshaper Module. You can select existing waves or create new ones through them. They are divided into three categories:

- **Simple Waves**: are monocyclic waveforms, read from a wave table. In principle, they are tiny samples containing exactly one period of the relevant waveform. Next to the standard forms Sine, Triangle, Saw and Square you can also find atonal and instrument-like forms.

- **Morph Waves**: are waves using the function Wave Morph (see section 7.5 “Wave Morph”). Technically speaking they are two waveforms stored in one file that have been “morphed” together.

- **Library Waves**: are the Factory-waves of the ABSYNTH 5 Universal Library.

7.1 Waveform Page, Spectrum Page, Morph Page

In the Wave Window, the tabs give you access to three pages: Waveform page, Spectrum page and Morph page. Click on one tab to access the page you want to view.

In the Waveform page you can edit the time component of a waveform, and in the Spectrum page you can edit its harmonic component. In the Morph page you can merge two waves into a Morph Wave. You can find out more on the Morph Wave in section 7.5, “Wave Morph”. All the tools that we will now describe work in real-time. You can play a sound, edit a waveform and hear the results immediately.
7.2 Creating New Waves

To create a new wave, click on the Waveform Selector in a module using Waveforms. A window opens. First click on the button marked Single, Morph and Library. This is where you can create a new Wave. Then click on the New Wave button. A new Wave is created. It is a copy of the waveform selected in the Waveform Selector. This allows you to quickly create variations of already existing waveforms. Please note however, that this is in fact a new waveform. It is completely independent for editing after being copied from the original. To edit the original, select Edit Wave button in the Waveform Selector. After a click on the New Wave button, ABSYNTH 5 switches to the Wave Window and displays in it the newly created Wave. Each Preset can contain up to eight waveforms that you have created yourself. User-defined waveforms are only available in the Preset where they were created. Other Presets cannot access them. You can however easily manage them centrally in ABSYNTH 5’s Universal Library.

7.3 Editing Waves

In the Waveform page you can edit the amplitude and the envelope of the waveform on display. You can create your own Waves completely from scratch using different tools, or change existing Waves. In the section below you will learn about the tools and options available to you in the Waveform page.
7.3.1 Tools in the Waveform Page

Line Draw Tool

- **Line Draw Tool**: This tool allows you to build a waveform with straight lines. The line starts at the point of origin, marked by a vertical bar through the waveform display. On the time-axis displayed at the top of the Window, you can move the point of origin with the mouse.

- **Curve Draw Tool**: constructs the waveform using semi-cosine curves. Works like the Line Draw Tool apart from that.

- **Stretch Tool**: If you select this tool, two vertical lines appear at once. Clicking and dragging the wave with the mouse stretches or compresses it within the lines. The squares can be moved along the time-axis to select different areas.

- **Amplification control (dB)**: sets the wave's amplitude (in dB).

- **Offset control**: allows to set the amplitude’s offset in relation to the zero-axis. A double-click on Offset control centers the waveform around the zero-line.

7.3.2 Transform menu (Waveform Page)

- **Normalize**: normalizes the waveform’s amplitude: the current waveform’s minimum and maximum values are adjusted to the maximum value range. If you normalize each waveform you will always obtain the same volume, no matter which waveform is selected.

- **DC Offset**: this function assures that the waveform’s energy will be evenly distributed between its positive and negative sections. This is different from centering the waveform through the Offset control.

- **Offset Phase…**: allows you to programme a phase offset for the waveform.

- **Invert Phase**: inverts the waveform’s phase.

- **Reverse**: reverses the waveform.
• **Mix...**: opens a window where you can mix the waveform with another one, selected from the Waveform Selector. The following parameters are available in the Mix... Dialog:
  ▪ **dB A**: determines the level of an existing waveform.
  ▪ **dB B**: determines the level of the waveform to be mixed.
  ▪ **Phase B**: defines the phase position of the waveform to be mixed, in relation to the existing waveform.
  ▪ **Freq Ratio B**: defines the frequency ratio between the waveforms.

  You can use the parameter Freq Ratio B to produce chords based on intervals of harmonic series. If you repeat the mixing procedure several times with a different frequency setting, you will add new notes to the chords.

• **Fractalize...**: allows for extraordinary waveform manipulations and is particularly good for creating powerful, organic waveforms. The parameters are:
  ▪ **Iterations control**: controls how detailed the waveform’s manipulation is.
  ▪ **Displacement control**: changes the fractalized waveform’s basic shape.
  ▪ **dB control**: controls the fractalization’s intensity – the higher the value, the richer the sound in overtones and noise.

• **Filter...**: applies a filter to the Wave. In the Filter menu you can select one of the following filter types:
  ▪ **Lowpass 1st order**: is a Lowpass filter with a slope gradient of -6 dB per octave.
  ▪ **Lowpass 2nd order**: is a Lowpass filter with a slope gradient of -12 dB per octave.
  ▪ **Highpass**: is a Highpass filter with a slope gradient of -6db per octave.
  ▪ **Frequency control**: enables you to set the filter’s cutoff frequency. Lowpass filtering of waveforms is the best way to prevent undesired aliasing effects.
• **FM...**: Frequency modulation; the current waveform serves as carrier. This dialog allows you to change the following features:
  ▪ **Waveform Selector**: select a modulator waveform from the Waveform Selector (light blue button).
  ▪ **Modulator Frequency control**: defines the frequency ratio between modulator and carrier.
  ▪ **Modulation Index control**: determines the FM’s intensity.
  ▪ **Carrier Frequency control**: defines the carrier’s frequency ratio.
  ▪ **Mod Phase control**: regulates the modulator’s phase.
  ▪ **Load...**: loads a waveform and replaces the existing waveform.
  ▪ **Import from audio file...**: loads the first 1024 samples from an AIFF- or WAV file as a waveform.
  ▪ **Load Template...**: retrieves a saved waveform from ABSYNTH’s Universal Library.
  ▪ **Save as Template...**: saves a waveform in ABSYNTH’s Universal Library.
  ▪ **Clear**: produces silence.

### 7.4 Spectrum Edit

The Spectrum page of the Wave Window displays the edited waveforms’ first 64 harmonics. The top half of the display shows the harmonics' amplitude, the lower half their phase. At the bottom of the window you can see – depending on the mouse position – the harmonic’s
number as well as its amplitude and phase. Harmonics above the 64th will be retained, although they can not be accessed in Spectrum page.

Some might think that a harmonic’s phase is not perceptible, but this is incorrect. Although the phase is less audible than the amplitude, a change of a harmonic’s phase with a complex waveform can be clearly noticed in the sound. In the following section you will learn about the tools and options available in Spectrum page.

7.4.1 Tools in Spectrum Page

Spectrum page tools

- **Single Harmonic Draw Tool**: This tool enables you to draw different amplitudes and phases for a harmonic. This can be used for precise manipulations.
- **Multi Harmonics Draw Tool**: This tool enables you to draw the amplitudes and phases for several harmonics at the same time.

7.4.2 Transform menu (Spectrum Page)

- **Invert phase**: inverts the phases of harmonics.
- **Shift harmonics**: shifts the entire form of the spectrum to the left or to the right.
- **Load…**: loads a random waveform and replaces the existing waveform.
- **Load Template**: opens a dialog and lets you select and load a Wave from the Universal Library. Select the Wave you want to load. Click “OK” to load the Wave into the Wave Editor.
- **Save as Template**: saves a waveform in ABSYNTH’s Universal Library.
- **Clear all**: sets all amplitudes and phases to zero.
- **Clear amplitude**: sets all amplitudes to zero.
- **Clear phase**: sets all phases to zero.
7.5 Wave Morph

The Wave Morph function allows you to dynamically blend two waveforms into a new shape. The two Waves used in a Morph Wave can then still each be edited with all the same features of a normal Wave in the Waveform page of the Wave Window. If you load a Morph Wave into an Oscillator Module or anywhere else, the combination of the two Waveforms will be used. The Morph Wave is determined by the position of the Morph Mod parameter in the Morph page of the Wave Window. You can, of course, freely modulate the Wave Morphing’s parameters. That way, you create lively, dynamic sounds that can change subtly or even take on a completely new character while being played.

To load a Morph Wave, do the following:

1. Activate an Oscillator in the Patch Window.
2. In the Waveform Selector, pick a Wave model from the Morph Waves (e.g. Miss Morphy).
3. Click on the New button. This creates a new waveform that uses the selected waveform as its model.
4. ABSYNTH opens the Wave Window automatically.
   → The Morph Wave is loaded into the Wave Window automatically.
You have the same options for editing the two waveforms as with simple waves: You can edit the individual waves of time, by switching between the two waveforms using the Morph Wave buttons from the Waveform page in the tab bar to switch between the waves.

![Waveform page in Wave Window](image)

Waveform page in Wave Window

In the Morphing page you determine how ABSYNTH 5 merges both waveforms into a single one.

1. Click the Morph tab, to go to the Morph page.

The Wave Display in this view is divided horizontally into three sections: At the top you can see Wave 1, in the middle Wave 2, and at the bottom you see the resulting Wave.

![Morph page in Wave Window](image)

Morph page in Wave Window (only available for Morph Waves)

1. The morphing takes place in two parallel processes: Transition control is the mix of morphing ratio of wave 1 to Wave 2. At a 0 value only Wave 1 is active; at the value of 100 only wave 2 is active. By raising the value, Wave 1 gradually waveforms is to set the Transition control to 50%.
2. With the Anchor Points the individual Waveforms are subdivided into sections. The sections between Anchor Point A and Anchor Point B of both Waveforms correspond to one another. I.e. when morphing from one Waveform to the other, it is Section A-B from Wave 1 morphing to section A-B from Wave 2. Consequently (as the Wave is a loop) a second section, B-A, emerges for both Waveforms, which behave exactly the same way when morphing (B-A of Wave 1 morphs to B-A of Wave 2).

With the Anchor Points menu, you can apply up to four Anchor Points to individual Waveforms when morphing.

Anchor Points menu

Try to always set the Anchor Points to zero crossings, which will give you better results and enable true spectral morphing.

A Quick Start devoted to Wavemorph can be found in the Getting Started guide, that illustrates the Wave morphing from a practical point of view.

The ability to move the Anchor Points has a useful effect on the resulting waveform; it makes morphing a subtle design tool. The modulation of Transition control through a Macro control (see section 10.2, “Automation in ABSYNTH 5: Macro Controls”) is particularly interesting. You can, for example, switch easily between two very different waveforms that you want to use as sound source in an oscillator. There are many more possibilities than simply fading in and fading out. Both waveforms are mixed in a non-linear way.

As another example, you can also use a Morph Wave in a Waveshaper module.

The Waveshaper module reacts in a very sensitive way to jumps in the waveform (such as those present in a square wave), morphing enables you to achieve an extensive sound variance by continuously stretching and compressing – i.e. shifting and distorting those jumps.
8 Envelope Window

Envelope Window

ABSYNTH 5 provides Envelopes with up to 68 Breakpoints for modulating the parameters. These Envelopes are extremely flexible and offer a variety of extraordinary options.

8.1 Fundamentals for Operation

Every oscillator has a standard amplitude envelope. The amplitude envelopes have a special status because they define when a voice is started and stopped being calculated. As soon as all amplitude envelopes of a voice have reached their last zero breakpoint, the calculation is stopped, reducing CPU burden.

When an envelope modulates a parameter, the value set in the Patch Window represents the maximal value of the envelope. The envelope can reduce this value but cannot increase it. For example: If a filter with a frequency of 5000 Hz is modulated by the envelope, then the envelope works between the range of 5 Hz to 5000 Hz.
8.1.1 Zoom Function

You can see the scales for amplitude and time on the top-left of the envelope representation, marked by the magnifying glass icon. Move the mouse in these zones to zoom in on the horizontal and vertical representation of the envelopes. It is possible to zoom in on the time-axis to such a degree, that one pixel corresponds to one sample.

8.1.2 Envelope List

![Envelopes List in Envelopes Window](image)

The Envelope List contains all assigned Envelopes. Selected Envelopes are displayed in the Envelope Display, while deselected ones are blanked out. The names of the envelopes inform you about the module type (Oscil, Filter, Mod), Channel (A, B, C, Master) and target parameter. To choose an envelope for viewing in the Envelope Display, just click on it with the mouse. You can select consecutive entries from the list by holding down the Shift key and clicking on the highest envelope followed by the lowest. To select several non-consecutive entries from the list, hold down the option-key (Mac OS) or Ctrl-key (Windows).
The Envelope List has two controls:

- **New Envelope button**: here you can create a new envelope. Click on the New Envelope button to open a window where you can select a parameter to create an envelope. Choose the Module by clicking on the desired entries, first in the left column, then on the parameter in the middle column. Only the relevant parameters appear in the Parameter List. For example, if an oscillator is working in Single Mode, the parameter FM index is not displayed. If you switch the oscillator to FM Mode, the parameter is visible. You can see a preview of the currently selected Envelopes below the three columns.

- **Show menu**: The Show menu offers a quick way to fade in and fade out different groups of envelopes in the Envelope Display. This way you can always keep an eye on the envelopes you want to see at any given time, and do not have to constantly consult the scroll bar in the Envelope Display. Click on the Show menu to access a list of following display options:
  - **All**: Displays all Envelopes that are used in the current preset.
  - **None**: Blanks out all Envelopes that are used in the current preset.
  - **Channel A**: Displays all Envelopes that belong to the modules in Channel A of the current preset.
  - **Channel B**: Displays all Envelopes that belong to the modules in Channel B of the current preset.
  - **Channel C**: Displays all Envelopes that belong to the modules in Channel C of the current preset.
  - **Master Channel**: Displays all Envelopes that belong to the modules in the Master Channel of the current preset.
  - **All Oscil**: Displays all Envelopes that belong to the Oscillator modules of the current preset.
  - **All Filter**: Displays all Envelopes that belong to the Filter modules of the current preset.
  - **All Mod**: Displays all Envelopes that belong to the Modulator modules of the current preset.
  - **All Waveshape**: Displays all Envelopes that belong to the Waveshaper modules of the current preset.
  - **All Effect**: Displays all Envelopes that belong to the Effect Window of the current preset.
8.1.3 Selecting an Envelope
You can select an envelope for editing by clicking on the envelope image. The name of the selected envelope is then highlighted.

8.1.4 Copying and Inserting Envelopes
1. To copy an envelope: Select the entry Copy Envelope from the Edit menu.
2. Click on the targeted envelope and choose Paste Envelope in the Edit menu.

8.2 Breakpoints, Transitions/Steps, Sync
The Breakpoints represent target points on the time axis and therefore affect the previous gradient-segment. Click on the desired Breakpoint to select it for editing, and you can then adjust the following controls in the Selected Breakpoint area:

- **Abs/BP Time control**: Determines the Breakpoint’s position on the time axis. Enter the duration in seconds. Depending on the setting of the BP Time Toggle on its left, you can either enter the duration since the previous Breakpoint (BP sec) or since the beginning of the Envelope (Abs sec).

- **BP Amplitude control**: Defines the amplitude for the selected Breakpoint. You can either insert a value directly in dB (on a scale of 0 dB to -96 dB) or adjust a percentage with 0 dB as the relation point. To switch between dB and %, click the BP Amplitude Toggle.

- **Slope/Step switch with Slope control**: With the Slope/Step switch you can influence the transition between the previous Breakpoint in the envelope path and the selected Breakpoint: The position Slope represents the typical wave shape; with the value in Slope control you can determine the slope of the curve progression. In the position Step, the change in value jumps, and instead of the curve you will see a colorful rectangle between the previous and the selected Breakpoint. Drag the rectangle upward, with the mouse button held down, to boost the value in the specified division. Drag it downward to diminish the value. You can also change the horizontal dilation (i.e. how long the value lasts), by moving the Breakpoints, which mark the corners of the Step-rectangle. Just hold down the mouse button.
These three parameters allow you to position the Breakpoint very precisely. You can also move the Breakpoint with the mouse to determine its amplitude and position directly. You can move several Breakpoints at the same time by using the Shift-click or by clicking and drawing the selected area above the part of the Envelope that contains the relevant Breakpoint. Every editing step influences all selected Breakpoints and the parameter amp, abs time and slope as well as the MIDI and LFO-settings. The absolute time and the adjusted parameter are displayed below Time control and Amp control.

Envelope with selected Breakpoint

In the illustration above, the envelope modulates the Filter A1 Freq (1) parameter. For this reason the filter frequency is displayed in the parameter-division of the selected Breakpoint. Slope determines the wave shape according to the sequence of the Breakpoints. A value of 1 creates a linear progression, and lower values create different exponential sequences (compare with previous picture).

Breakpoint with Slope value of 1
8.2.1 Creating and Deleting Breakpoints

To create a Breakpoint simply hit a command-click (Mac) or a right-click (Windows). To delete a Breakpoint, perform a Ctrl-click (Mac) or respectively repeat the right-click (Windows).

8.2.2 Grid Switch

Click the Grid switch to turn the grid in the envelope-representation on and off. If the grid is turned on, then the Grid menu appears on the right side next to the Grid switch. Choose the favored resolution of the grid from the Grid menu. The default value is 1/8 (the grid amplitude corresponds to **eight notes). Other possible resolutions are 1/16 (sixteen notes) and 1/32 (thirty-two notes). If the grid is being displayed, the Breakpoints automatically register on the lines. You can overwrite the registering by drawing the Breakpoints with a depressed Ctrl-key (Mac), respectively Alt-key (Windows).

8.2.3 Lock/Slide Switch

With this you can determine how the Breakpoints react to movement with the mouse: If Lock is selected, you can only move a Breakpoint to the next Breakpoint. The move does not affect the parts of the envelope that follow the next Breakpoint. If Slide is selected, all of the following Breakpoints move together with the Breakpoint that is currently edited.

Lock is especially useful for rhythmical envelopes, where the Breakpoints are supposed to be synchronized with beats.

8.2.4 Free/Sync Switch

Sync button

Apart from Control Driven Envelopes (which are independent of time), you can synchronize to the tempo of the Host-Software by switching the Free/Sync switch to Sync.
8.2.5 Sustain/Release Marker

The Sustain/Release Marker determines which Breakpoint represents the Sustain/Release-point of the envelope. The exact function of the marker depends which envelope mode you select (see below). With the exception of the first and last, you can drag the marker of every Breakpoint.

8.3 Envelope Modes

You can choose from several Envelope Modes, named Release, Sustain, Loop und Retrigger, from the Envelope Mode Menu. A special case is the Control Driven Envelope, which is controlled by MIDI. The envelope mode Sample Jump also works in a different way to the other variations. We will deal with that later together with the Link Mode, where two Envelopes can be connected to one other.

8.3.1 Release Mode

If you have chosen Release Mode and play a note, the envelope will run from the beginning until the last Breakpoint. If you release the note before the Sustain/Release-point is reached, the envelope jumps to the position of this point and proceeds on its path from there until the end. The Release Mode is advisable with percussive sounds and piano-like sounds with sustain. If the Sustain/Release point placed near the beginning, the envelope always progresses in the same way, independent of the length of the releasing note.

8.3.2 Sustain Mode

In Sustain Mode the envelope works similarly to a classical ADSR-envelope. If you have selected this mode and then play a note, the envelope will proceed to the Sustain/Release point and its value will remain constant from then on. If you release the note, the envelope runs through the remaining sequence to the last Breakpoint. If the note is released before the Sustain/Release point is reached, the envelope jumps to the position of this point and proceeds on its path from there until the end.
8.3.3 Loop Mode
If the Loop Mode is selected, a Loop Start Marker that looks like a sideways-tilted U will be displayed together with the red Sustain/Release Marker. You can use this Marker to select all the Breakpoints prior to the Sustain/Release point, right up to the first one. Segments of path inside the Loop are blue, while segments outside are green. Consider that Breakpoints are target-points of the path – therefore the segments of path prior to the Loop Point also belong to the Loop. In Loop Mode, the envelope jumps back to the Loop Start Marker as soon as it has reached the Sustain/Release Marker, and repeats the section in between until the note is released.

8.3.4 Retrigger Mode
In Retrigger Mode, the envelope is restarted according to the Retrigger value when a note is held. If the note is released before the Sustain/Release point is reached, the envelope jumps to the position of this point and proceeds from there until the end. If the Sustain/Release Marker is located inside the Retrigger Loop, the envelope keeps its position. The Retrigger mode is especially useful for creating rhythmic, looped paths. You can feed the retrigger speed as number of beats into the Retrigger: Beat control.
8.3.5 Control Driven Envelopes

Envelope in Control Driven mode

Even though Control Driven Envelopes look like all of the other envelopes, the way they function is significantly different. Compared to normal envelopes, the particularities of Control Driven Envelopes can be more readily understood: While a normal envelope is controlled by time, in Control Driven Envelopes Mode, the movement on the X-axis is controlled by a Macro Control. The MIDI-value 0 refers to the beginning of the envelope, 64 refers to the middle, and 127 to the end. If the minimal value and the maximal value are connected by a diagonal, straight line, then changing a signal value assigned to the Macro Control will directly influence the dedicated parameter – the incoming signal value will be translated into a change of parameter at a ratio of 1:1. If you draw a more complex form with the Control Driven Envelope (and in doing so establish a non-linear control type), things start to get interesting. You are now able to morph between sounds, and even create Arpeggios by turning a controller and using the modulation-wheel to control the speed of rhythms. There are many examples of using Control Driven Envelopes in the Factory Presets. To create a Control Driven Envelope yourself, select Control Driven in the Envelope Mode menu at the top of the envelope’s window. The length of the Control Driven Envelope and the number of points do not matter: The area that can be accessed by the Macro Control ranges from the very beginning to the very end of the Envelope.
Envelopes in Link mode

You can connect the edited Envelope to another Envelope via the Link mode. In Link mode, all changes made to the second Envelope (the source) have an immediate effect on the edited Envelope. To create such a linked Envelope, select Link in Mode menu at the top of the Envelope Window. Even though you cannot directly edit a subordinate Envelope, you can still assign certain characteristics to it. You will notice that all changes will be reflected in the visual representation of the connected Envelope. You choose the source Envelope via the Source menu.

- **Source menu**: Select the source Envelope.
- **Time % control**: Scales the temporal progression of the subordinate Envelope. 50% corresponds to double the speed of the Master Envelope, 200% half the speed.
- **Amp % control**: Scales the amplitude of the subordinate Envelope.
- **Amp Offset control**: Boosts or diminishes the zero-line of the subordinate Envelope.
- **Slope % control**: Scales the escalation of the subordinate Envelope.
The Link mode not only saves time when editing similar Envelopes, but serves for creative purposes as well. You could, for example, alter the Cut-off Frequencies of the filter of multiple channels by choosing a slightly different scaling of escalation or time, which creates a more organic sound. Similarly, you can evoke interesting detuning-effects by connecting the Oscillator Pitch to the parameter.

8.3.7 Sample Jump

Envelope in Sample Jump mode

The Sample Jump Envelope retriggers a sample in a synchronized tempo. You can set an individual Retrigger position in the sample for every Breakpoint. Envelopes of this type look different from normal Envelopes because they do not have real Breakpoints. Instead they show the actual wave shape of the sample. The Sample Jump Envelope only works when one oscillator is in Sample Mode.

To create a Sample Jump Envelope, you first have to set at least one oscillator to Sample Mode and load a sample. Even though the Sample Jump Envelope is suitable for a variety of material, its operating mode is best understood using a drum loop or a similar kind of sample. To create a Sample Jump Envelope, click on the New Envelope button in the Envelope Window. Then select the oscillator oscil A (or any other oscillator containing the loaded the sample you wish to edit). Then choose the parameter oscil A sample jump from the middle column. Now you should see the Sample Jump Envelope and the wave shape that has been loaded into the oscillator module in a wave shape window. In Sample Jump Envelopes you can create new points the same way you did in other Envelopes: via Ctrl-click (Mac) or via right key click (Windows). In Delta Time/Abs Time control you can determine the moment when the sample is retriggered. The Retrigger-position in the sample changes with the value in % control, which sets the position as a percentage of the full length. The Envelope-type Sample Jump Envelope allows you to retrigger the various divisions of a sample, and can be synchronized by tempo.
8.4 Envelope LFO

It is possible to integrate a Low Frequency Oscillator (LFO) in every Envelope. You can draw the wave shape of the LFO in ABSYNTH’s Wave Window. The same LFO Wave influences the entire Envelope. However, every Breakpoint of the Envelope can have different Depth and Speed values. All LFO settings for Envelopes are visually displayed in the Envelope Window.

To practice activating an LFO, select the Envelope and click on the LFO section at the top of the window. LFO settings are carried out individually for every Breakpoint. Select a Breakpoint with a click and increase the value of the Depth until you see the sketched LFO-form. Different settings between Breakpoints are smoothed out. For instance, if a Breakpoint has an LFO Depth of 100 (maximum) and the next one an LFO Depth of 0 (minimum), the LFO Depth parameter would completely blank out. Differences in the speed setting are similarly interpolated. This allows you to create organic LFO-Speed-Ups and Speed-Downs. Every Envelope can have its own LFO with independent parameters for each Breakpoint. The parameter for the LFO’s can be set in the LFO section sitting at the top of the Envelope Window.

The LFO parameters that apply for the entire Envelope are:

- **Waveform Selector**: Here you can choose the Waveform for the LFO.
- **Phase control**: Sets the primary phase of the LFO.
- **Wave/SH Toggle**: If a triangle wave appears, the LFO adopts the shape of the chosen wave. If the Sample&Hold Symbol is displayed, the LFO operates as a random Sample&Hold-function.
The LFO-parameters that are specific for the Breakpoint can be assembled directly beneath the global parameter. They only appear when you have selected the desired Breakpoint.

- **Depth control**: Adjusts the Depth of the LFO ranging from 0 to 100.
- **Sec control**: Adjusts the speed of the LFO (in seconds). A fast LFO has a low value for example.
- **S/H Sec control**: With this you can determine the Sample&Hold-speed (in seconds). A low value corresponds to a high speed. This option is only active if the Wave/SH Toggle is set to Sample&Hold in the global parameters section.

### 8.5 Envelope Modulation

Every Breakpoint position in an Envelope can be set via Macro Control. It is even possible to control every Breakpoint of an Envelope with its own Macro Control. This enables the shape of an Envelope to change dynamically and in sync with the information that comes in through Macro Control or MIDI Velocity. Each Breakpoint responds individually to control signals for time and amplitude. It is therefore possible to dynamically change the form of the Envelopes using either Velocity or the signal that is transmitted through Macro Control.

![Envelope Breakpoint with activated Macro Control](image)
You can activate the remote control of a Breakpoint by clicking on the colored Control switch at the top-right of the Envelope Window. There are no global Macro Controls for the envelope (other than the start and stop functions in the remote control). Clicking on a Breakpoint displays the following Breakpoint-specific features:

- **Time CC menu**: In this menu you determine which Macro Control is responsible for controlling the temporal positioning of the Breakpoint. The Time CC menu offers the following sources of navigation:
  - **Not assigned**: No Macro Control is assigned.
  - **Macro Control 1 to 16**: If you select one Macro Control from the list, this will be the one that navigates the parameter.
  - **Velocity**: The MIDI-Velocity-information is evaluated for the navigation of the parameter.
  - **Pan LR (Left/Right)**: The left and right-axis position of the stereo-panorama is evaluated for the navigation of the parameter.
  - **Pan FB (Front/Back)**: The position of the front and back-axis of a surround-panorama is evaluated for the navigation of the parameter.
  - **Time Scale control**: Defines the strength of the time scale. The signal coming from the Macro Control relates to temporal positions from zero to the graphical value of the Breakpoint. Positive values of the Time Scale control will move the time position of the Breakpoint forward when the Macro Control value goes up, while negative values will reverse the polarity of the control signal.
  - **Amp CC**: With this you can determine from which Macro Control the amplitude of the Breakpoints will be controlled. The list of the possible options is identical with the list of options from parameter Time CC.
  - **Amp Scale control**: Strength of the amplitude scale. Negative values lower the amplitude while positive values boost the amplitude: For a value of -100, the signal coming from the Macro Control relates to amplitudes from zero to the graphical value of the Breakpoint; for a value of 100, the signal from the Macro Control relates to amplitudes from the graphical value of the Breakpoint to the maximum amplitude.

To create playable sounds, you can control the amplitude of the Oscillator Envelope or the Attack Time of a Filter Envelope via Velocity.
8.6 Master Envelope

Editing the release time of an Envelope with the Master Release control

It is often desirable to hear obvious audible changes in an Envelope with just a little bit of work. This is the case when using the MIDI controller and playing live. For this reason, ABSYNTH 5 has the central envelope Master Envelope, which follows the traditional envelope model with the four-step phases Attack, Decay, Sustain and Release (ADSR): with this Master Envelope you can change the amplitude progression fast and effectively. This opens up new possibilities for real-time sound composition, especially in live situations.

8.6.1 Assigning Breakpoints

To use the four Master Envelope knobs in the navigation of Envelopes, you first have to connect every Knob to a Breakpoint on an Envelope. In order to do this, proceed as follows:

Click on the ADSR Assign switch to put the Master Envelope into learning mode. Then click the division A (the A Tab). Now you can select a Breakpoint for the attack phase of the Envelope. To achieve this, click on a Breakpoint in the Envelope Display of the Envelope representation. Next to the Breakpoint you will see a little A. Now you have connected the Breakpoint with the attack Knob (A) of the Master Envelope. To undo the connection, click on the Breakpoint again and the A disappears.

To connect the remaining three knobs of the Master Envelope with Breakpoints of the selected Envelope, repeat the process; but first select, with the help of Tabs D, S and R, which Master Envelope knob you wish to assign to the Breakpoint. When you have assigned the desired Breakpoints to all the Master Envelope knobs, click the ADSR Assign switch again to turn off the learning-mode.
If you move one of the Master Envelope knobs A, D, and R with the mouse, the darker “ghost”-envelope shows how the duration of the curve progression towards the selected Breakpoint, is stretched or jolted depending on the direction of rotation. Every Breakpoint can be connected to exactly one of the Master Envelope knobs A, D und R. You can also connect several Breakpoints with the same Master Envelope knob A to create complex control curves for the attack-phase. This also applies to the other Master Envelope knobs D, S and R and the associated phases of the Envelope.

You can also connect the Master Envelope Knob S, which regulates the amplitude during the Sustain-phase, with several Breakpoints at the same time. This way you can influence the amplitude during the stand still period. The Envelope Display shows you the changes in real-time here as well.

You can perform your own assignments for every Envelope and then navigate several Envelope-progressions with the four Master Envelope Knobs simultaneously. To develop a classical ADSR-Envelope, create an Envelope with five Breakpoints in Sustain Mode. Assign the first Breakpoint the Master Envelope Knob A, the second the Master Envelope Knob D, the third and fourth the Master Envelopes Knobs S, and the fifth Master Envelope Knobs R. In addition, the four Master Envelope Tabs allow you to influence the reaction of the corresponding Master Envelope Knob with the Value Fields Time control and Amp control. The value in Time control lets you to determine the transitional period between the phases of the Envelope; the default value for the Master Envelope Knobs A, D und R is 100, for the Master Envelope knobs A 0. Through the value in Amp control you establish the strength with which the Master Envelope knob influences the amplitude. Here, the default value for A, D and R is 0; for S, it is 100. The expected ADSR-performance is achieved with these default values. Depending on the musical situation, other values might make sense, for instance, if a short attack-phase should simultaneously lead to lower amplitude. In this case, the value of Amp control would have to be increased on the basis of the default settings. At a value of 100, the knob A would not only control the duration of the attack-phase, but also the amplitude.
8.6.2 Controlling the Master Envelope

Several options are provided to control the values of the four Master Envelope knobs.

- You can move the four Knobs with your mouse.
- Since the Master Envelope Knobs are especially suitable as a tool for real-time editing of sounds during play, you can teach those four Knobs to react to information from external MIDI sources, such as rotary controllers and sliders.

To start teaching the Master Envelope Knobs to work with a MIDI controller:

1. Switch to the Perform Window. You will see the four Master Envelope Knobs as well.
2. Make a Ctrl-click (Mac) or a right-click (Windows) on one of the Master Envelope Knobs to put the Knob into MIDI Learning Mode. A small sign will appear indicating Learn Status.
3. Now move the desired control element to remotely control the Master Envelope knob.
4. Click the little sign Learn to finish the MIDI Learn mode.
   → If you now move the control element that was assigned previously, you will see how the knob follows the movements on the screen.

8.7 Transform Commands

The Transform menu offers you access to eight different functions that you can use to quickly transform the selected Envelope(s). Every function opens its own dialogue and has specific parameters. Through the Transform menu you have access to the functions presented within the following sections.
8.7.1 Scale...
This function scales the various parameters of the selected Envelope(s). If you choose the entry Scale..., the Transform Envelopes menu opens with the following elements:

- **Envelope List**: Here you choose the Envelope you wish to transform.
- **Time Scale control**: Scales the horizontal intervals between Breakpoints as a percentage related to the status prior to applying the function. Enter a percentage value here.
- **Amp Scale control**: Scales the amplitudes of the Breakpoints in relation to the status before appliance of the function.
- **Amp Offset control**: Determines the offset of the amplitudes in dB in relation to the status before appliance of the function.
- **Slope Scale control**: scales the slope of the envelope’s progress. Smaller values close to 0 lead to a more convex form, high values lead to a more concave form. The domain ranges between 0 and 1600.

8.7.2 Expand to Rhythm...
The function Expand to Rhythm... allows you to adjust the steps of the Envelope to a rhythm grid. You can easily create definite rhythmic modulations or completely independent rhythms. As with the Step Sequencer, the steps here are organized in patterns. Before you start using the function Expand to Rhythm..., turn on the grid for the Envelope representation by clicking the Grid switch.

If you choose the entry Expand to Rhythm..., a dialog opens up with the following elements:

- **Envelope List**: Select here the Envelope to which you would like to apply the transformation.
- **# of Beats control**: Enter here your desired amount of steps for the pattern. Between 2 and 16 steps can comprise a pattern.
- **BPM control**: Determine here the speed of the created rhythm in beats per minute (BPM).
- **Beat Duration control**: With this you can set the interval between the individual applications of envelopes in beats. This also determines how much of your initial Envelope will be used for the pattern.
- **Pattern**: Here you can determine the consecutive steps for the created rhythm. Like a Step Sequencer or a Drum Machine, you can turn individual steps on and off by clicking the appropriate division.
8.7.3 Generate AR Pulse…

The function Generate AR Pulse… automatically creates a progression of attack- and release-pulsewaves. This can be extremely helpful if you want to create rhythmical Envelope-forms, for instance, to use them in Retrigger Mode. If you choose the entry Generate AR Pulse… the Transform Envelopes menu opens up with the following elements:

- **Envelope List**: Select here the Envelope to which you want to apply the transformation.
- **# of Beats control**: Enter here the number of pulses that you would like to be generated.
- **BPM control**: Determine here the speed of the pulsewave that you have created in beats per minute (BPM).
- **Beat Duration control**: You can use this to adjust the interval between the individual pulses in beats.
- **Attack time control**: Use this to adjust the Attack Time of the pulsewave.
- **Min amp control**: Use this to regulate the lowest amplitude value that the pulsewaves will reach in their path.
- **Slope control**: Use this to determine the slope of the curve progression.

8.7.4 Set Duration…

This command determines the duration of the selected Envelope(s). This means that the complete duration of the Envelope can be clinched or expanded here. If you choose Set Duration…, the Transform Envelopes menu opens up with the following elements:

- **Envelope List**: Selects the Envelope to which you would like to apply the transformation.
- **Seconds control**: Determines the duration in seconds for one cycle.
- **BPM control**: Determines the duration for a beat in beats per minute (BPM). This serves the conversion of Seconds control to Beats control.
- **Beats control**: Determines the duration for one cycle in beats. The beat reference is the speed set in the BPM control.
8.7.5  Load Template
Activates a dialogue through which you can select and load an Envelope from ABSYNTH’S Universal Library.

8.7.6  Save as Template
Calls up a dialogue through which you can save an Envelope in ABSYNTH’S Universal Library.

8.7.7  Initialize Selected Envelope
Repositions the selected Envelope(s) to the custom form provided by ABSYNTH.

8.7.8  Delete Selected Envelope
Removes the selected Envelope(s) from the Envelope List and the Envelope Display.
9  LFO Window

ABSYNTH has three LFO's, which can be used for modulation. In many ways the LFOs (low frequency oscillators) are – with respect to the technical foundations and Control Elements – identical to the Oscillator Modules in the Patch Window: You can adjust the oscillation rates and use any Waveform – including a Morph Wave – for this oscillation. Because of the low oscillation frequencies, however, the LFOs, in contrast to the aforementioned Oscillators of the Patch Window, make no audible sounds. Instead, the slow oscillation rates can be used in order to modulate the parameter of the sound cyclically, similar to a swinging pendulum.

The musical utilization possibilities are numerous. A Vibrato effect, which consistently and periodically changes its pitch around the tone that is actually being played, is a common application. By contrast, in a Tremolo effect the volume is repeatedly increased and decreased. The circling movement through a space can also be achieved easily through modulation of the panorama position of a sound using an LFO.

ABSYNTH 5's LFOs 1 and 3

The three LFOs of ABSYNTH 5 are built in the same way. They each have at their disposal an Oscillator section in the upper margin as well as three Modulation sections beneath. The oscillation properties of each LFO in the upper section can be adjusted while the primary two Modulation sections define which sound parameters are modified using the LFO Signal. The lowest Modulation section determines how the LFO can modulate itself using the Macro Control.
9.1 Oscillator Section

Oscillator section of an LFO

The Oscillator section of an LFO is where its oscillation properties are determined: You can determine waveforms, oscillation rates and phases, and utilize a Sample&Hold module in the Oscillator section. This Module delivers the signal of the LFO at regular intervals and maintains this value until the next value is delivered. This process delivers a signal patterned after a staircase model, which emerges from the continual, round oscillation of the LFO. The following Control Elements can be found in the Oscillator section:

- **LFO switch:** The LFO can be turned on or off by clicking on its upper left label. If it is not necessary for it to be on, turn it off to preserve the CPU of your computer.

- **Mono/Poly switch:** In Mono mode an LFO modulates all the voices; in Poly mode every voice has its own independent LFO. If you use the LFO to produce a Tremolo, for instance, the monophonic LFO will let the volume of every individual voice rise and fall simultaneously, which in most cases is the desired effect. In polyphonic mode, every voice changes its volume independently of the others, and the resulting sonic impression is more diffuse – which, in some cases, is of course equally desirable. (An even more important parameter in this connection is Phase, see below)

- **Waveform Selector:** Click on the Waveform Selector to open a Dialogue in which you can select the Waveform for the Oscillator. You can use Simple Waves or Morph Waves. The latter in particular produces clearly audible effects when combined with the modulation of Transition control.
• **Phase:** Here, set the Phase with which the LFO waveform in Poly Mode is started when a note is struck. It begins with a value of 0 at “Start” (as seen in the Wave Window: left), the middle begins when a value of 50 is reached, and the “End” begins with 100 (as seen in the Wave Window: right). Since a waveform passage immediately returns to “Start” after the “End” is reached, 0 and 100 produce identical results. You can use this controller when you want to start at a specific point in a waveform: If, for example, you want to use a Sine to modulate pitch (Vibrato), but first you want to lower the tone rather than raise it, you can do this with a Phase of 50: This way, the oscillations begin in the middle of the sine curve. Make sure the LFO in Mono mode does not restart the set Phase through the struck note. In this case, you can use the Retrigger Button.

• **Rate:** The speed of the LFO is defined in beats per minute according to the condition of the Rate Mode switches. In a set time frame, the selected Waveform will be passed through once.

• **Sample&Hold:** Turn the Sample&Hold Module on and off. A Rate control parallel to the LFO Rate control controls the tapping points as long as the Module is active. The lower the frequency, the longer an individual value belonging to the LFO Waveform will stay constant.

### 9.2 Modulation Sections

There are three Modulation sections set above one another. The two at the top determine which parameters of ABSYNTH 5 will be modulated with the Signal of the LFO. The section at the very top contains the parameters that are available by Channel or Module, for example, the pitch tones of the Oscillator Modules. Underneath that section follow the parameters that have global influence, such as the ADSR Controller or the Effect parameter. The section on the very bottom establishes how the LFO itself can be modulated through Macro Controls.
9.2.1 Channel Parameters Section

Here you can allocate three parameters, other than pitch, for LFO Modulation. These three parameters are chosen through a menu. Nevertheless, you do not choose the Channel in the Menu itself, but rather separately from the parameters and to their right. In addition, the signal can be doubled: If you press the Inversion switch, the phase turns by 180 degrees (“Valleys” in the Waveform become “Peaks” and vice versa). You can also assign this altered Signal to other channels using the Channel Select Buttons. For example, if you were to use a Bandpass Filter in Channels A and B, you could modulate the bandwidth of both filters using the LFO. If you wish for both bands to time their opening and closing so that one always opens when the other closes, you can activate the Inversion switch, and, in the upper lines of the Channel Select Buttons, deactivate the second Channel during which you deactivate Channel A in the line below. As a result the bands of both filters are alternately narrow and wide.

In the Channel Parameters sections you will find the following control elements:

- **Pitch Modulation Depth control and Inversion switch**: Use halftones to determine the extent to which the LFO has changed the pitch tones. Use the Inversion switch to reverse the signal of the LFO.

- **Pitch Channel Select buttons**: Selects the Channels of the Patch Window, the pitch tones of which are modulated by the LFO. Click on the buttons in order to select and deselect the individual channels. By default, all Channels are modulated.

- **Modulation Target menu**: Chooses the parameter that is to be modulated by the LFO. The parameters are grouped according to the Modules of the Patch Windows.
• **Modulation Depth control and Inversion switch**: Determines the extent of the Modulation by the LFO as a percentage of the desired value. The Inversion switch returns the Signal of the LFO.

• **Target Channel Select Buttons**: Selects the Channels of the Patch Windows, including the Master Channels, the parameters of which are modulated by the LFO. Click on the Buttons in order to select or deselect the individual channels.

### 9.2.2 Master Parameters Section

![Master Parameters of an LFO](image)

The Master Parameters behave almost identically to the Channel Parameters. But since they have a global effect, you won’t find here any Channel Select buttons nor Inversion switches. Note that the second Master Parameter is set to the Panning. This type of Modulation influences the left/right position as well as the front/back position in the surround sound field. The wave position in the front/back modulation is positioned at 90° relative to the wave position of the left/right modulation. This produces a rotation with a sine wave. Other waveforms produce more complex movements and curves. Waveforms with interruptions (e.g. sudden leaps, as in sawtooth and square Waveforms) tend to be heard with at least some surprise at first. This derives from the fact that the front/back panning reaches the interruption in the waveform at a different point in time as the left/right panning. As a result, the position of the sound source, for example, can make a leap from left to right while the leap to the front from behind follows later.

You have the following setting possibilities:

• **Modulation Target menu**: Selects the parameter that is to be modulated by the LFO. Diverse effect parameters, such as the Master ADSR Controller, are at your disposal.

• **Modulation Depth control**: Determines the extent of Modulation by the LFO as a percentage of the desired value.
9.2.3 Controller Section

This last section turns the direction of modulation around: rather than what the LFO controls, this section is about that which controls the LFO itself. You can use the general amplitude of the LFO (Master Depth) to scale all of the modulations that come from this LFO. Additionally, you can change the speed of the LFO and the Sample&Hold Module. All three options are organized under Macro Controls that you can choose in the Modulation Source menus. You will find more info on the Macro Controls in section 10.2, “Automation in ABSYNTH 5: Macro Controls”.

Here in detail are the following parameters:

• **Modulation Source menu**: Chooses the Macro Control that modulates any LFO parameter.

• **Modulation Depth control**: Defines the extent of the Modulation by the Macro Control as a percentage of the desired value.

In the bottom margin of the LFO Window you will see the Retrigger Button. It is only applicable when the LFO is in Mono Mode. As mentioned, each voice in the LFO is reset in polyphonic mode with every new note struck. In monophonic mode, this is not the case. Here the LFO is reset to the position set by the Phase as soon as a MIDI Continuous Controller exceeds the value of 0. This can be caused by a sustain pedal, which the MIDI-CC values broadcast. However, releasing the pedal has no effect. If the Retrigger button is activated, a further Modulation Source menu appears beside it. Here you can directly choose one the 128 Continuous Controllers that the MIDI specifications put at your disposal.
10 Perform Window

The Perform Window gathers all of the signals that control parameters in ABSYNTH 5. Additionally, you will find here global settings affecting all the presets.

Perform Window

The Perform Window is divided into multiple areas: Right below the Navigation Bar, you see the Global Settings Bar. This bar can be seen on all six different views of the Perform Window – the so-called “pages”. You can reach the pages using the tabs under the Global Settings Bar. Click on a tab in order to change to the appropriate page.

Starting on the left, the first three pages are Controls, Assignments, and MIDI. You can configure the control Signals and connect them with targeted parameters. The page entitled Note enables you to undertake various smaller adjustments that influence the behavior of ABSYNTH 5 upon each played note. The Tuning page selects the tuning and for making your own tunings. On the Audio Mod page, you set an Envelope Follower that derives control signals from audio signals. Next, you will learn how to understand the different elements and pages of the Perform Window more clearly.
10.1 Global Features

Some elements of the Perform Window can always be seen independently of the selected Page: the Global Settings Bar, the Master Envelope, and the Audio In section.

10.1.1 Global Settings Bar

The Global Settings Bar provides you with access to the following global settings:

- **Polyphony control**: This defines the number of voices produced by ABSYNTH 5. This setting affects all Presets.

- **dB control**: This sets the output level for the current Preset (in dB). If you use multiple Presets with the same level, but with different resulting volume effects, you can adjust the differences in volume here. You can raise the output level by up to 24 dB or lower it by any amount.

- **MIDI Channel menu**: This sets the MIDI channels, which effect ABSYNTH 5. You can select one of the MIDI Channels between 1 and 16 so that ABSYNTH only reacts to the MIDI messages received on this one channel. If you select Omni, ABSYNTH 5 gives all MIDI messages a value independent of which channel they were transmitted on.

- **Tempo control (BPM)**: This determines the global tempo. This setting affects, for example, the effects that depend on tempo.

- **Transpose**: This shifts the global pitch into half tone steps. The resolution is by 1/10 cent, which is the minimal step width and can also be described as one thousandth of a half.

- **Tuning menu**: With this you select a global Tuning. You can select one from the predefined Tunings or create your own Tuning on the Tuning Page (for more information on this, see section 10.7 “Tuning Page”).
10.1.2 Master Envelope

The superordinated envelope Master Envelope is present in all of the pages of the Perform Window. The settings of the four Master Envelope Knobs on the Perform Window is always identical with those in the Envelope Window: When you place a Knob in one of the two Windows, you will always also see this change when you switch to the other Window. More specific information on the possibilities of the Master Envelope can be found in section 8.6, “Master Envelope”.

10.1.3 Audio In

In the Audio In section, ABSYNTH 5 establishes the level of the input signal. Here you can adjust the threshold level by changing the Threshold controls. If the threshold value is exceeded, the note set in the adjacent Pitch control will automatically be triggered. The prerequisite for this is that the Auto Trigger menu must be set to Audio. If Always On is selected instead, the note selected by Pitch control will be held permanently. (If Off is chosen, then both functions are deactivated.)

This functionality is useful if you use ABSYNTH 5’s as Effect. As was explained in the 8, “Envelope Window”, the program only calculates when the amplitude envelope of an Oscillator is active. If a MIDI envelope does not activate the amplitude envelope, ABSYNTH cannot process the input signal. Choosing the option Always On solves this problem. By using Audio you can depend on us to calculate the effect input signal – and flexibly define the starting point of the envelope.

More on this topic can be found in the section 10.8 “Audio Mod Page”.
10.2 Automation in ABSYNTH 5: Macro Controls

Assignment page in Perform Window

With the Macro Controls, you can organize all of the Signals controlling parameters inside of ABSYNTH 5. First, we will take a look at the different types of control signals:

- Envelope and LFO are modulation sources within ABSYNTH 5. Their control signals automatically control parameters of the sound production and effect section. If you activate, configure, and assign such a Modulation Source to a destination, the Control Signals will also be created without any additional effort on your part. The possibilities are limited to the sound path, meaning that they are limited to the period of time between the instant when you hit the key (i.e., when the MIDI Note-On message is triggered) and the instant when the resulting sound vanishes.

- To change a sound over the course of an entire piece of music without having to interfere with the piece while it is playing, send the Control Signals from “outside” to ABSYNTH 5. Additionally, use the automation of our Audio MIDI sequencer in the Plug-in Program. All modern programs, such as Cubase, Logic, Sonar, or Digital Performer offer the possibility to record Automation data or to create them by mouse click. In the graphic presentation can work on the Automation comfortably. You can send the Automation data to ABSYNTH 5 and make sound changes to several bars or entire compositions. Automation tracks can be assigned to the parameters inside of ABSYNTH 5 using a list of available Automation goals, of which ABSYNTH 5 notifies the host software.
• You can control ABSYNTH 5 in real time by connecting it to the MIDI keyboard. The simplest form of using MIDI to control ABSYNTH 5 is the communication of note values using Note-on and Note-off commands. The Pitch Bend and the Modulation Wheel are also Standard Controllers, which almost every MIDI keyboard sends and which ABSYNTH 5 utilizes. Moreover, many modern MIDI keyboards and controllers offer control elements that also send MIDI Signals; rotary controllers, sliders, and switches are only three of the many possibilities. You can use these MIDI Signals flexibly together with parameters to change the sound during play.

These three types of Control Signals distinguish themselves in their possibilities as well as their origins. In ABSYNTH 5 they are the same in some ways: In order to design the administration of the individual Control Signals as unitarily and as flexibly as possible, ABSYNTH 5 has the Macro Controls.

In other software instruments the distribution of Control Signals mostly takes place through the use of an unchanging list of parameters that exclusively allow rigid assignments of signal sources to particularly elements of the user interface. The disadvantage of such definite connections between source and goal is namely that a controller of your MIDI control element always controls the same parameter independently of the desired sound. This approach is often not sensible, since there can always be other parameters in every Preset, a change in which would have the desired effect upon the sound.

For this reason, ABSYNTH 5 offers a possibility in the Macro Controls to distribute incoming Control Signals among the parameters with flexibility. The fact that you can design the assignment of every Preset on an individual basis is only one advantage of the Macro Controls, however. It is also very advantageous that you can control multiple targets from a single source. That is best explained through the use of an example:

Assume we want to change the Cutoff and Resonance parameters of Lowpass Filter at the same time as the Modulation Wheel of your MIDI keyboard: At high frequencies the resonance should be low, at low frequencies high. To control both parameters simultaneously, build a Macro Control: by activating a Filter Module in the Patch Window and select the Filter LPF -12dB from the Filter’s Type menu. Right-click on the Frequency control. It opens a list with the available Macro Controls. Choose Macro Control 1. Assign the parameter Resonance control to Macro Control 1 as previously described. Now switch to the Perform Window.
There you can choose the Controllers Page with one click on the Controllers Tab. This is where all 16 Macro Controls are found. Every Macro Control is represented on the Controllers page through a menu and a level indicator (Slider) that indicates the current value of the Control Signal. Click on the name field of Macro Control 1, in order to use the computer keyboard to enter a somewhat more memorable name, “Filter 1,” for example. When you activated auto naming under the point General in the Options Menu earlier, every new Macro Control was named after the first assigned parameter.

Assign the Modulation Wheel to the Macro Control “Filter 1” as the source for the control information. To do this, click on the menu of the Macro Control and select the entry MIDI Learn from the list. Now, move the Modulation Wheel. You have assigned the control source: the status bar of the Macro Control will now change its value when you move the Modulation Wheel. Simultaneously, the values of both of the Controls to which the Macro Control has been assigned also change.

The value changes of the two parameters should have gone in opposite directions so we must change the direction for the filter resonance. We will switch to the Assignments Page for this purpose. On the left, you will see a list of Macro Controls. Click on the Macro Control “Filter 1.” In the area on the right next to the list with the Macro Controls you will now see the two parameters that you have assigned to the Macro Control “Filter 1”, namely Filter A1 Freq and Filter A1 Res. You need not change the values in Depth control and in Lag control for the purposes of our example, more on this in the next section. In order to reach the opposite changes in values for both parameters, click on the Inversion switch of the parameter Filter A1 Res. You have now reversed the interpretation of the incoming Control Signal for this parameter, the Filter should illustrate the posture formulated in the input. More precise information about the functions of the Assignments Page can be found in the next section.

We already met the concept of bundling parameters (ie a single controller influencing multiple parameters) when we described the Master Envelope: There you can change the position of several Breakpoints with one of the four Master Envelope Knobs. Learning via MIDI is another feature that the Macro Controls and the Master Envelope have in common. The next section gives you more details on the features of the Macro Controls.
10.3 Controllers Page

Controllers page

The Controllers page gives you an overview of the Macro Controls and the parameters to which they have been assigned. In the default setting you will see a field with a Popup and a Slider for 14 of the 16 Macro Controls. The remaining two Macro Controls are both bound to an XY control. We will discuss this later on. By default, the Macro Controls are simply numbered, showing names such as “Macro Control 1”. You can name the Macro Controls in a more entertaining fashion by clicking on the name field of the Macro Control and using your computer keyboard to enter a new name.

To control a Macro Control using a MIDI controller, you must first assign a MIDI control source. Use the function MIDI Learn in the way already explained in the practical example:

1. Choose MIDI Learn from the menu of the Macro Control that you want to assign to one of the control elements of your MIDI controller.

2. Move the desired control element.

   → As soon as you change the position of the controller, the Slider of the Macro Control follows the change in values, representing the parameter bundled under this Macro Control.

If you want to use a joystick, a touch pad, or another control source that can convert movements on two axes into control information and can disperse information independently of one another, you can combine any two Macro Controls with an XY control. This square field presents the values of two parameters in a two-axis system of coordinates. A yellow cursor marks the current position. The named input devices usually send the information for the x- and y-axes separately as MIDI Control Change Messages.
In a case of a corresponding parameter assignment, this permits you to change two values simultaneously with a single movement. Naturally, this is also the case when you would not like to change the cursor position of the XY control in real time with a MIDI controller, but rather use the Automation of your Audio MIDI sequencer.

In order to combine two Sliders to an XY control:

► Select the entry Make into XY from the menu of a Macro Control. This will allow you to connect the selected Macro Control with the next Macro Control to an XY control.

In order to dissolve this connection and get back to two independent Sliders:

► Choose the entry Make into Sliders from the menu.

In the default setting (shown in the Controllers Page after opening a new, empty Preset), the Macro Controls 15 and 16 are already connected to an XY control and are assigned to control of global Panning: Use the x-axis to control the right/left position, the y-axis to control the front/back position. MIDI Learn works in the same way as the “simple” Macro Controls: Select the entry MIDI Learn from the menu of the XY control.

If you use ABSYNTH 5 as a Plug-in within an audio MIDI sequencer, all Macro Controls are available as targets for automation information. Information on how to use the Automation in an audio MIDI sequencer can be found in the handbook delivered with the sequencer.
10.4 Assignments Page

Assignments page

On the Assignments page you can fine-tune every individual Macro Control. On the left you see the list of all Macro Controls. When you select a Macro Control, its parameters appear below (these are the same as on the Controllers page):

- The MIDI CC# control shows the current assigned MIDI Control Change Number (MIDI CC#). You can change the assigned MIDI CC by double-clicking on the indicated value and entering a new number. Alternatively, you can click on the displayed value and drag your mouse vertically. You can also use MIDI Learn to assign a new MIDI Control Change Number, by clicking on the Learn button and moving the preferred control element on your MIDI controller.

- The horizontal Slider with the label Control Value indicates the current value of the Macro Control. You can change the value by dragging this Control Value Slider with your mouse.

In the Assignment Table in the middle of the Assignments page you can use different settings for every parameter assigned to a Macro Control. The list always shows the parameters that are assigned to the Macro Control selected from the Macro Controls List. You can add additional parameters to the list by making a right click on the parameter to be affected (for example, Filter Cutoff in a Filter Module of the Patch Window) and then select Macro Control from the context menu that the parameter is to control from that point on. In order to separate the parameter from the Macro Control, select the entry Not assigned from the context menu. The entry then be removed from the Assignment Table.
For every parameter assigned to a Macro Control you can use the following setting:

- **Depth % control**: determine the depth of the Modulation carried out by the Macro Control as a percentage of the current value of the parameter under its control.
- **Lag**: determines the delay with which the parameter reacts to the changes in value communicated by the Macro Control.
- **Inversion switch (Inv)**: reverses the direction of the Modulation. High Controller values produce a low parameter value, low Controller values lead to high parameter values.

### 10.5 MIDI Page

On the pages Controllers and Assignments, MIDI has been limited to issues concerning Control Change Information. On the MIDI Page, you can set the remaining MIDI parameters and assign functions to MIDI control elements.

#### 10.5.1 Pitchbend

In this section, you can set how a Preset reacts to Pitchbend information: In Depth control you can limit the region of upward and downward Pitchbendings on a set number of halftones. In Lag control you can determine the delay (in milliseconds) with which ABSYNTH 5 evaluates the incoming Pitchbend information for this Preset.
10.5.2 Volume
Here you can set how ABSYNTH 5 uses incoming information from a volume pedal or another MIDI control source as a level control.

- **CC control**: Here enter the number of Controllers that you want to use for control of the entire level; in the standard setting, ABSYNTH 5 reacts using Control Change #7, designated in the MIDI specification the control of the total level.
- **Pre/Post Toggle**: Determines whether changes in the level should come before or after the Master Channel.
- **Macro Control menu**: If you want to make the entire output level dependent upon the signal value of a Macro Control, you can select a Macro Control from the Macro Control menu.
- **Depth control**: Determines the strength with which the incoming control information influences the level.
- **Lag**: Establishes the delay before ABSYNTH 5 reacts to changes in the signal value responsible for the level control.

10.5.3 Pan
Macro Controls 15 and 16 (both of which are combined with an XY control) are designed to control the Panorama Position by simultaneously placing the output signal on a left-right axis and front-back axis. In order to use a two-axis controller like a joystick or a touch pad to adjust the panorama position, learn the instrument as described in section 10.3 “Controllers Page”. For control of the Panorama you can also determine the strength of the control signal (Depth control) and the hesitation in the assessment (Lag control).
10.5.4 Velocity

With the options in the Velocity Table you can determine how particular parameters can be influenced via velocity values communicated via MIDI, that is to say, the force with which you hit the note. You can determine, for example, that a note struck loudly increases the frequency of a filter and as a result not only changes the volume of the tone, but also its characteristics.

For every parameter you can set the percentage value in Depth% control around which the velocity values can change the value of the parameter. With the Inversion switch (abbreviated Inv) you can reverse the velocity values so that a soft stroke on the key results in a strong change of the parameter, but a stronger stroke on the key only induces a slight change.

Further parameters can be added to the velocity table by selecting the desired parameters from Add Parameter menu in the title line of the Velocity Table.

10.6 Note Page

On the Note page you can establish how much a parameter is modulated depending on the played note. That is, you can establish an individual relationship between the modulated parameter and every key on your keyboard. You can make a Filter open wider for higher notes. Three groups of parameters can be modulated dependently of notes:

- **Oscil Amp A, B, C**: are the volume envelopes of the Main Oscillator in the three Oscillator Modules.
- **Oscil FM Index/Balance A, B, C**: controls the ratio between the channels’ main oscillators and their modulation oscillators.
• **Filter Freq A, B, C, Master**: corner and middle frequencies of the Filter Modules in Channels A through C and Master.

### 10.6.1 Note-dependent Modulation

In order to set up a note-dependent modulation for a parameter, first choose the desired parameter from the Parameter menu on the upper left-hand side of the Note Page. In the curve presentation in the center of the Note page you see the progress of the modulation value over the entire tone; in the standard setting, the values of all notes are the equal. For which reason you see a horizontal line. To adjust the Modulation Attitude, draw the desired curve in this presentation using your mouse. This way, you can establish a modulation value for the all MIDI note values very quickly.

If you find this process too inaccurate, you can also set the target values for individual notes. First determine the note to which you want to assign an individual value. You have two possible ways to select a note: Either change the value directly in Note control, or click on the Keyboard switch and play the desired note on your MIDI keyboard or on the Virtual Keyboard. With Scale control you can enter the value of the Modulation directly in the manner previously described for the selected MIDI note.

### 10.6.2 Glide

The function Glide produces gradual transitions between multiple notes following after each—known as Glissando. You might know this function under the name Portamento from other instruments.

The Glide control lets you determine the duration of the pitch transitions. The default value is 0; with this setting the function Glide is not active, and the tones are produced without Glissando. If you enter a higher value, you thereby determine the duration of the Glissando in milliseconds.

With the Legato switch you can switch between the portamento variants: in the mode Glide (when the Legato switch is not pressed) the transition of the pitched notes is gradual and independent of the manner of play. If you activate the Legato switch, the notes are only produced with a gradual transition when you are playing Legato. When you play Staccato – that is, without overlapping the hold time – the transitions between notes are not gradual.
10.7 Tuning Page

On the Tuning Page you can tune ABSYNTH 5 in a great deal of detail: You can assign any individual key to any pitch, which does not have to follow any common scales. In this sense you can produce any desired alternative tuning. You can load different, predefined tunings from ABSYNTH’s Universal Library.

10.7.1 Creating a User-defined Tuning

To create your own Tuning, you must first design a new Tuning. This takes place in a manner entirely parallel to the creation of a new waveform: Open the Tuning Selector in the Global Settings Bar of the Perform Window. There you can choose from a series of predefined Factory Tunings. By clicking on the New button, a new User Tuning is created, which in contrast to the Factory Tuning can change as much as you want. The display then switches automatically to the TuningNow set the basic tone for your new Tuning in Base Key control. Finally, select in Note control the Note that you would like to tune. You can enter the tuning of the note either as a MIDI note number (Note control), in Hertz (Frequency control) or in the form of a ratio with the note given in Base Key control acting as a base. The three value fields, Note control, Frequency control (Hz), and Ratio control, correlate; that is, if you change the value for one of the three controls, the other two controls show the same value in their own unit.

After you tune all of the notes according to your desires, you can save your new Tuning using the Transform menus in the Universal Library. You can then always return to this Tuning.
10.7.2 Octave Link

When you activate the option Octave Link by clicking on the Octave Link button, ABSYNTH 5 transmits the frequency intervals determined for an octave to the other octaves within the scope of the tone. For this reason, you do not need to tune every note individually for all of the octaves. When you have turned on Octave Link and newly tuned a note, the note changes by the same amount simultaneously in all of the octaves such that the intervals in all of the octaves correspond exactly to those in the basis octave. If you want to tune all of the notes individually, turn Octave Link off.

In Keys per Octave control set the number of MIDI buttons to produce an octave from which you can recognize that an octave in ABSYNTH 5 does not necessarily have to consist of eight whole tones or twelve half tone steps. If you turn on Octave Link, set the value in (for example) Keys per Octave control at 11, and then change the pitch of a particular note, then the 11th note above and below the selected button will be tuned correspondingly.

As an example, take a typical tuning with 12 half tone steps per octave. In this example, Keys per Octave control as well as Octave Interval control both have the value 12. For stretched tunings (e.g. the tempered tuning of a piano) you should increase Octave Interval slightly, e.g. to 12.01.

To automatically produce quartertones, set the Keys per Octave control to 1 and Octave Interval control to 0.5. To produce eighth tones, put the Keys per Octave control at 1 and Octave Interval control at 0.25.

When defining an octave, the Octave Link and the controls only influence the operation of the other parameters. You will not hear any changes until you change the pitch of a note in Note control, Frequency control or Ratio control.
With the function Audio Mod you can derive modulation signals from audio signals. This follows the principle of an Envelope Follower Module: Each of the four Audio Signal Analysis Paths available for parallel use, Audio Mod A to D, analyzes the level of the audio signal transmitted to it and then makes the result of the analysis available when the Signal has its output as a Modulation Signal. The progress or sequence of values corresponds to an envelope: A high level of the Audio Signal means the same thing as a high value of the outgoing Modulation Signal. Apart from using them to directly control parameters, you can also use the Audio Mods as a Trigger to activate the envelope paths.

### 10.8.1 Audio Mod as Envelope Follower

The Enveloper Follower function is similar to a Macro Control. Rather than a MIDI source or an Automation track, the level of a signal activates the value changes of an outgoing control signal. This manner of working is best illustrated through an example: Turn on the Waveshaper Module in Channel A in the Patch Window and select a square Waveform for the Waveshaping. Right click in the In dB control of the Waveshaper Module and select the entry Audio Mod A from the context menu. Increase the value in In dB control by about 12 dB. In the Perform Window, switch to the Audio Mod page and select the entry Oscil A as Modulation Source from the Modulation Source menu. In the Depth% control, set a medium Modulation Depth and reverse the Modulation Signal by hitting the Inversion switch. If the input level is low, this signal manipulation will boost (preamp) the signal in In dB control. Conversely, the boosting will be reduced if the input level is high. In effect, a compression of the Signal results. This pretreatment is the result of a consistent signal distortion by the level-sensitive Waveshapers when dealing with various volume levels.
10.8.2 Audio Mod as Trigger

The Trigger Module of the Audio Mod page activates envelope progressions of a freely selectable Module of the Patch Window. If you use this function to Trigger any of the Oscillator Amplitude envelopes Oscil A through C, the Trigger Module produces certain Note-On and Note-Off commands without your having to push a button. Additionally, not all, but rather only certain Modules of ABSYNTH 5 and its envelopes will be restarted, which makes for a contrast between ABSYNTH 5 and traditional MIDI Trigger Signals.

This is best understood from a practical viewpoint, if you use ABSYNTH 5 as an Effect: The Trigger Module produces a Note-On command as soon as the threshold in Threshold dB control is exceeded. In this case, set the Envelope switch to Pre Rev in order to prevent the envelopes that have yet to be started from silencing the Effect Input Signal. More specific information on the envelopes and their control possibilities can be found in chapter 8 “Envelope Window”.

10.8.3 Parameters

On the Audio Mod page you can find the following control elements:

- **Audio Mod A through D**: the four Audio Mods A through D are equipped identically. Click on one of the Audio Mod Tabs in order to select the appropriate Audio Mod. The settings that belong to this Audio Mod will be indicated on the Audio Mod page. Like the Macro Controls, the Audio Mods can be assigned using the context menu that you can activate using a right click on the parameter of a Module in the Patch Window. The setting of the modulated parameters that can be seen in the Assignment Table is carried out in the same way as with the Macro Controls.

- **Audio Mod On/Off switch**: use this to turn the Audio Mods on and off individually. Select an Audio Mod and click on the Audio Mod On/Off switch in order to turn this Audio Mod on or off.

- **Modulation Source menu**: Use this to select the output signal of any Patch Window Module as the input signal for the Audio Mod.

- **Pre/Post Envelope switch**: Use this to determine whether the Audio Signal is tapped off before or after being sent to an amplitude envelope.
• **Gain dB control**: use this to set how much an input signal is boosted before measuring the level by an Envelope Follower (in dB).

• **Attack control**: Determines how quickly the Modulation Signal produced by the Envelope Follower follows the upward movements of the level. High values stand for a slow reaction.

• **Decay control**: Determines how quickly the Modulation Signal produced by the Envelope Follower follows the downward movements of the level. High values stand for a slow reaction.

• **Trigger Module menu**: Use this to select the goal of the Trigger Signal when you are using Audio as an Envelope Trigger. It raises the input level of the Audio Mod over the threshold value set using the Thresh dB control (see below) and activates the envelopes of the selected Module (as would otherwise be done by a MIDI Note-On message). More specific information on this can be found in the introductory example in the section 10.8.2 “Audio Mod as Trigger”.

• **Thresh dB control**: Use this to set the threshold value (in dB). Above this threshold, the Audio Mod should trigger the envelope. If the level of the input signal falls under the set threshold, the Audio Mod sends a MIDI Note-Off command.
11 The Browser and Attributes Windows

11.1 The Attributes Concept and the KORE SOUND

ABSYNTH provides a new and more intuitive way to save, browse and load its preset sounds. We have left behind the old paradigm of individual sounds contained in separate sound banks, with all its organizational problems. Instead, the settings for each sound are saved into single files that can then easily be ported between platforms or projects. These sound files can also be loaded directly by Native Instruments’ host application KORE. As a result, each saved sound within ABSYNTH is called a KORE SOUND.

To manage all these KORE SOUND files you need a powerful way to browse through them. Therefore, each KORE SOUND file also contains information about the sound in musical terms, known as the sound’s attributes. The Attributes Window of ABSYNTH provides a list of about 170 different attributes.

By combining these descriptive terms, each of the synthesizer’s sounds can be illustrated according to its origin or source, its timbre, articulation and genre. You can also enter additional meta information such as the name of the sound’s author and so on.

All KORE SOUND files placed in ABSYNTH’s user and factory library folders are automatically integrated into a database of sounds. The Browser Window of ABSYNTH is your interface to this database. Within the Browser you can select a combination of attributes to find a sound that fits your needs. For example, try selecting attributes Bass, Digital, Dark and Fat, Monophonic and Techno/Electro to find exactly that — a digitally cold yet propulsive and fat baseline sound. Different bank files at various locations on your disk won’t be an issue anymore — you’ll be able to find the sounds you need for your music quickly and easily.

⚠️ Please note that there is a differentiation between SingleSounds and MultiSounds within KORE. All KORE SOUNDS you save with ABSYNTH will be loaded as SingleSounds in KORE, and ABSYNTH will also only be able to load SingleSounds. Please refer to the KORE manual for detailed information. This difference is of no importance within ABSYNTH itself.
The following sections will explain how to use ABSYNTH’s attributes to browse through your sounds and load them as well as how to save your own sounds using the attributes. You can find a complete description of all available attributes in Appendix B. A detailed tutorial on how to search with the browser is available in Appendix A.

11.2 Searching and Loading Sounds with the Browser

In the Browser Window you can search and load your ABSYNTH sounds as well as organize them into programs.

Browser Window

The Browser Window of ABSYNTH can be viewed in two alternative modes that are toggled by clicking the Sounds button in the Window’s upper-left corner. When this is deactivated, you see the File Tree View. When activated, you can browse your KORE SOUNDS in the Database View. Both views share the same structure: at the left you specify which sounds you want to see (i.e. a folder in File Tree View or a set of attributes in Database View). On the right you can load one of the KORE SOUNDS from the Search Result List by double-clicking on it. When activating the Programs button in either view a program list is added. All views feature the Browser Control Bar at the top, which contain the Sounds button, the Programs button and additional control options.
11.2.1 Database View

The Database View becomes visible by using the mouse to activate the Sounds button. It consists of the table of attributes itself as well as the Sound Type switch, the Reset button and the Search Field, these three placed within the Control Bar at the top.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Blending</td>
<td>Rock</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Funk</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Hip Hop</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>House</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>Industrial</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long+Evolving</td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Drum</td>
<td>FM</td>
<td>Warm</td>
<td>Pulseting</td>
<td>Dj'Ns/Breaks</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>House</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td>Lead</td>
<td>Techno/EDM</td>
</tr>
<tr>
<td>Recorder Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Lead</td>
<td>Pop</td>
</tr>
<tr>
<td>Basses</td>
<td>Ensemble/KIT</td>
<td>Soft</td>
<td>Chord</td>
<td>Jazz</td>
</tr>
<tr>
<td>Brasses</td>
<td>Small</td>
<td>Metallic</td>
<td>Slide/Pitch Mod</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Rhythm Strings</td>
<td>Big</td>
<td>Detuned</td>
<td>Arpeggiated</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td>Vocal</td>
<td>Dry</td>
<td>Dissonant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synced</td>
<td></td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Synthetic</td>
<td>Musical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MultiTrack</td>
<td>Layered</td>
<td>Wooden</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Exotic</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Attributes List

The list of available attributes alternates depending on the sound you are searching for. In most cases this will be instrument sounds. But, as described in section 5.4.11, “Audio In”, you can also route audio signals to ABSYNTH to use the application as an effect unit. Therefore, you can toggle between searching for Instruments or Effects by clicking the Instruments or Effects button in the Control Bar.

The attributes are grouped into columns. For instruments, the categories used are Instrument, Source, Timbre, Articulation and Genre.

- **Instrument**: Specifies the general type of instrument, for example Synth, Bass or Soundscape.
- **Source**: Loosely describes the sound’s origin (acoustic, derived from a sample loop, synthetic, etc).
- **Timbre**: Describes the sound’s general tonality (cold, warm, metallic, dissonant, and so on).
- **Articulation**: Describes how the sound develops over time (rhythmic, short, evolving, and so on).
- **Genre**: Provides a choice of musical styles with which the sound might be compatible.
Effects, can be selected using the attribute categories Type, Mode, Characteristic and Application:

- **Type**: Characterizes the effect in technical terms. Choose between reverb, distortion, delay, and the like.

- **Mode**: Deals with how the effect is applied, as in side-chain, LFO, and multi-band.

- **Characteristic**: Describes the effect’s tonality (warm, intense, metallic, etc.)

- **Application**: Gives you a choice of “targets” for which an effect might be best suited. These can be different instruments, like Organ or Bass, or application areas, like mastering or surround sound.

Each of these categories contains a list of attributes describing possible characteristics, which a given KORE SOUND might contain. A detailed explanation of all the available attributes can be found in Appendix B. There are also several examples on how to find a specific sound in Appendix A.

To search for a sound within the database, simply select or deselect single attributes by clicking them with the mouse. Any number of attributes can be combined to narrow your search. However, you can only use one attribute of the Instrument (instrument sounds) and Type (effect sounds) categories, respectively. The Reset button deselects all currently activated attributes. Each additional attribute that you select reduces the total number of matching KORE SOUNDS in the list at right. The remaining KORE SOUNDS are displayed in the Search Result List.

The database represents the contents of the library folders (and their sub-folders) on your hard-drive. Those folders are not checked for new KORE SOUND files each time ABSYNTH is started, as this would significantly slow down the start-up time. Thus, if you manually place KORE SOUND files within your library folders using your operating system, ABSYNTH will not integrate these files into the database search until the library folders are re-scanned.

Again, you can trigger the database rebuild manually within the Options Dialog, described in section 3.4, “Options Dialog”. The database is then scanned in a background process while you continue working with ABSYNTH 5.
The Search Field

Instead of browsing the database by using the Attributes, you can also search for sounds by entering a search term into the Search Field:

Search Field

When you enter a term, the Browser automatically searches through all KORE SOUND file names, Attributes and Meta Information. Using this feature you can search all sounds sharing the same word in their names, all sounds created by a particular author or search those sounds containing specific terms in their Comment fields.

The Search Field can be very handy to let the Search Result List display only the new Sounds from the ABSYNTH 5 Library. Since these have “Absynth5 Factory Content” in their Meta Information’s Bankname field, typing “absynth5” in the Search Field will narrow the Search Result List down to the new Sounds in ABSYNTH 5.

The Search Result List

The KORE SOUNDS that match the search criteria (search term or Attribute combination) are displayed as a table within the Search Result List.
Each row of the table holds one KORE SOUND. Information about the KORE SOUND is displayed in several columns. You can change the table’s layout by clicking on the headers at the top:

- Click onto a column’s header to sort the Search Result List alphabetically, according to that column’s entries. Clicking it again reverses the order of the sort. This can come in handy if you want to search all bass KORE SOUNDS with a high rating, for example. Simply select the Bass attribute within the Database View’s Instrument column, and then click the Rating column header within the Search Result List: the KORE SOUNDS with the highest ratings will now appear at the top of the list.

- Right-click ([Ctrl]+click on Mac OS X) to provide a context menu of possible columns to be displayed. Clicking a column label here that is already displayed (e.g. Name) removes it from the display. Vice versa, clicking the label of a column that is currently not displayed inserts the column into the table.

You can now easily load an ABSYNTH KORE SOUND by double-clicking on a desired entry in the Search Result List.

You can also load the elements of your Search Result List from the Navigation Bar. See section 4.2.2, “Sound Name Display and Sound Menu”, and 4.2.3, “Previous/Next Sound Buttons”, for details.

The Search Result List will also be used by the Mutator as pool of Sounds from which the desired characteristics will be inherited (see section 11.3, “Mutator”, below).
11.2.2 File Tree View

Deactivating the Sounds button with a mouse click brings the File Tree View into view. In this view, some of the elements within the Control Bar will fade. In place of the columns of attributes a common file tree is displayed, showing all the folders and drives on your computer. You can adjust the layout in File Tree View by dragging the small handle on the frame between the windows to either side.

Browser in File Tree view

The File Tree View is pretty straightforward; it is similar to the way you work with files in the operating system itself. You can select a folder by clicking its name; any KORE SOUND files contained within it are immediately displayed within the Search Result List. If a folder contains sub-folders, you can make them visible by clicking on the folder icon in front of the folder’s name. The list of sub-folders is closed again by clicking the folder icon once more.

When all folders are closed there are three main entries here:

- At the top we find the Explorer entry. It contains your operating system’s folder structure as sub-levels. This is particularly useful if you want to open a KORE SOUND file that is not within your library folders.

- In the middle we find My Favorites. It does not contain KORE SOUNDS itself; instead it contains links to KORE SOUND files elsewhere on your computer.

- Finally, there is My Sounds, which links to the user content folder on your hard drive. It reflects that directory’s sub-folder structure; its handling is similar to that of the Explorer entry. The My Sounds entry contains all the original sounds that you have saved from previous sessions with ABSYNTH.
You cannot delete, rename, copy or move KORE SOUNDS within the File Tree View as this might create inconsistencies with the database. If you need to delete or rename a KORE SOUND, you can do this in your operating system as you would with any other files. You’ll find your sounds where they were saved by ABSYNTH. ABSYNTH uses the following file locations to save your sounds depending on your operating system:

- “My Documents/Native Instruments/Shared Content/Sounds/Absynth 5” on Windows Vista/XP.
- “[User]/Documents/Native Instruments/Shared Content/Sounds/Absynth 5” on Mac OS X.

These are the default locations for the user content folder. You can add further locations within the Database Tab of the Options Dialog. There you can also trigger a reconstruction of the database. This is necessary after deleting or renaming a KORE SOUND to inform the database of the changes.

My Favorites is a powerful way to quickly access the KORE SOUNDS you use most often. You can add any KORE SOUND from the Search Result List by right-clicking on it and selecting Add to My Favorites from the context menu. Alternatively, you can drag it from the Search Result List into the My Favorites folder or one of its sub-folders. You can also create sub-folders within the My Favorites folder to sort your favorite sounds hierarchically: right-click on the My Favorites entry and choose New Favorite Folder from the context menu. Empty Favorites folders can also be removed by using this conYou can also easily browse through the KORE SOUNDS in any folder by using the Previous/Next buttons.
11.2.3 Programs

Within the Browser Control Bar you will find the Programs button. Clicking on it removes the Database View (the File Tree View remains in this case, as it is smaller) and brings up a second list beside the current Search Result List. You can drag any KORE SOUND to this list from the Search Result List. You can also change the list’s order by dragging the KORE SOUNDS within the list up and down. If you drag a KORE SOUND to a position in the list that is already occupied, that entry and all subsequent ones are shifted down by one position.

Program List

After you press the On button (next to the Programs button if this one is activated) this list of KORE SOUNDS becomes your default list of presets, and these presets become selectable by MIDI Program Change messages and host automation from a sequencer.

KORE SOUNDS as Presets in Cubase
Obviously, only one program list can be active at a time. You can, however, export the list to a file and create another one. All exported lists can be imported again for future use. Note that those program lists link to the actual KORE SOUNDS, similar to the Favorites. If, by any circumstance, one of the KORE SOUNDS on the list has been lost or renamed, the program list will not be able to recall it.

11.3 Mutator

The Mutator holds all parameters controlling the Sound Mutations.

The Mutator is a striking new feature introduced in ABSYNTH 5. It allows you to select some parts of the Sound currently loaded and to “mutate” them towards the equivalent parts of other Sounds. These “other Sounds” are those appearing in the Search Result List. Hence, you only need to narrow the Search Result List down by selecting the desired Attributes, those Attributes defining the characteristics that you would like to give to the loaded Sound.

The Mutator allows you to:

- Set the extent of the mutation and add some randomization to it.
- Iterate the process as many times as you want.
- Adjust “on the fly” some global characteristics of the newly generated Sounds via the Finetuning controls.
- Rewind to previous Mutations via the Mutation History.
11.3.1 Basic Operations

Basic Mutator controls

In the top middle part of the Mutation section, you find two big sliders and two big buttons:

- **Mutation Amount slider**: Defines the extent of the Sound Mutation. In other words, it is the distance between the next Sound Mutation and the current Sound. The more you drag the slider to the right, the further the Sound Mutation will be from the original Sound – and the closer it will be to the Sounds sitting in the Search Result List.

- **Randomization Amount slider**: Defines the amount of randomization applied to the parameters affected by the Sound Mutation. The more you raise the Randomization Amount slider, the more the parameters of the mutated Sound will deviate from the road between the original Sound and the Sounds sitting in the Search Result List.

- **Mutate button**: Applies the Sound Mutation. Once the mutation is computed, the Sound Mutation gets automatically loaded, replacing the original Sound (which can be itself a previous Sound Mutation). The Sound Mutation takes the name of the original Sound and adds a “M” followed by a number denoting the rank of the mutation: M1 for the first one, M2 for the second one, and so on.

- **Retry button**: Cancels the last Sound Mutation and applies a new Sound Mutation starting from the previous Sound/Mutation. The new Sound Mutation takes the name of the previous one. If you have not executed any mutation yet, this Retry button is inactive (it is greyed out).
11.3.2 Mini-Patch View

Mini Patch view

In the left part of the Mutation section, the Mini-Patch view is a small representation of your current patch with all its modules, as they are in the Patch Window. The Mini-Patch view allows you to select the components that you want to include in the mutation process.

The Modules

Each module of the Mini-Patch view can have three states:

• Totally dimmed: The module is deactivated in the Patch Window. Therefore, it cannot be included in any mutation process.

• Border highlighted only: The module is active in the Patch Window but does not take part in the mutation process.

• Whole component highlighted: The module is active in the Patch Window and also included in the mutation process.

The active modules (included or not in the mutation process) are labeled so that you can recognize them easily:

• At the top, the three Oscillators are denoted by the letters A, B or C of their respective Channels.

• Below, the Filters, Modulators or Waveshapers of each Channel are denoted by the numbers 1 or 2 according to their place within that Channel.

• At the bottom, in the Master Channel, the first two modules are labeled with M1 and M2 (“M” for Master) and the last module with FX.

You can select the modules to include or exclude within/from the mutation process by clicking on them to toggle their state.
The Envelope and LFO Buttons
On the right side of the patch, the Envelope and LFO buttons allow you to include the Sound’s Envelopes and LFOs to the mutation process.

Here as well, you can include/exclude the Envelopes and LFOs within/from the mutation process by clicking on them to toggle their state.

11.3.3 Mutation History

Mutation History

In the right part of the Mutation section, the Mutation History gives you access to all previous Sound Mutations you might have done since you started ABSYNTH 5. It provides you with following controls:

- In the middle, it displays the name of the last Sound Mutation that was done.
- On both sides, the Previous/Next Mutation buttons allow you to scroll the Mutation History. A click on one of these buttons loads the previous/next Sound Mutation in ABSYNTH 5, if available. If this is the first or the last Sound Mutation, the corresponding button is deactivated and greyed out.
- By clicking anywhere else in the Mutation History section, you open the Mutation History dialog, described below.

Mutation History Dialog
The main part of the Mutation History dialog is the ordered list of all existing Sound Mutations. By clicking on any of them, you select it and load it in ABSYNTH 5 so you can listen to it directly and compare it with the others.

At the top of the dialog, you find the following elements:

- **Save As button**: Allows you to save the selected Sound Mutation as a plain Sound in your Library. In the dialog that opens, choose a name and a location for the saved Sound, then click “Save” to save it.

- **Clear History button**: Removes all Sound Mutations from the Mutation History. A warning message asks you to confirm the operation, since it is irreversible.

- **Sound Mutation Name display**: Shows the name of the Sound Mutation currently selected in the list.

At the bottom of the dialog, the buttons “OK” and “Cancel” allow you to return to the ABSYNTH 5 interface with the selected Mutation loaded or not, respectively.

### 11.3.4 Finetuning Controls

The Finetuning controls form a quick access to eight characteristics of the Sound. These controls allow you to quickly tweak the Sound after a mutation, or simply after loading it from the ABSYNTH 5 Library.

Only parameters that have applications in the current patch are active. The other are dimmed.

These Finetuning controls are intended to make on-the-fly adjustments to your Sounds when browsing or mutating them. They are not meant for live performance, therefore they cannot be automated, modulated nor controlled via MIDI!
11.3.5 Mutation Controls in Other Parts of the GUI

The Sound Mutations are available in other parts of ABSYNTH 5’s graphical user interface, making them available even if another window is open:

• The Mutate and Retry buttons are also to be found in the Navigation Bar’s lower row:

• The Mutation History is also available as a submenu sitting at the top of the Navigation Bar’s Sound menu, right below the currently loaded Sound, so that you can review it from any Window:

• Mutation and Retry commands are also built into the Edit menu of each module in the Patch Window, so that you can selectively mutate/retry any module as you are working:

The Getting Started guide provides you with a detailed Quick Start on how to use the Mutator functionality.
11.4 Defining Attributes and Saving KORE SOUNDS

Assuming now that you are familiar with searching for a sound in the Browser’s Database View (as described in the previous section), the following explanations should be easy to follow.

Browser in Effect mode

You access the Attributes Windows by clicking the Attributes button in the Navigation Bar. Its layout is similar to the Browser’s Database View, except that while you load KORE SOUNDS from the Browser Window, within the Attributes Window you save them. Therefore, the Search Result List are not needed and are replaced by the Meta Information.

The Meta Information provides additional text fields to enter information about the sound to be saved:

- **Author**: the Author of a KORE SOUND. Fill in your name for your own KORE SOUNDS. This field is automatically filled with a default author name, if one has been entered in the Options Dialog.
- **Company**: the commercial vendor of the KORE SOUND, if there is one.
- **Bankname**: the bank the sound is derived from.
- **Color**: associates a color with the KORE SOUND. This information is used if the sound is loaded into KORE.
- **Rating**: allows you to assign a rating the sound for future reference.
• **Comment**: this field can hold any information you want. Often it is used to describe a KORE SOUND in terms of its possible usage, and also to note any special interactive features of the KORE SOUND, e.g. “MIDI modulation wheel controls master cutoff.”

• **Number of Inputs**: Specifies the number of inputs used in the oscillators (see section 5.4 “Oscillator Module”).

• **Number of Outputs**: Specifies the number of outputs set in the Output Setup (see section 5.4 “Oscillator Module”).

Note that the format of the Meta Information has been unified among a number of different NI software instruments such as MASSIVE, ABSYNTH 5 and FM8 as well as our software live host KORE 2 in order to provide a common environment for your work. Some of the displayed values may, however, not be active within all of these instruments. For instance, Color is of no importance within ABSYNTH 5 itself.

You can search through all of the entries of the Meta Information with the Search Field of the Browser. For example, you can enter the name of the project created for your sound in the first place into the Comment field. By using the database you can access it easily in all future projects, and if you need all sounds used in a particular project, you can find them by entering the project’s name into the Search Field.

All sounds you save are automatically integrated into the database. While this is very comfortable for browsing – you don’t have to worry about where the KORE SOUND files are actually stored – you should take a moment while saving a new KORE SOUND to set its attributes. If you don’t do this, your database will quickly become less useful, as you won’t be able to find your own sounds easily. Take a look at Appendix A and Appendix B for an explanation of all attributes as well as some basic examples.

After entering the Meta Information and setting the attributes according to your sound, you can save it by clicking the Save button within the Navigation Bar. This button will bring up a Save As dialog asking you for the new KORE SOUND file’s name and the location to save it. If you saved the sound previously, this may overwrite the old file unless you rename it at this point; if so, ABSYNTH will ask you whether or not you really want to overwrite it. By default, the dialog box will suggest to save the sound to the user content folder or one of its sub-folders. The user content folder is created during installation and can be found in “My Documents/Absynth 5/My Sounds” (Windows) or “[User]/Documents/Absynth 5/My Sounds” (Mac OS X). You can access this folder within the Browser’s File Tree View by selecting the My Sounds entry. As explained above, you can use your operating system to delete or rename files within these folders.
12 Additional Features

12.1 Virtual Keyboard

ABSYNTH Virtual Keyboard

In every Window of ABSYNTH 5, you can show a Virtual Keyboard at the very bottom. This Virtual Keyboard is especially useful when you want to try a Sound yet no MIDI keyboard is available. You can play on the Virtual Keyboard by clicking on the notes with your mouse. The notes play until you release the mouse button. To show/hide the Virtual Keyboard, click on the Keyboard button in the upper Navigation Bar:

Keyboard button

When the Virtual Keyboard is open, you can also hide it by clicking on the small triangle at its top middle.

12.1.1 Hold Switch

If you activate the Hold switch on the left of the keyboard, each note will continue to sound until you click on its key again or until you play another note (…or until you deactivate the Hold switch). This can be handy to try a sound without having to hold the mouse button depressed on a key.
12.1.2 Sustain Switch

Above it, the Sustain switch – the switch with the pedal symbol – allows the notes to fade out naturally with the release of the key, just as they would with the use of a pedal while playing a piano. In this way you can also play chords with the mouse by playing the tones one after another. The Sustain switch also affects the incoming MIDI notes such that you can use the Sustain switch when you play ABSYNTH 5 from a real MIDI keyboard. Remote control of the Sustain switch is possible with MIDI CC #64, which is reserved for the Sustain Pedal.

12.2 Audio Recorder

Audio Recorder

The Audio Recorder is a convenient tool if you want to quickly stream ABSYNTH 5’s sound into a file on your hard disk without plugging the synthesizer into an extended host environment. It even allows you to overdub different layers, which are saved to one single file.

The Audio Recorder can be opened via the Record button, located in the Navigation Bar between the Effect tab and the CPU Meter:

Clicking on the button opens the Audio Recorder in a pop-up window. You can still access all other parts of ABSYNTH 5 to modify your sound while recording.

The Audio Recorder window cannot be opened when ABSYNTH 5 is being used as a plug-in. In this case, use your host’s capacities to record the synthesizer’s signal.
12.2.1 Main Operations

The main recording operations are controlled with the Stop, Start/Pause and Record buttons in the Window’s top row.

To record ABSYNTH 5’s sound, you first need to arm the recorder by pressing the red Record button in the Window’s top row. The button will then start blinking along with the Start/Pause button, and the Audio Recorder is ready to record.

To start the recording, you have two possibilities:

► Click on the Start/Pause button.

or

► Activate the Wait for note switch: the recording then starts automatically when you play the first note (from your MIDI keyboard, from the Virtual Keyboard or from your computer keyboard).

To stop the recording, you have two possibilities:

► Click on the Stop button.

or

► The recording ends automatically if the Fixed Length switch is turned on and the set time is surpassed. You can enter the length in beats according to the tempo (in beats per minute, BPM). This easily creates loop-like recordings, which can then be used in any other environment – or, recursively, in ABSYNTH 5’s sample operation modes.

While recording, the Status Bar displays the current recording progress as a small horizontal bar.
12.2.2 Overdubbing

After having recorded some audio, you can overdub multiple audio layers by pressing the Overdub switch. If activated, the new signal will be mixed with the old signal rather than replacing it.

To control the mix, you can set both signals’ level separately with the two sliders that appear upon activation of the Overdub switch:

- The Synth slider controls the new recording’s level.
- The Tape slider controls the previous recording’s level.

You can repeat the overdubbing process as often as needed: the mix between the Synth and Tape signals will simply be used as new Tape signal the next time, so that you can mix it again with your playing.

⚠️ Note that this is not equivalent to true multi-track processing. With standard settings, both signals will be attenuated by 6 dB so that they play at half volume and don’t clip. If you record a third layer, the first recording will be attenuated a second time. So, if you plan to use this feature extensively, keep the recordings’ order in mind.

12.2.3 Options

You have a few more options at your disposal:

- **Stereo switch**: If activated, two channels will be recorded; if not, a mono mix will be recorded. Note that you cannot overdub stereo and mono signals together.

- **Options button**: By clicking on the Options button in the bottom row, you open the Options dialog. This dialog allows you to activate/deactivate the Undo function (see below) and define the maximum duration of your recordings (1, 2, 3, 5 or 7 minutes).
12.2.4 Once the Recording Is Finished

The first three buttons on the bottom row control what to do with your recording:

- **Undo button**: Removes the last recording layer from your recording.
- **Save button**: Opens a file dialog which allows you to save your recording as a file on your hard disk. Choose a name and a path for your recording. You can choose to save your recording as a WAV or AIFF file. Finally, press the “Save” button to store the file.
- **Clear button**: Flushes the whole recording buffer without saving.
13 Appendix A – How to Work with Attributes

This chapter will provide several examples on how to search for sounds and effects with the sound Browser. You'll learn the meaning and the definitions of the supplied Attributes, as well as the logic behind their arrangement. We will discuss how to search for specific sounds or effects effectively, and how to supply Attributes for your own sounds and effects. A detailed explanation of all Attributes can be found in Appendix B.

Note that you can search for both instruments and effects since the approach is the same. The following explanations will focus on instruments only.

First, switch to the Browser Window and activate the Database View by activating the Sounds button. Then click on the Instruments button at the top of the Browser.

The Browser is arranged in five columns. Your search should begin with the leftmost column and then filter the results as you move toward the rightmost column. Some columns have internal groupings, so work with a left to right/top to bottom protocol when searching for sounds.
13.1 The Instrument Column

The Instrument column acts as the starting point for your search and describes a sound’s basic instrumental quality:

The first thing you probably did was to click on Synth to find a sound, as ABSYNTH is a synthesizer. You’ll wonder why we’ve included so many acoustic instruments as Attributes.

The practice of imitating acoustic instruments has a long history. Synthesizing brass, woodwinds or strings in analog synths has become so familiar to sound designers, that sounds like Mellow Strings or Fat Brass have become familiar preset names for synthesized sounds.

On the other hand, there are sounds that are clearly based on acoustic instruments, yet they don’t sound anything like the acoustic original. For example, you might have an ABSYNTH KORE SOUND, which uses a sample of an acoustic flute as material for granular synthesis. Clearly, this sound is only possible with digital synthesizers, but the origin of the sound is still an acoustic instrument. So you’d choose Flute in this column to look for such a sound.

Of course there are many sounds that have no connection to any acoustic instrument, so you’ll probably find these sounds categorized as Synth, Soundscapes, Sound Effects or Other. Also, don’t worry if you’re looking for Pads or Leads, and can’t find these Attributes under Instruments. You can specify this in the Articulation column, letting you distinguish between, for example, String and Synth Pads.
A sound can have only one instrument as an Attribute. For example, if you’re looking for a sound that features a drum loop and bass loop at the same time, choose Multitrack. If you’re searching for a nice piano sound with some strings layered on top of it, choose Piano/Keys and Layered (in the Source column).

### 13.2 The Source Column

The Source column has the following functions:

- It defines the instrument you’ve chosen in the first column more specifically
- It gives you information about the synthesis technique used in the sound
- It provides information about the sound’s origin

<table>
<thead>
<tr>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic</td>
</tr>
<tr>
<td>Electric</td>
</tr>
<tr>
<td>Analog</td>
</tr>
<tr>
<td>Digital</td>
</tr>
<tr>
<td>Synthetic</td>
</tr>
<tr>
<td>Sample-based</td>
</tr>
<tr>
<td>FM</td>
</tr>
<tr>
<td>Additive</td>
</tr>
<tr>
<td>Granular</td>
</tr>
<tr>
<td>Physical Model</td>
</tr>
<tr>
<td>Solo/Single</td>
</tr>
<tr>
<td>Ensemble/Kit</td>
</tr>
<tr>
<td>Small</td>
</tr>
<tr>
<td>Big</td>
</tr>
<tr>
<td>Dry</td>
</tr>
<tr>
<td>Processed</td>
</tr>
<tr>
<td>Layered</td>
</tr>
<tr>
<td>Sequence/Loop</td>
</tr>
<tr>
<td>Surround</td>
</tr>
</tbody>
</table>
This column is subdivided into seven smaller groups, each of them serving a specific purpose. We'll start from the top and make our way to the bottom of the list, so let’s begin with the first group:

- **Acoustic – Electric – Analog – Digital**: These four Attributes define the instrumental source. Let’s assume you’ve clicked on Bass in the Instrument column; you can then distinguish among Acoustic basses (e.g., an upright bass), Electric bass (e.g., a picked rock bass), Analog Bass (e.g., a typical subtractive synth bass sound) and Digital bass (e.g., an FM bass sound). Of course, depending on your choice in the first column, not every attribute will fit. If you chose Flute, you will probably only be using Acoustic, Analog or Digital. Note that every sound should belong to exactly one of the four types; i.e., a sound should not be Analog and Digital.

- **Synthetic – Sample-based**: This pair of Attributes describes the sound’s technical aspects, as it can be important to know if a sound was generated by some form of synthetic synthesis technique or through sampling. If a sound is Synthetic you will have the option of accessing many, if not all parameters that constitute the sound. If a sound is Sample-based you’ll most likely not be able to change the sound’s origin, but the sound might not use as much CPU. If you want to add “real” acoustic instrument Sounds to the Database, you’ll probably want to select this Attribute. Synthetic also refers to patches that use samples, but have such heavy processing that the sample is perceived as an oscillator (ABSYNTH’s sample and granular mode are good examples of this). Note that a sound is always either Synthetic or Sample-based (but not both).

- **FM – Additive – Granular – Physical Model**: These four Attributes specify the audible perception and/or synthesis technique of the sound. Note that an Attribute like FM does not necessarily mean that the sound uses the actual technique of frequency modulation, but it clearly sounds like FM. Let’s assume you are looking for a typical FM bass sound. This sound could be produced by actual frequency modulation, or by using a sample. If you’re sure you want “true” FM synthesis, you would check Synthetic, and then you can be confident that your FM Bass was generated using this technology.
The next six Attributes are grouped in pairs and specify the sound’s source:

- Solo/Single – Ensemble/Kit
- Small – Big
- Dry – Processed

These are clearly opposites (e.g., a sound cannot be dry and processed at the same time). Please refer to Appendix B for a complete set of definitions.

13.3 The Timbre Column

The Timbre column specifies a KORE SOUND’s timbre. It is made up mostly of Attribute pairs:

<table>
<thead>
<tr>
<th>Timbre</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
</tr>
<tr>
<td>Low</td>
</tr>
<tr>
<td>Distorted</td>
</tr>
<tr>
<td>Clean</td>
</tr>
<tr>
<td>Bright</td>
</tr>
<tr>
<td>Dark</td>
</tr>
<tr>
<td>Warm</td>
</tr>
<tr>
<td>Cold</td>
</tr>
<tr>
<td>Fat</td>
</tr>
<tr>
<td>Thin</td>
</tr>
<tr>
<td>Hard</td>
</tr>
<tr>
<td>Soft</td>
</tr>
<tr>
<td>Muted</td>
</tr>
<tr>
<td>Detuned</td>
</tr>
<tr>
<td>Dissonant</td>
</tr>
<tr>
<td>Noisy</td>
</tr>
<tr>
<td>Metallic</td>
</tr>
<tr>
<td>Wooden</td>
</tr>
<tr>
<td>Exotic</td>
</tr>
</tbody>
</table>

It is important to realize that this column’s Attributes have to be seen in relation to the selected Attributes in the Instrument and Source columns (that is why it is a good idea to always go from left to right).
For example, a bass instrument is obviously low in nature; therefore you don’t have to additionally select Low. However, you could still do it for bass sounds that clearly exhibit low frequencies like a sub bass. Note that Attributes like Warm or Exotic are highly subjective. It is important to consider the expressiveness of such Attributes in relation to the instrument. Please refer to the Appendix B for a complete set of definitions.

13.4 The Articulation Column

The Articulation column serves two purposes: It describes how the sound progresses over time; and it gives you information regarding how to use the sound.

In previous versions of ABSYNTH, you’d have to work with preset names like “Slow Strings,” “Dream Pad (+rls)” or “Monsta Synth (lead).” But a preset name is not really the best place to indicate the sound’s intended application. With the Articulation column you can define exactly what the Sound is about, and its intended use.

Especially in a live situation, the knowledge of how a sound is meant to be played is quite important: If for example a sound is categorized as Chord, you know immediately that hitting one key results in a chord, meaning that if you play a chord on the keyboard the result will be rather messy.
13.5 The Genre Column

The Genre column describes the musical style with which a sound can be associated:

<table>
<thead>
<tr>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avantgarde</td>
</tr>
<tr>
<td>Orchestral</td>
</tr>
<tr>
<td>Film Music</td>
</tr>
<tr>
<td>Electronica</td>
</tr>
<tr>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>House</td>
</tr>
<tr>
<td>Techno/Electro</td>
</tr>
<tr>
<td>Industrial</td>
</tr>
<tr>
<td>Dance/Trance</td>
</tr>
<tr>
<td>HipHop/Downbeat</td>
</tr>
<tr>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Rock</td>
</tr>
<tr>
<td>Pop</td>
</tr>
<tr>
<td>Jazz</td>
</tr>
<tr>
<td>Folk/Country</td>
</tr>
<tr>
<td>Ethnic/World</td>
</tr>
</tbody>
</table>

This set of Attributes is the last step in defining your KORE SOUND, as these are the most subjective definitions and/or interpretations.

Obviously, the definition of “What is techno?” and “What sound can be used for techno?” is always subjective because really, every sound can be used for every genre, like a harpsichord in hip-hop or a sub bass in jazz. But here, we also try to pinpoint the sound’s origin whenever possible. Therefore, a harpsichord sound should be found under Orchestral/Classical, as it’s an instrument used in the repertoire of the 17th and 18th century.

Again, check Appendix B for a complete list of definitions.
13.6 Examples

In this section, we’ll present some examples of typical searches. In each example, we kept the amount of selected Attributes to a minimum, just to give you an idea about the basic principle. You always can refine your search.

• **Analog Kick Drum**: This search will provide you with a single kick drum sound, as Solo/Single is selected (although the pitch of the kick drum might change when you play across the keyboard). Because Synthetic is checked, you know that you’ll be able to modify the sound in its entirety. Try the Genre column to refine your search:
• **“Harsh” electronic drum kit**: This search will give you complete drum kits, since Ensemble/Kit is selected:

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long/Decaying</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Releasing</td>
<td>Techno/Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td></td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical</td>
<td>Thin</td>
<td>Lead</td>
<td>Hip Hop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowied Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Fruch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Detuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Arpeggiated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synched</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td>Randomized</td>
<td></td>
</tr>
</tbody>
</table>

• **FM Bass**: This is a typical search setting for an FM bass sound. You could select Sample-based instead of Synthetic; then you’ll retrieve programs that sound like FM but are based on samples:

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long/Decaying</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Releasing</td>
<td>Techno/Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td></td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical</td>
<td>Thin</td>
<td>Lead</td>
<td>Hip Hop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowied Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Pitch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Detuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Arpeggiated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synched</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td>Randomized</td>
<td></td>
</tr>
</tbody>
</table>
• **Rave Lead:** Note that no Instrument is specified, so this search will give you all sounds, which could be used in the same context.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long/Evolving</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Pulsating</td>
<td>Techno/Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td>Pad</td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical Model</td>
<td>Thin</td>
<td>Lead</td>
<td>Hip Hop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowed Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Pitch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Retuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Arpeggiated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synched</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• **Soft Electric Piano:** In this example, because Sweep/Filter Mod is selected the sound will have some sort of filter movement. As a result, the electric piano might have a wah-wah “feel” to it.
• **Dark Pad:**

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long, Evolving</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Pulsating</td>
<td>Techno/ Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td>Pad</td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical Model</td>
<td>Thin</td>
<td>Lead</td>
<td>HipHop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowed Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Pitch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Detuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Apeptigated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synced</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td>Randomized</td>
<td></td>
</tr>
</tbody>
</table>

• **Chord Stab:**

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long, Evolving</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Pulsating</td>
<td>Techno/ Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td>Pad</td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical Model</td>
<td>Thin</td>
<td>Lead</td>
<td>HipHop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowed Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Pitch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Detuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscapes</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Apeptigated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synced</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td>Randomized</td>
<td></td>
</tr>
</tbody>
</table>
- **Thin Bells:**

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Source</th>
<th>Timbre</th>
<th>Articulation</th>
<th>Genre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Piano/Keys</td>
<td>Acoustic</td>
<td>High</td>
<td>Slow Attack</td>
<td>Avantgarde</td>
</tr>
<tr>
<td>Organ</td>
<td>Electric</td>
<td>Low</td>
<td>Decaying</td>
<td>Orchestral</td>
</tr>
<tr>
<td>Synth</td>
<td>Analog</td>
<td>Distorted</td>
<td>Sustained</td>
<td>Film Music</td>
</tr>
<tr>
<td>Guitar</td>
<td>Digital</td>
<td>Clean</td>
<td>Long Release</td>
<td>Electronica</td>
</tr>
<tr>
<td>Plucked Strings</td>
<td>Synthetic</td>
<td>Bright</td>
<td>Percussive</td>
<td>D’n’B/Breaks</td>
</tr>
<tr>
<td>Bass</td>
<td>Sample-based</td>
<td>Dark</td>
<td>Long/Evolving</td>
<td>House</td>
</tr>
<tr>
<td>Drums</td>
<td>FM</td>
<td>Warm</td>
<td>Pulsating</td>
<td>Techno/Electro</td>
</tr>
<tr>
<td>Percussion</td>
<td>Additive</td>
<td>Cold</td>
<td>Echoing</td>
<td>Industrial</td>
</tr>
<tr>
<td>Mallet Instruments</td>
<td>Granular</td>
<td>Fat</td>
<td>Pad</td>
<td>Dance/Trance</td>
</tr>
<tr>
<td>Flute</td>
<td>Physical Model</td>
<td>Thin</td>
<td>Lead</td>
<td>HipHop/Downbeat</td>
</tr>
<tr>
<td>Reed Instruments</td>
<td>Solo/Single</td>
<td>Hard</td>
<td>Monophonic</td>
<td>Funk/Soul</td>
</tr>
<tr>
<td>Brass</td>
<td>Ensemble/Kit</td>
<td>Soft</td>
<td>Chord</td>
<td>Reggae/Dub</td>
</tr>
<tr>
<td>Bowed Strings</td>
<td>Small</td>
<td>Muted</td>
<td>Glide/Pitch Mod</td>
<td>Latin/Afro-Cuban</td>
</tr>
<tr>
<td>Vocal</td>
<td>Big</td>
<td>Detuned</td>
<td>Sweep/Filter Mod</td>
<td>Rock</td>
</tr>
<tr>
<td>Soundscape</td>
<td>Dry</td>
<td>Dissonant</td>
<td>Arpeggiated</td>
<td>Pop</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>Processed</td>
<td>Noisy</td>
<td>Tempo-synced</td>
<td>Jazz</td>
</tr>
<tr>
<td>Multitrack</td>
<td>Layered</td>
<td>Metallic</td>
<td>Expressive</td>
<td>Folk/Country</td>
</tr>
<tr>
<td>Other</td>
<td>Sequence/Loop</td>
<td>Wooden</td>
<td>Multiple</td>
<td>Ethnic/World</td>
</tr>
<tr>
<td></td>
<td>Surround</td>
<td>Exotic</td>
<td>Randomized</td>
<td></td>
</tr>
</tbody>
</table>
14 Appendix B – Attributes Reference

The next few pages are a reference of all attributes used in ABSYNTH’s database. The attributes are identical to those used within KORE. They are ordered in categories: first those used to describe an instrument sound, then those that specify an effect sound.

Please note that some attributes should be used mutually exclusive, e.g. a sound’s source can either be acoustic or electric. Refer to Appendix A for examples.

14.1 Instrument Categories

14.1.1 Instrument

This column specifies a sound’s basic instrumental quality. All other columns are additional descriptions of these instruments. Only one instrument can be chosen. The sound can be an emulation of the chosen instrument or a timbre which audibly refers to an instrument without trying to imitate it (e.g., granular processed flute sample).

- **Piano/Keys**: All acoustic/electric pianos, harpsichord, clavinet etc. In general all sounds that are meant to be played in a piano/keyboard fashion.
- **Organ**: Acoustic and electric organs. Also harmoniums and organ-like reed instruments, e.g. accordion, melodica, reed organ etc. Generally played on some kind of keyboard.
- **Synth**: All kinds of typical synth sounds not associated with other instruments in this column. A typical synth brass sound for instance belongs to Brass. Synth instruments which are meant to be played in the lower range are found in Bass.
- **Guitar**: An instrument that sounds like a guitar, including acoustic, classical, electric and synth guitars.
- **Plucked Strings**: Instruments that are generally played by plucking a string, like a harp, koto, banjo, etc. This also applies to synth instruments whose main sonic quality is derived from the sound characteristic of a plucked string.
• **Bass:** A sound which can serve as the bass part in a production. A synth should only be categorized as Bass if the lower range is more convincing than the upper range. (Note that a double bass used in a classical context (i.e., bowed) would be categorized as Bowed Strings. However, if used in a jazz context (i.e. plucked), it would be categorized as Bass.)

• **Drums:** A single drum sound, a drum kit or a drum loop based on an acoustic or electronic drum kit. Typically this includes kick drum, snare, toms, hi-hat, ride/crash cymbals, claps.

• **Percussion:** A single percussion sound, a percussion kit or a percussion loop. This includes all idiophones and membranophones of indefinite pitch, such as bongo, timpani, agogo etc. It also includes electronic percussion that is not usually found in an electronic drum kit.

• **Mallet Instruments:** All instruments with definitive pitch played with mallets, like vibraphones, xylophone, marimba, bells, steel drums etc.

• **Flute:** Instruments that reproduce or simulate flutes (oscillating air tubes) or which are based on flute samples. This includes acoustic flutes, pan pipes, synthetic flute simulations, breathy sounds, etc.

• **Reed Instruments:** Instruments that reproduce or simulate reed instruments like oboe, clarinet, bassoon, saxophones etc. Note: reed organs are categorized as Organ.

• **Brass:** Instruments that reproduce or simulate brass instruments like trumpet, french horn, trombone, tuba. You’ll also find a lot of analog brassy synth sounds in this category. Note that Saxophones are not brass, but reed instruments.

• **Bowed Strings:** All instruments with a playing technique defined by bowing a string, typically violin, viola, cello and double bass. Also, typical analog string pads are found here.

• **Vocal:** Choirs, vocal samples and all other instruments that sound like vocals. This also includes synth sounds that clearly make use of a formant/vowel filter or a talkbox/ vocoder to make the sound speak or sing.

• **Soundscapes:** A sound providing some sort of acoustic scenery, whether it’s based on tonal timbres or noise textures (typically long compared to sound effects).

• **Sound Effects:** A sound effect (not an effect plug-in) similar to an explosion, shot or footsteps (typically short compared to Soundscapes).
• **Multitrack**: A combination of several different instruments. If you can imagine using the different instruments independently from each other, it’s Multitrack. These are mostly sequenced or used in a key-split (like a combination of drums/bass/keyboard). If the instruments blend into one sonic entity, its Source is categorized as Layered and is not categorized as Multitrack.

• **Other**: Select this Attribute if none of the above instruments apply.

### 14.1.2 Source

This describes the source and/or synthesis technique with which the sound can be associated, always in relation to the selected instrument.

• **Acoustic**: Further defines the instrument, e.g. acoustic piano, acoustic guitar, acoustic (i.e., church) organ.

• **Electric**: Further defines the instrument as an electro-acoustic instrument, e.g., electric piano, electric guitar, electric organ.

• **Analog**: Further defines the instrument as a typical subtractive synth sound, e.g., analog bass, analog brass, analog synth.

• **Digital**: Further defines the instrument as a typical digital synth sound (like wavetable, FM), e.g., digital bass, digital piano, digital synth.

• **Synthetic**: This Attribute describes the technical aspect of how the sound was produced. Synthetic refers to all synthesis techniques like subtractive, additive, FM, wavetable, granular etc.

• **Sample-based**: This Attribute describes the technical aspect of how the sound was produced. Sample-based refers to all instruments in the sense of sample playback, i.e., the sounds were obtained from external sources. It should not be used for granular synthesis or sample-based wavetable synthesis. For example ABSYNTH patches, which use a sample for playback but manipulate it drastically, would be categorized as Synthetic.

• **FM**: A sound which uses FM synthesis. FM can also be used for sample-based instruments that sound like FM.

• **Additive**: A sound that uses additive synthesis (or sounds like it).

• **Granular**: A sound that uses granular sampling (or sounds like it).
• **Physical Model**: A sound that uses physical modeling (or sounds like it).

• **Solo/Single**: Used to differentiate between a single instrument and a group of identical instruments, like a solo violin (as opposed to a violin section) or a single snare drum (as opposed to a drum kit).

• **Ensemble/Kit**: Used to differ between a group of identical instruments and a single instrument, like a string section or a drum kit. Don’t mistake Ensemble/Kit with Layered.

• **Small**: Specifies the physical size of the instrument source to help differentiate among similar instruments. Only select this Attribute to describe real instrument sizes, not the timbre itself. For example, a violin is categorized as Bowed Strings/Small; a hand drum would be found under Percussion/Small.

• **Big**: Specifies the physical size of the instrument source to help differentiate among similar instruments. Only select this Attribute to describe real instrument sizes, not the timbre itself. (For example a violoncello is categorized as Bowed Strings/Big; a taiko drum would be found under Percussion/Big.)

• **Dry**: Has no noticeable effects like reverb or delay. Distortion and/or filtering do not affect this Attribute.

• **Processed**: A sound reinforced with some obviously added and audible effects like delay, reverb or chorus.

• **Layered**: A sound where two or more sound sources contribute to one instrument. The sounds must combine to form one sonic character, like a typical Piano + String sound.

• **Sequence/Loop**: Based on a sequence or loop, like a step-sequenced synth or a drum loop. This Attribute is not used for simple repeating or retriggering of notes (see Arpeggiated).

• **Surround**: A sound using surround-sound technology.
14.1.3 Timbre

This set of attributes describes the sonic composition of the sound (always considering the selected instrument).

- **High**: Used for high pitched sounds and to distinguish similar timbres by their range, like a piccolo flute, hi-hat, bells etc.
- **Low**: Used for low pitched sounds and to distinguish similar timbres by their range, like a bass clarinet, kick drum, sub bass etc.
- **Distorted**: A sound featuring obvious distortion/overdrive. Saturated and heavily bit reduced sounds are also found here.
- **Clean**: A sound featuring no distorted sound elements at all. Can be used to further specify instrument groups, e.g. clean electric guitar.
- **Bright**: A sound with emphasized high frequencies.
- **Dark**: A sound with de-emphasized high frequencies, perhaps from lowpass filtering.
- **Warm**: A sound with an organic, pleasing ambience, often associated with analog sounds. Technically speaking, warm sounds tend to have a bit more lower midrange emphasis and not too many highs.
- **Cold**: Not a natural sound, but a more electronic/digital sound.
- **Fat**: A “room-filling” sound, e.g., an analog super sawtooth sound, also to be used with typical unison sounds.
- **Thin**: A small sound or a sound with a narrow frequency band.
- **Hard**: A general, rather subjective interpretation of a sound. Can be used to differentiate similar instruments (e.g., vibraphone with hard mallets). Also associated with hard-synced oscillators.
- **Soft**: A general, rather subjective interpretation of a sound. Can be used to differentiate similar instruments (e.g., vibraphone with soft mallets).
- **Muted**: A sound with a muted or damped quality, like a muted guitar or con sordino strings. Usually found on acoustic instruments (a dark sound is not necessarily muted).
• **Detuned**: A sound with detuned oscillators to create floating tones, like saw leads used in trance music or honky-tonk piano. This is not used when the oscillators are tuned a fifth apart (see Chord), and it is not used with instruments that use micro intervals and/or non-standard tunings.

• **Dissonant**: A sound which in general is not playable tonally.

• **Noisy**: With some noise elements in the sound, but still playable tonally, like very breathy flutes. Slightly bit-reduced (not yet distorted) and lo-fi sounds are also categorized as Noisy.

• **Metallic**: A sound with a metallic quality. Note that several types of bells and FM often sound metallic.

• **Wooden**: A sound with a wooden quality, like a bamboo flute or xylophone.

• **Exotic**: Sounds with an extremely unusual quality fall under this category.

### 14.1.4 Articulation

Describes how the sound progresses over time in terms of volume and timbre. Also, this column lists all the Attributes that affect the playing style.

• **Slow Attack**: A sound with a gradual attack or a fade-in.

• **Decaying**: A sound which decays while holding a key, like a piano or a guitar. It does not necessarily fade out completely; see Sustained.

• **Sustained**: A sound with a constant volume level while holding a key, e.g. an organ or sustained strings. The sound doesn’t fall under this category if just a small part of the signal is sustained. A sound can be both Decaying and Sustained. A loop, although it continues to play a sound, is usually not categorized as Sustained.

• **Long Release**: A sound with a long fade out after releasing the key, like a bell or a pad. This can also indicate instruments with release samples. Don’t confuse Long Release with an echo or long reverb!

• **Percussive**: A sound with a short attack and usually short decay/release, often found in the group of drums or percussion.

• **Long/Evolving**: A sound with a complex, moving or increasing envelope, which persists for more than just a few seconds.
- **Pulsating**: A sound with periodic changes in volume and/or timbre over time, e.g., a step modulator controlling volume/filter. A loop is not necessarily Pulsating - only if it is processed in a similar manner.

- **Echoing**: A sound with significant reverb or delay.

- **Pad**: A sound texture suitable for as a homophonic background. As opposed to a Soundscape, a Pad has a more uniform characteristic and is often played as a chord.

- **Lead**: A sound suitable for the main instrumental melody part.

- **Monophonic**: A sound which can play only one (MIDI) note at a time, with or without key-up action.

- **Chord**: A sound with more than one pitch played simultaneously per key, like fifth leads. This does not include sounds that simply double the octave. A Chord can also be Monophonic, as long as only one (MIDI) note is sounding at a time.

- **Glide/Pitch Mod**: A sound that uses pitch slides between note transitions. It also indicates sounds with pitch modulation, like a dropping kick drum.

- **Sweep/Filter Mod**: A sound with some kind of filter modulation, i.e., an LFO or envelope modulates filter parameters. A simple velocity to filter modulation is not sufficient (see Expressive).

- **Arpeggiated**: A sound that arpeggiates or repeats held notes. A sound that triggers a sequence is not Arpeggiated, but Sequenced/Loop.

- **Tempo-synced**: A sound which clearly changes when the host tempo changes, i.e., where certain parameters like LFO or delay times are synced to tempo.

- **Expressive**: A sound with a large and noticeable dynamic and/or tonal range, controlled by either velocity or mod wheel (a subtle velocity to amplitude routing is not sufficient).

- **Multiple**: Used to denote instruments that feature more than one articulation. Usually applies to keyswitched instruments. Randomized: A sound with random elements in it, for example a random or free-running LFO modulating filter. Also indicate sequences and/or loops that give the impression of randomness.
14.1.5 Genre

Illustrates the typical musical genre to which a sound would be suited. It can also stand for a particular sound’s origin.

- **Avantgarde**: Sounds associated with modern contemporary music, whether acoustic or electronic. This Attribute works well in combination with other genres, e.g. orchestral + avantgarde might include extended playing techniques on acoustic instruments.

- **Orchestral/Classical**: Sounds used in a traditional symphonic orchestra or chamber group. Such sounds need not necessarily be dry, but the emphasis is placed on natural reproduction. Sample-based acoustic instruments are usually found here.

- **Film Music**: Sounds associated with film music and/or game audio. In general, sounds belonging to this category have a certain “bombastic” quality, in other words they’re ready to use for scoring, like massive orchestral brass, airy atmospheric synth textures and cinematic effects.

- **Ambient/Electronica**: Sounds that create a certain atmosphere, based on depth and warmth. Also, sounds with a kind of slow motion character or “clicks & bleeps” are often used for ambient or electronica tracks and will be found here, as well as all typical sounds for “intelligent electronic music” (opposite of cheap plastic sounds).

- **Drum&Bass/Breaks**: Prominent and deep basses combined with dark lead sounds and gloomy atmospheric hover pads. Synthetic sound effects are also a part of this genre, as syncopated drum loops are often based on polyrhythms and samples from 70s jazz and funk records.

- **House**: Typical warm and often human-sounding elements are used for this four to the floor dance music, e.g. organ chords, warm analog basses etc. Generally more analog sounds with a certain depth will be found here.

- **Techno/Electro**: Synthetic and electronic sounds and sound effects with a rather dry and dark nature are this genre’s trademark. Percussion with hard attack and a very compressed character belong here as well as a wide spectrum of synthetic bass sounds, stabs and leads.

- **Industrial**: Sounds with a digital and cold/metalllic character, often combined with noisy or distorted elements, belong in here.
• **Dance/Trance**: Sounds with a rather soft and warm character will be found here. Typical sounds are analog and digital synth pads, melodic elements (from soft and small to typical detuned super saw sounds for trance anthems) and commercial dance sounds like bells and arpeggiated elements go here. Sounds which are suited to create a hypnotic mood also fit here.

• **HipHop/Downbeat**: Sounds with a laid back and chilled character belong in here as well as typical sound effects like vinyl-scratching, struck drum sounds with an acoustic or analog synthetic character, and mellow pads.

• **Funk/Soul**: These instruments have that vintage funk sound, such as organs from the 60s, synths from the 70s, wah-wah guitars, slap bases, and dry acoustic drums.

• **Reggae/Dub**: For this genre, typical instruments would be dry acoustic drums and percussion, clean guitars, some acoustic flutes and smaller organs.

• **Latin/Afro-Cuban**: Sounds to be used in Central and South American music (Salsa, Son, Samba, Bossa Nova). This includes all latin percussion such as congas, maracas and timbales, as well as some acoustics guitars and djembes.

• **Rock**: Typical sounds for straightforward rock music, like electric guitars and basses, acoustic drums, and dirty synths.

• **Pop**: A rather broad musical genre that includes sounds of typical “radio-ready” music, ranging from pianos and guitars to electro-pop synths and drums.

• **Jazz**: All typical jazz instruments like piano, upright bass, saxes, brass and drums are found here. In other words, all sounds used for an acoustic jazz arrangement, ranging from small ensemble to big band. Sounds are rather natural in character with little or no processing.

• **Folk/Country**: Sounds associated with all kinds of folk and songwriter styles like bluegrass, klezmer, blues. In general, this encompasses acoustic sounds.

• **Ethnic/World**: Sounds associated with non-western musical cultures like south/north Indian music, gamelan, Arabic/Persian, Asian and African music. These sounds need not necessarily be acoustic in nature; electronic textures can also be categorized here as long as they reflect this kind of atmosphere.
14.2 Effect Categories

14.2.1 Type
Describes the basic effect characteristics.

- **Delay**: An echo effect that adds one or more delayed versions of the original signal to the sound.
- **Chorus**: An effect that mixes a very slightly delayed and pitch-shifted version of the input signal with the original input signal.
- **Phaser/Flanger**: All kinds of effects using a comb filter (delay-line) to generate phase shifting and cancellation thus creating, a phasing or flanging sound.
- **Reverb**: All effects creating an obvious room ambience.
- **Filter/EQ**: All types of effects which modify a sound’s harmonics.
- **Dynamics**: Effects that manipulate the input signal’s dynamic range such as compressor, limiter or expander.
- **Enhancer**: All types of effects that enhance the sound through psycho-acoustic means, e.g., to add brilliance and/or depth.
- **Vocoder**: Effects based on traditional vocoder technology where the signal present at one input modulates the signal present at another input.
- **Distortion**: All types of effects that distort the incoming signal, from discreet to heavy distortion.
- **Resonator**: A special effect containing a (comb) filter that rings at a resonant frequency when it is excited by an input signal. A short input pulse creates a significantly longer decaying oscillation at the output.
- **Lo-Fi**: An effect that creates lo-fi sounds from the incoming signal, like a bit or sample rate reducer.
- **Pitch Shift**: All effects altering the pitch of a sound without affecting the playback tempo.
- **Gate/NR**: All types of gate and noise reduction effects.
- **Panning**: Effects that modulate the incoming signal’s stereo/surround placement.
• **Re-Sampler**: All effects that re-sample the incoming signal for the purpose of altering it via granular synthesis, making sequence changes, etc.

• **Amp Simulator**: An effect that simulates the sound of an analog amp.

• **Speaker Simulator**: An effect that simulates the sound of a particular speaker/cabinet combination.

• **Restoration**: Effects used to restore vintage or otherwise damaged recordings, e.g., click, hiss, or scratch removal.

• **Combination**: All effects including the character of several different effects of the above list (e.g., a combination of delay, filter and reverb effects).

• **Other**: Select this Attribute if it’s not possible to specify an effect type.

### 14.2.2 Mode

Specifies the effect’s mode of operation.

• **Synced**: All effects that can sync to the host sequencer’s tempo.

• **Side-chain**: All effects controlled by an external signal via side-chain.

• **Gated**: Effects that including “gating” (rapid amplitude changes) as an integral part of their sound.

• **Tuned/MIDI**: Effects that are tuned or controlled via MIDI.

• **Envelope Follower**: All effects that follow an amplitude envelope to modulate certain Attributes like filter cutoff, pitch, volume and so on.

• **Random**: Effects with random parameters.

• **LFO**: All effects with parameters controlled by low frequency oscillator(s).

• **Step**: All effects with parameters controlled by a step-modulator.

• **Granular**: Effects that re-synthesize the signal by using a micro-sound time scale.

• **Impulse Response**: All effects working with impulse responses, e.g., convolution reverb effects or filters.

• **Overdriven**: For effects with potentially overdriven inputs or outputs.
• **Vintage**: An effect that creates a vintage character, mostly associated with warmth and positive sound alteration.

• **Multi-band**: For effects working with more than one level or band, e.g. a multi-band compressor.

• **Selective**: All effects that operate on certain selective scopes of the signal, e.g., on selective frequencies like an exciter or de-esser.

• **Adaptive**: Driven by parameters that are extracted from the sound itself. The goal of this effect’s class is to provide a changing control signal to an effect.

• **Channel strip**: A combination of effects designed for processing incoming audio, similar to a hardware mixing console.

• **Parallel**: The signal routing of effects is parallel.

• **Chain**: The signal routing of effects is serial.

• **Stereo**: All effects work in stereo mode.

• **Mono**: All effects work in mono mode.

### 14.2.3 Characteristic

Describes an effect’s special sound characteristics.

• **Long**: Describes the release time of an effect, e.g., a long reverb or delay.

• **Short**: Describes the release time of an effect, e.g., a short reverb or delay.

• **Fast**: For effects that need to treat the incoming signal immediately upon receiving it (e.g., a compressor) or the effect itself sounds or acts fast.

• **Slow**: An effect that treats the incoming signal slowly, or the effect itself sounds or acts slow (e.g., attack-delay effect).

• **Bright**: A general, rather subjective interpretation of an effect. Can also be used to differentiate similar effects.

• **Dark**: A general, rather subjective interpretation of an effect. Can also be used to differentiate similar effects.

• **Warm**: An effect that adds warmth to the processed sound.
• **Cold**: An effect that adds coldness to the processed sound.
• **Intense**: An effect that changes the sound in an intense way, e.g., a heavy distortion effect.
• **Discreet**: An effect that changes the sound in a discreet way, e.g., a subtle delay.
• **Nasty/Evil**: An effect that modifies the sound in a nasty or evil way, e.g., a distortion effect with high intermodulation distortion.
• **Enhancing**: An effect that generally enhances the incoming sound.
• **Coloring**: An effect that adds color or character to a sound. Often found in vintage compressor or equalizer gear.
• **Neutral**: A transparent effect that doesn’t alter a sound’s essential character.
• **Alienating**: An effect that modifies the sound completely, e.g., vocoder.
• **Clean up**: An effect that cleans up the incoming signal, e.g., an equalizer that reduces or removes unwanted frequencies like hum or hiss.
• **Metallic**: An effect that adds metallic elements to the sound, e.g., a ring-modulator or frequency shifter.
• **Ambience**: An effect that creates an atmospheric mood, e.g., a room reverb.
• **Spacious**: An effect that creates an evocative mood, e.g., a very long delay.

**14.2.4 Application**

Describes the type of instrument, track, or field of application with which the effect is typically used.

• **Acoustic Piano**: For effects typically used with acoustic pianos, e.g., reverb or compressor.
• **Electric Piano**: For effects typically used with electric pianos, e.g., phaser or tremolo.
• **Organ**: For effects typically used with organs, e.g., speaker simulator or distortion.
• **Pads/Strings**: For effects typically used with pad or string sounds, e.g., chorus or phaser.
• **Guitar**: For effects typically used with guitar sounds, e.g., amp simulator or distortion.
• **Bass**: For effects typically used with bass sounds, e.g., equalizer or filter.
• **Drums/Percussion**: For effects typically used with drum/percussion instruments, e.g., small reverb or compressor.

• **Brass/Woodwinds**: For effects suitable for brass or woodwind sounds, e.g., reverb or delay.

• **Lead**: For effects typically used with lead instruments, e.g., chorus or reverb.

• **Vocal**: For effects typically used with vocal tracks, e.g., vocoder or reverb.

• **Sequences**: For effects typically used with sequenced lines, e.g., delay or gate.

• **Loops**: For effects typically used with drum or other loops, e.g., flanger or lo-fi.

• **Experimental**: For effects that change the signal so extensively it becomes unrecognizable.

• **Surround**: For effects that could be used for surround applications, e.g., panning etc.

• **Mastering**: For effects intended for mastering applications, e.g., multiband compressor or FIR equalizer.